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 Safety Guidelines 
This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger. 

DANGER  
indicates that death or severe personal injury will result if proper precautions are not taken. 

WARNING  
indicates that death or severe personal injury may result if proper precautions are not taken. 

CAUTION  
with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken. 

CAUTION  
without a safety alert symbol, indicates that property damage can result if proper precautions are not taken. 

NOTICE  
indicates that an unintended result or situation can occur if the corresponding information is not taken into 
account. 

If more than one degree of danger is present, the warning notice representing the highest degree of danger will 
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to 
property damage. 

Qualified Personnel 
The device/system may only be set up and used in conjunction with this documentation. Commissioning and 
operation of a device/system may only be performed by qualified personnel. Within the context of the safety notes 
in this documentation qualified persons are defined as persons who are authorized to commission, ground and 
label devices, systems and circuits in accordance with established safety practices and standards. 

Prescribed Usage 
Note the following: 

WARNING  
This device may only be used for the applications described in the catalog or the technical description and only 
in connection with devices or components from other manufacturers which have been approved or 
recommended by Siemens. Correct, reliable operation of the product requires proper transport, storage, 
positioning and assembly as well as careful operation and maintenance. 

Trademarks 
All names identified by ® are registered trademarks of the Siemens AG. The remaining trademarks in this 
publication may be trademarks whose use by third parties for their own purposes could violate the rights of the 
owner. 

Disclaimer of Liability 
We have reviewed the contents of this publication to ensure consistency with the hardware and software 
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the 
information in this publication is reviewed regularly and any necessary corrections are included in subsequent 
editions. 
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Preface 1
Scope of the manual 

This manual contains the description of the FM 452 electronic cam controller as valid at the 
time it was published. We reserve the right to publish modifications of FM 452 functionality in 
a separate Product Information. 

 
... is valid for FM 452 The Manual with the Number 

in the Page Footer .... Order No. [MLFB] Version 
EWA 4NEB 720 6012-01 

 
EWA 4NEB 720 6012-01 a 

6ES7 452-1AH00-0AE0 

 or  
C79000-G7000-C452-03 
A5E01071729-01 

6ES7 452-1AH00-0AE0 
 

Content of this manual 
This manual describes the hardware and software of the FM 452 electronic cam controller.  
It comprises: 
● Fundamentals part (Chapters 1 to 8) 
● Reference part (Chapters 9 to 13) 
● Appendices (A, B, and C) 
● Index 

Recycling and disposal 
The FM 452 is low in contaminants and can therefore be recycled. For ecologically 
compatible recycling and disposal of your old device, contact a certificated disposal service 
for electronic scrap. 
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CE label 
Our products meet the requirements of EC Directive 89/336/EEC "Electromagnetic 
Compatibility" and the harmonized European Standards (EN) listed there. 
Our products conform to the requirements and safety objectives of the EC Directives listed 
below. They are compliant with the harmonized European Standards (EN) for programmable 
logic controllers as published in the official gazettes of the European Community: 
● 89/336/EEC "Electromagnetic Compatibility" (EMC Directive) 
● 94/9/EC "Equipment intended for use in potentially explosive atmospheres" (ATEX) 
● 1999/5/EC "Radio and telecommunications terminal equipment" (RTTE Directive) 
The EU conformity certificates are available for the relevant authorities and are kept at the 
following address: 
Siemens Aktiengesellschaft 
Automation & Drives 
A&D AS RD ST Typetest 
P.O. Box 1963 
D-92209 Amberg 



 

FM 452 Installation and Parameter Assignment 
Operating Instructions, 07/2007, A5E01071729-01 9 

Product overview 2
2.1 FM 452 

Description 
The FM 452 function module is a single-channel, electronic cam controller for integration in 
the S7-400 automation system. It supports rotary and linear axes. The module supports 
proximity switches, and incremental/absolute encoders (SSI) for position feedback. When 
operating in slave mode, the FM 452 can listen in on the SSI frame of an absolute encoder.  
You can program up to 128 position or timing cams that you can assign to 32 cam tracks as 
required. The first 16 cam tracks are output at the digital outputs of the module. For 
information about the functions and settings of the cam control, refer to the next chapters. 
You can operate several FM 452 stations in parallel. The module also supports combinations 
with other FM/CP modules. A typical application is the combination of the module with an FM 
451 positioning module. 

 
Figure 2-1 Configuration of a SIMATIC S7-400 with FM 452 
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2.2 Fields of application of FM 452 

Example: Applying glue tracks 
In the following example, glue tracks are applied to wooden boards. Each cam track controls 
one glue nozzle via a digital output. 

 
Figure 2-2 Example of an electronic cam control 

Example: Press control 
The automation of an eccentric press using a cam controller is another typical application. 
Press operation is based on a rotary motion, i.e., the rotary axis rotates 360 degrees and 
then starts the next cycle at zero. 
Typical tasks of an electronic cam controller: 
● Switching a lubricating system on and off 
● Enabling pick-up and release of materials (for example, gripper control) 
● Stopping the press at the "upper dead center" 

Example: Packaging unit 
Preserves are packed on an automatic rotary turntable. The electronic cam controller 
triggers actions at specific angular positions: 
● Inserting and unfolding the cardboard box on the automatic rotary turntable 
● Filling the preserves into the cardboard boxes 
● Closing the cardboard boxes 
● Transfer of the cardboard boxes to a conveyor 



 Product overview 
 2.3 Configuration of an electronic cam control with FM 452 

FM 452 Installation and Parameter Assignment 
Operating Instructions, 07/2007, A5E01071729-01 11 

2.3 Configuration of an electronic cam control with FM 452 

Components of the electronic cam control 
The following figure shows the components of an electronic cam control. These are 
described briefly below. 

 
Figure 2-3 Electronic cam control 

Power drive and safety system 
The motor is controlled by the power drive. The power drive may consist, for example, of a 
protective circuit that is controlled by an FM 451 positioning module. 
The power drive shuts off the motor if the safety system responds (EMERGENCY STOP or 
limit switch). 

Motor 
The motor drives the axis, controlled by the power drive. 
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FM 452 electronic cam controller 
The electronic cam controller determines the actual position value of the axis based on an 
encoder signal. It evaluates the encoder signals (for example, by counting the pulses) that 
are proportional to the distance traveled. Based on the actual position value, it sets or resets 
the digital outputs ("cams"). The processing stations are controlled by signals at the digital 
outputs. 

Encoder 
The encoder returns position and direction data. 

CPU 
The CPU executes the user program. The user program and the module exchange data and 
signals by means of function calls. 

PG/PC 
The electronic cam controller is programmed and assigned its parameters using a PG or PC. 
● Programming: You program FM 452 using the programming interface or the parameter 

DB. 
● Programming: You program the FM 452 with functions that you can integrate directly in 

the user program. 
● Testing and commissioning: You test the FM 452 using the programming interface with 

which you also finally put the system into operation. 
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Cam control basics 3
3.1 Properties of the cam types 

Cam types 
You can program each cam for operation as position cam or timing cam. 
The following table shows a comparison of the properties of both cam types.  

Directional recognition 
The direction of the axis motion is determined as follows:  
● At each pulse of the incremental encoder. 
● With each error-free frame of an SSI encoder. 
Definition and switching of the two cam types 

 
 Position-based cam Time-based cam 
Representation 

 
 

 

Parameters 
assignment 

You program the: 
• Cam start 
• Cam end position 
• Effective direction 
• Lead time 

You program the: 
• Cam start 
• Cam activation time 
• Effective direction 
• Lead time 

Effective direction Two effective directions are supported: 
• positive: The cam is set at the start 

position, if the axis is moving in 
direction of increasing actual 
values. 

• negative: The cam is set at the end 
position, if the axis is moving in 
direction of decreasing actual 
values. 

You can set both effective directions in 
parallel. 

Two effective directions are supported: 
• positive: The cam is set at the start 

position, if the axis is moving in 
direction of increasing actual 
values. 

• negative: The cam is set at the start 
position, if the axis is moving in 
direction of decreasing actual 
values. 

You can set both effective directions in 
parallel. 
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 Position-based cam Time-based cam 
Enabling The cam is switched on: 

• At the cam start, when the axis is 
moving in positive direction and 
positive effective direction is set. 

• At the cam end, when the axis is 
moving in negative direction and 
negative effective direction is set. 

• If the actual value lies within the 
cam range. 

The cam is switched on: 
• At the cam start when the direction 

of movement of the axis matches 
the effective direction. 

After it has been activated, the full cam 
activation time expires even if the 
direction of movement of the axis 
changes after the cam is activated. The 
cam is not retriggered if its start 
position is passed again during the 
cam activation time. 

Shut-off The cam will be disabled if:  
• it has passed the programmed 

distance 
• its effective direction is reversed 

compared to the direction of the 
axis motion, and you have not 
programmed a hysteresis 

• the actual value is out of the cam 
range. 

The output cam is switched off on 
expiration of the programmed time. 

Path length The path length of the cam is defined 
by its start and end position. 
The cam start and end positions 
belong to the active section of the cam.

The path length of the cam is 
determined by the axis velocity within 
the cam activation time. 

On period The on period of the cam is determined 
by the speed at which the axis travels 
across the path length of the cam. 

The on period of the cam is set by 
programming the cam activation time. 
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3.2 Tracks and track result 

3.2.1 Standard tracks 

Cam tracks 
The 32 tracks can be used to control up to 32 different switching actions. You can evaluate 
the tracks based on the return signals. 
The first 16 tracks (track 0 to 15) are each assigned a digital output (Q0 to Q15) of FM 452 
which can be used for direct control of a connected contactor relay, for example.  

Track result 
The system provides up to 128 cams which can be assigned to user-specific tracks. 
Each track can be assigned several cams. The track result is a logic OR operation derived 
from all cam values of this track. 

Example of a track result 
You assign parameter to the following cams for track 3: 

 
Cams Cam start Cam end position 
1 101 µm 106 µm 
2 100 µm 104 µm 

This leads to the following track result: 

 
Figure 3-1 Calculating the track result 

Track enable 
In order to transfer the track results of tracks 0 to 15 as track signals to the digital outputs Q0 
to Q15 of the FM 452, you have to enable the tracks used. 
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External enable of tracks 3 to 10 
You can set an external enable for tracks 3 to 10 in the machine data. The track signals 3 to 
10 are then ANDed with digital inputs I3 to I10 before they can switch the respective digital 
outputs Q3 to Q10 of the FM 452. 
A digital output (Q3 to Q10) is switched when the following conditions are met: 
● The corresponding track is enabled. 
● At least one cam on this track is active (track result = 1). 
● The corresponding digital input I3 to I10 was set by an external event. 

Setting the track signals 
The track signals 0 to 15 (according to digital outputs Q0 to Q15) can be set by the cam 
control system, or by the CPU. 

3.2.2 Special tracks 

Definition  
You can program tracks 0 to 2 for operation as special tracks:  
● Track 0 or 1: Counter cam track 
● Track 2: Brake cam track 

Requirements 
The following requirements must be met to allow the use of the special tracks: 
● Cams are assigned to the track 
● Cam processing is active 
● The relevant track is enabled 
● The track is selected as a special track 

Counter cam track 
A counter cam track counts the status transitions of the track results on this track. 
Define a counter value, and then start the counter function. 
The counter value of the relevant track decrements by the count of 1 at each positive edge of 
the track result signal. 
The track flag bit = 0 as long as the value of the counter cam track is not equal to zero. 
The controller sets the track flag bit and, if assigned parameters accordingly, the track signal 
when the counter value = 0. 
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It resets the track flag bit, and sets the default value of the counter at the next negative edge 
of the track result signal (all cams on this track are disabled). 

 
Figure 3-2 Setting a counter cam track 

Brake cam track  
To use track 2 as a brake cam track, digital input I0 must be interconnected. 
A positive edge of the I0 signal sets the track flag bit. 
The track flag bit is reset again when: 
● there is no longer a "1" signal at I0 and afterwards 
● the controller has detected a negative edge at the track 2 result signal. 

 
Figure 3-3 Setting a brake cam track 

In the example, the track flag bit is reset by a negative edge at cam 3 or 4. 

See also 
● Interfaces of the cam controller (Page  20) 
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3.3 Hysteresis 

Definition 
Mechanical imbalance at the axis may cause fluctuation of the actual position value. If the 
actual position value is offset by one edge of a cam, or within an active cam with only one 
effective direction, this cam's activation would be cycled on and off continuously. A 
hysteresis prevents this flutter. 
A hysteresis setting is dependent on the actual value, and applies globally to all cams. It is 
enabled when a direction reversal is detected. A hysteresis will always take effect, 
regardless of whether or not a cam is set at the current axis position. 

Rules for the hysteresis range 
Rules applicable to the hysteresis range: 
● The hysteresis will always be set when a directional reversal is detected. 
● The indication of the actual value remains constant within the hysteresis. 
● The direction is not redefined within the hysteresis. 
● A distance cam is neither set nor reset within the hysteresis. 
● A time-based cam is not set within the hysteresis. An active time-based cam is disabled 

on expiration of the programmed cam activation (not only on reaching the hysteresis 
limit). 

● When the value is out of the hysteresis range, the FM 452 sets: 
– the actual position value 
– the current direction of motion of the axis 
– the current states of all cams 

● The hysteresis range applies to all cams. 

Directional reversal of a cam with hysteresis 
The table illustrates the reaction to directional reversal of a cam. A distinction must be made 
between the reaction of position- and time-based cams. The effective direction of the cam is 
positive.  
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Table 3-1 Effects of a reversal of the cam direction 

Position-based cam Time-based cam 

The hysteresis becomes active after a reversal of 
direction is detected. The cam will be disabled 
immediately when the the hysteresis range is 
violated. 

The cam always remains active within the set 
cam activation time. 

Output cam:  
Hysteresis:  
 

 

3.4 Dynamic adjustment 

Task 
The dynamic adjustment is used to compensate delay times of the connected control 
elements. 

Lead time 
You can program a delay time and assign it as lead time to each cam. You can assign one 
lead time to each cam. The lead time applies to the cam start and end position.  

Actuation distance 
The actuation distance of a cam is calculated continuously based on the current velocity and 
lead time. The entire cam is shifted in direction of the actual value by this value. The 
programmed range is the "static range," and the range calculated based on the lead time 
represents the "dynamic range." 
Actuation distance = lead time x actual velocity of the axis 
Calculation of the lead distances of all cams is carried out within ¼ of the longest selected 
lead time in the FM 452.  
An extremely high lead time of a cam reduces the dynamic performance of cam processing. 
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3.5 Interfaces of the cam controller 

Overview 
The diagram below shows the most important interfaces to illustrate the relationship between 
data, inputs and outputs. 

 

4 
6 

1 

2 

3 

5 

7 8 

 

 

 

 
Figure 3-4 Interfaces of FM 452 

For information on the diagram, refer to the table below. 
 

No. Description 
① The FM 452 cam processing functions calculate the cam flag bits based on switching 

conditions and actual values. The module also determines the track results according to the 
assignment of the cams to the tracks. 

② When track 0 or 1 is programmed as counter cam track, the track result of the cam controller 
(point 1) is logically linked to the counter result in order to produce the track flag bit. The track 
flag bit is otherwise equivalent to the track result. 

③ When track 2 is programmed as brake cam track, the track result of the cam controller (point 1) 
is logically linked to input I0 to produce the track flag bit. The track flag bit is otherwise 
equivalent to the track result. 
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No. Description 
④ Using machine data, you can control whether the previously determined track flag bits of tracks 

0 to 15 of the cam controller are passed on, or whether they are set directly by the track enable 
signal (TRACK_EN). 

⑤ You enable the track signals of tracks 0 to 15 by setting TRACK_EN, and the count function by 
setting CNTC0_EN/CNTC1_EN. 

⑥ The track signals of tracks 3 to 10 can be ANDed with digital inputs I3 to I10 if you have 
enabled this option in the machine data (EN_IN_I3 to EN_IN_I10). 

⑦ All track and cam flag bits can be read at this location (i.e., before these are logically linked 
with machine and channel data) using the ACTPOS_EN or CAMOUT_EN job. 
At tracks 3 to 31, the track flag bit is equivalent to the track result (point 1). 

⑧ After having been logically linked with the machine/channel data, the track signals of tracks 0 
to 15 are available in the return signals. The track signals of tracks 16 to 31 and the track flag 
bits of point 7 are identical. The track signals of tracks 0 to 15 are also available at the digital 
outputs Q0 to Q15. 
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Installing and removing the FM 452 4
Important safety rules 

When integrating an S7-400 with an FM 452 in a plant or system, there are important rules 
and regulations that are described in the installation manual S7-400/M7-400 Programmable 
Controllers, Hardware and Installation. 

Selecting slots 
The electronic cam controller FM 452 can be installed in a central or expansion rack just like 
a signal module. 

Mechanical configuration 
The options available for the mechanical layout of your system and how to configure the 
system are described in the installation manual S7-400/M7-400 Programmable Controllers, 
Hardware and Installation. 

Installation and removal tools 
You require a 4.5 mm screwdriver to install or remove the FM 452. 

Installing the FM 452 electronic cam controller 
1. Hook in the FM 452 at the top and swing it down. 
2. Secure the FM 452 with screws (torque approximately 0.8 to 1.1 N/m.) 
3. Label the FM 452 with its slot number. Use the number wheel included with the rack. 

The numbering scheme and numbering of slots is described in the installation manual S7-
400/M7-400 Programmable Controllers, Hardware and Installation. 

Removing the FM 452 electronic cam controller 
1. Switch off the power control unit. 
2. Release the front connector and remove it. 
3. Loosen the mounting screws on the module. 
4. Swing the module upwards and remove it. 
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Wiring FM 452 5
5.1 Before you start wiring 

Important safety rule 
It is essential for the safety of the system to install the elements listed below and to adapt 
these to your system. 
● EMERGENCY OFF switch to shut off the entire system. 
● EMERGENCY OFF limit switches directly affecting the power units of all drives. 
● Motor circuit-breakers. 
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5.2 Terminal assignment of the front connector 

Front connectors 
Connect the encoder, the digital inputs and outputs, and the auxiliary power supplies using 
the 48-pin front connector. 

Terminal assignment of the front connector 
 

Pin Name Proximity switch Incremental encoder Absolute encoder 
1  --- 
2  --- 
3 1L+ Auxiliary supply 24 V DC 
4 A/DAT --- Encoder signal A (5 V) SSI data 
5 /A / /DAT --- Encoder signal A inverse (5 V) SSI data inverse 
6 B/CLI 1 --- Encoder signal B (5 V) SSI shift clock input 1 
7 /B / /CLI 1 --- Encoder signal B inverse (5 V) SSI shift clock input inverse 1 
8 N --- Zero mark signal (5 V) --- 
9 /N --- Zero mark signal inverse (5 V) --- 
10 CLS 2 --- --- SSI shift clock output 
11 /CLS 2 --- --- SSI shift clock output inverse 
12 A* Encoder signal A (24 V) --- 
13 B* --- Encoder signal B (24 V) --- 
14 N* --- Zero mark signal (24 V) --- 
15 Q0 Digital output 0 
16 Q1 Digital output 1 
17 Q2 Digital output 2 
18 Q3 Digital output 3 
19 Q4 Digital output 4 
20 Q5 Digital output 5 
21 Q6 Digital output 6 
22 Q7 Digital output 7 
23 5.2 V DC --- Encoder supply (5.2 V) 
24 24 V DC Encoder supply (24 V) 
25 M3 Encoder ground 
26 2L+ Auxiliary supply 24 V DC 
27 Computer 

Unit 
--- Sourcing/sinking (see Appendix B3) --- 

28 Q8 Digital output 8 
29 Q9 Digital output 9 
30 Q10 Digital output 10 
31 Q11 Digital output 11 
32 Q12 Digital output 12 
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Pin Name Proximity switch Incremental encoder Absolute encoder 
33 Q13 Digital output 13 
34 Q14 Digital output 14 
35 Q15 Digital output 15 
36 3L+ Auxiliary supply 24 V DC 
37 I0 Brake cam track enable 
38 I1 Length measurement/ edge detection/ set actual value on-the-fly 
39 I2 Home position switch 
40 I3 Enable track signal 3 
41 I4 Enable track signal 4 
42 I5 Enable track signal 5 
43 I6 Enable track signal 6 
44 I7 Enable track signal 7 
45 I8 Enable track signal 8 
46 I9 Enable track signal 9 
47 I10 Enable track signal 10 
48 M3 Ground for auxiliary voltages 
1 In listen mode 
2 In master mode 
3 Ground connections wired on module 

Auxiliary voltage for sensors and DA (1L+, 2L+, 3L+) 
The 24 V DC auxiliary voltage of the encoders and digital outputs is monitored: 
● for wire-break of the 24 V feed line 
● for power failure 
The 24 V DC auxiliary supply is converted internally to 5.2 V DC. This means that 24 V DC 
(terminal 24) and 5.2 V DC (terminal 23) are available on the front connector for the different 
types of encoders. 
The general technical data and requirements of the DC power supplies are described in the 
installation manual S7-400/M7-400 Programmable Controllers, Hardware and Installation.  

11 digital inputs (I0 to I10)  
You can connect bounce-free switches (24 V current sourcing) or non-contact sensors (2 or 
3-wire proximity switches) via 11 digital inputs. 
The digital inputs are not monitored for short-circuits or wire-break, and are connected to 
ground potential of the module. 
A separate LED indicates the state of each input. 



Wiring FM 452  
5.2 Terminal assignment of the front connector 

 FM 452 Installation and Parameter Assignment 
28 Operating Instructions, 07/2007, A5E01071729-01 

16 digital outputs (Q0 to Q15)  
The state (on/off) of tracks 0 to 15 is output at 16 digital outputs. The digital outputs are 
connected to ground potential of the module. 
Loads supported: 
● Operating voltage 24 V 
● Current load 0.5 A/short-circuit proof 
A separate LED indicates the state of each output. 
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5.3 Wiring front connectors 

Connecting cables 
● The cables for digital IO must be shielded if they exceed a certain lengths: 

– Digital inputs: cable length of more than 32 m 
– Digital outputs: cable length of more than 100 m 

● The encoder cables must be shielded. 
● The shields of the encoder cables must be terminated at the shielding/grounding busbar 

bar and at the I/O connector. 
● The A, /A, B, /B and N, /N lines of the incremental encoder must be twisted in pairs. 
● Use flexible connecting cables with a conductor cross-section of 0.25 mm to 1.5 mm2 
● Wire end ferrules are not required. However, should you prefer to use these, you can 

crimp and wire two wires with a conductor cross-section of 0.25 to 0.75 mm2 using a 
single ferrule without insulation collar (DIN 46228, design A, short version). 

 

 Note 
Always use shielded cables to wire measuring sensors or proximity switches in order to 
achieve maximum noise immunity. 

 

Notes on wiring the 24 V DC supply 
Wire the 24 V DC auxiliary supply to the encoders and digital outputs to pins 36, 26 and 3. 
Remember that all terminals 1L+ to 3L+ must be wired for the module to operate error-free. 
You can use up to three power supplies. 
Note that all supply voltages are connected to a common ground. 
The absence of the auxiliary voltage is indicated by a diagnostic event. 

 

CAUTION  
The module can be damaged. 
If you reverse the polarity of the encoder supply, the module will be destroyed and must be 
replaced. 
Make sure the polarity of the 24 V DC supply is correct (auxiliary voltage 1L+, 2L+, 3L+ and 
chassis ground M.) 
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Equipotential bonding 
The ground potentials of the auxiliary voltages are bound to CPU ground, i.e., you require a 
low impedance interconnection of pin 48 (M) with CPU ground. 
You also require a low impedance interconnection of the external encoder supply ground 
with CPU ground. 

 
Figure 5-1 Grounding Diagram 

 
(1) Power control 
(2) Shielding/grounding busbar 
(3) Chassis ground 
(4) Pin 48 (M for auxiliary supply) 
(5) Auxiliary voltage 

Tools required 
3.5 mm screwdriver or power screwdriver 
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Wiring procedure 
 

CAUTION  
Risk of injury or material damage if the power supply is not shut off. 
If you wire the FM 452 front connector while the system is in live state, you will risk injury 
from electric shock. 
Always switch off power before you wire the FM 452. 
If no EMERGENCY OFF switch is installed, damage may be caused by connected 
aggregates. 
Install an EMERGENCY OFF switch to be able to shut down the connected drives while 
operating the FM 452 at the programming interface. 

 
Follow the steps outlined below to wire the front connector: 
1. Remove the front connector cover. 
2. Strip the cable insulation over a length of 6 mm. 
3. Are you going to use wire end ferrules? 

If yes: Crimp the wire end ferrules onto the conductor. 
4. Place the enclosed strain relief into the front connector. 
5. Start wiring from the bottom. You should also tighten any unused screw terminals of the 

front connector (tightening torque 0.6 N/m to 0.8 N/m.) 
6. Tighten the strain relief for the cable harness. 
7. Close the front connector. 
8. Label the connections using the enclosed labeling strip. 

Further information 
A detailed description of the front connector wiring is included in the installation manual S7-
400/M7-400 Programmable Controllers, Hardware and Installation. 
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Installing software 6
Introduction 

You program the FM 452 using the programming interface. This interface is designed for FM 
452 and FM 352. A description of the Programming interface is available in the Online Help.  

Requirements 
● Before starting to assign parameters to the FM 452 electronic cam controller, note the 

requirements in the readme.rtf file, in particular, the required version of STEP 7. The 
readme.rtf file is available on the CD included in your shipment. 

Installation  
The software package is available on the included product CD. How to install the software:  
1. Place the CD into the drive of your PG/PC. 
2. In this dialog, select the CD drive and the Setup folder, then double-click Setup.exe to run 

Setup. 
3. Follow the instructions of the Setup program. 

Result: Setup installs the software in the folders listed below: 
– SIEMENS\STEP7\S7LIBS\FMx52LIB: FCs and UDTs 
– SIEMENS\STEP7\S7FCAM: Programming interface, Readme, Online Help 
– SIEMENS\STEP7\EXAMPLES\zEn19_01 and zEn19_02: Examples for FM 452 and 

FM 352 
– SIEMENS\STEP7\MANUAL: Manual 

 

  Note 
If you installed STEP7 in a folder other than SIEMENS\STEP7, the setup will enter this 
path. 

Configuring and programming 
For information, refer to the relevant chapter of this manual. 

See also 
● Commissioning the FM 452 (Page  59) 

http://www.efesotomasyon.com/html/siemens/siemens.html
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Programming FM 452 7
7.1 Basics of Programming an FM 452 

Task 
You can assign parameters, control and commission the FM 452 module from a user 
program. To exchange data between the user program and module, you use the functions 
(FCs) and data blocks (DBs) described below.  

Preparatory steps 
● Open the FMx52LIB block library in SIMATIC Manager. Copy the required functions 

(FCs) and block templates (UDTs) to the block folder of your project. If the block numbers 
are already being used, assign new numbers. The block names are entered unchanged 
in the symbol table of your S7 program.  
– CAM_INIT (FC 0):  

This is required to initialize the channel DB following a module startup. 
– CAM_CTRL (FC 1):  

This is required for data exchange with the module. 
– CAM_DIAG (FC 2):  

This is required when you process detailed diagnostic information in the program, or 
want to make this information available to an operator control and monitoring system. 

– CAM_MSRM (FC 3):  
This is required to immediately read the results of a length measurement or edge 
detection after a hardware interrupt. 

– CAM_CHANTYPE (UDT1):  
This is required to generate a channel DB, which is used by the FCs CAM_INIT, 
CAM_CTRL, and CAM_MSRM. 

– CAM_DIAGTYPE (UDT2):  
This is required to generate a diagnostics DB, which is used by FC CAM_DIAG. 

– CAM_P016TYPE (UDT3):  
This is required to generate a parameter DB with machine data and data for 16 cams, 
which is used by FC CAM_CTRL to write or read machine or cam data. 

– CAM_P032TYPE (UDT4):  
Same as CAM_P016TYPE, but for 32 cams. 

– CAM_P064TYPE (UDT5): 
Same as CAM_P016TYPE, but for 64 cams. 
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– CAM_P128TYPE (UDT6):  
Same as CAM_P016TYPE, but for 128 cams. 

● Create data blocks using the UDTs in the block folder of your S7 program. You require a 
separate set of data blocks for each module used. 

● Enter the module address in the channel DB and, if used in the diagnostic DB, also at the 
address MOD_ADDR. You can also have the address entered automatically by selecting 
the module in HW Config, and then selecting a data block from the "Properties" dialog by 
clicking the "Mod Addr" button. 

● If your PG/PC is connected to a CPU, you can now download the FCs and DBs to the 
CPU. 
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7.2 FC CAM_INIT (FC 0) 

Tasks 
FC CAM_INIT initializes the following data in the channel DB:  
● The control signals 
● The return signals 
● The trigger, done and error bits of the jobs 
● The function switches and their done and error bits 
● Job management, and the internal buffers for FC CAM_CTRL and FC CAM_MSRM 

Call-up 
The function must executed after a startup (power on) of the module or CPU. You should 
therefore install it, for example, in the warm restart OB (OB100) and the removal/insertion 
OB (OB83), or call it in the initialization phase of your user program. This ensures that your 
user program does not access obsolete data after a CPU or module restart.  

Call parameters 
 

Name Data type P-type Meaning 
DB_NO INT I Number of the channel DB 

Return values 
This function does not return a return value.  
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7.3 FC CAM_CTRL (FC 1) 

Tasks 
You can use FC CAM_CTRL to read operating data from the module, initialize the module, 
and control it in RUN. For these tasks, you use the control signals, the return signals, and 
write and read jobs. 
Each time it is called, the function performs the following actions: 
● Read return signals: 

FC CAM_CTRL reads all return signals from the module and enters these in the channel 
DB. The control signals and jobs are not executed until this task is completed, and thus 
the checkback signals reflect the module status prior to the block call.  

● Write control signals: 
The control signals written to the channel DB are transferred to the module. Enabling of 
cam processing, however, is delayed as long as the trigger for a "Set reference point" job 
or "Write cam data" job is set. The activation (or reactivation) of cam processing is 
delayed by this time.  

● Execute job: 
The next job is executed based on the trigger bits for jobs entered in the channel DB.  

Call-up 
This function must be called cyclically.  
Before you call the function, enter all the data in the channel DB that are required to execute 
the required functions.  

Data used 
● Channel DB: 

The module address must be entered in the channel DB. 
● Parameter DB: 

If you want to write or read machine or cam data using jobs, you require a parameter DB 
whose number must be entered in the channel DB. The size of the parameter DB must 
be adequate for the number of cams.  
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Jobs 
Data exchange with the module other than the control and return signals is handled using 
jobs.  
To start a job, set the corresponding trigger bit in the channel DB, and provide the relevant 
data for write jobs. You then call FC CAM_CTRL to execute the job.  
A read job is executed immediately. Due to the required confirmations from the module, a 
write job requires at least 3 calls (or OB cycles).  
You can send several jobs at the same time, if necessary, along with control signals. Apart 
from the job for writing the function switch, the jobs are executed in the order of the trigger 
bits as specified in the channel DB. Once a job has been completed, the trigger bit is reset. 
The next time the block is called, the next job is located and executed.  
For each job there is not only a trigger bit but also a done bit and an error bit. In their names, 
instead of the ending _EN (for "enable"), they have the ending _D (for "done") or _ERR (for 
"error"). Done and error bits of the job should be set to 0 after they have been evaluated or 
before the job is started. 
If you set the JOBRESET bit, all the done and error bits are reset before the pending jobs 
are processed. The JOBRESET bit is then set to 0 again. 

Function switch 
The function switches activate and deactivate module states. A job for writing the function 
switches is only executed when there is a change in a switch setting. It is always executed 
between the jobs "set reference point" (REFPT_EN) and "set actual value" (AVAL_EN). The 
setting of the function switch is latched after the job has been executed. 
Length measurements and edge detection must not be activated at the same time. FC 
CAM_CTRL makes sure that when one of the function switches is activated, the other is 
deactivated. If you do switch both function switches at the same time (0 -> 1), the length 
measurement is activated.  
Function switches and jobs can be used at the same time in one FC CAM_CTRL call.  
As with the jobs, there are done bits with the ending _D and error bits with the ending _ERR 
for the function switches. 
To be able to evaluate the done and error bits, you should set these bits to 0 when you 
change a function switch.  

Startup 
When the module or CPU starts up, call FC CAM_INIT. Among other things, this resets the 
function switches.  
FC CAM_CTRL acknowledges the module startup. During this time, RET_VAL and 
JOBBUSY = 1.  
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Call parameters 
 

Name Data type P-type Meaning 
DB_NO INT I Number of the channel DB 
RET_VAL INT O Return value 

Return values 
The function returns the following return values: 

 
RET_VAL BR Description 

1 1 At least 1 job active 
0 1 No job active, no error 
-1 0 Error: 

Data error (DAT_ERR) or  
Communication error (JOB_ERR) occurred 

Job status 
You can check the status of job execution using the return value RET_VAL and the 
JOBBUSY activity bit in the channel DB. You can evaluate the status of a single job based 
on the trigger, done, and error bits of the job.  
● Job active: 

– RET_VAL = 1 
– JOBBUSY = 1 
– Trigger bit = 1 
– Done bit = 0 
– Error bit = 0 

● Job completed without error: 
– RET_VAL = 0 
– JOBBUSY = 0 
– Trigger bit = 0 
– Done bit = 1 
– Error bit = 0 

● Job completed with error: 
– RET_VAL = -1 
– JOBBUSY = 0 
– Trigger bit = 0 
– Done bit = 1 
– Error bit = 1 
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● Write job aborted: 
– RET_VAL = -1 
– JOBBUSY = 0 
– Trigger bit = 0 
– Done bit = 0 
– Error bit = 1 

Reaction to errors  
If faulty data were written by a write job, the module returns the alarm DATA_ERR = 1. If an 
error occurs in communication with the module during a write or read job, the cause of the 
error is entered in the JOB_ERR parameter in the channel DB.  
● Error in a write job:  
If an error occurs in a job, the trigger bit is reset and the error bit (_ERR) and the done bit 
(_D) are set. The trigger bit is reset and the error bit (_ERR) is set for all write jobs still 
pending.  
The read jobs pending continue to be processed. JOB_ERR is set again for each job. 
● Error in a read job:  
If an error occurs in a job, the trigger bit is reset and the error bit (_ERR) and the done bit 
(_D) are set.  
The read jobs still pending continue to be processed. JOB_ERR is set again for each job. 
For further error information, refer to the JOB_ERR and DATA_ERR parameters. 

See also 
● Options of error diagnostics (Page  137) 
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7.4 FC CAM_DIAG (FC 2) 

Tasks 
Use FC CAM_DIAG to read the data of diagnostics buffer of the module, and make these 
available for visualization on an operating and monitoring system, or to a programmed 
evaluation function. 

Call-up  
This function must be called cyclically. A further call in an interrupt OB is not permitted. At 
least 2 calls (cycles) are required to complete execution of this function.  
The function reads the diagnostic buffer when a new entry is indicated in the diagnostic 
buffer by the return signal DIAG = 1. After reading the diagnostic buffer, DIAG is set to 0 by 
the module. 

Data used 
The module address must be entered in the diagnostic DB. The last entry in the diagnostics 
buffer is entered in the DIAG[1] structure, and the first entry in the DIAG[4] structure. 

Jobs 
You can read the diagnostic buffer whether or not there is a new entry by setting the 
DIAGRD_EN trigger bit. After reading the diagnostic buffer, the trigger bit is set to 0.  

Startup 
There is no startup processing associated with the function.  

Call parameters 
 

Name Data type P-type Meaning 
DB_NO INT I Number of the diagnostics DB 
RET_VAL INT O Return value 

Return values 
The function returns the following return values: 

 
RET_VAL BR Description 

1 1 Job active 
0 1 No job active, no error 
-1 0 Error  
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Reaction to errors 
The cause of a job error can be read in the JOB_ERR parameter of the diagnostic DB. 

See also 
● Options of error diagnostics (Page  137) 
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7.5 FC CAM_MSRM (FC 3) 

Tasks 
You use FC CAM_MSRM when you want to evaluate the measurement data of length 
measurements or edge detection immediately in the hardware interrupt OB.  

Call-up  
The function is called in a hardware interrupt OB (for example OB 40). 

Data used 
The module address must be entered in the channel DB.  

Startup 
There is no startup processing associated with the function.  

Call parameters 
 

Name Data type P-type Meaning 
DB_NO INT I Number of the channel DB 
RET_VAL INT O Return value 

Return values 
The function returns the following return values:  

 
RET_VAL BR Description 

1 1 Job active 
0 1 No job active, no error 
-1 0 Error  
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Measurement Results and Status Information 
The measurement results and status information are entered in the channel DB: 
Interrupt measured data in the channel DB 

 
Address Name Type Start 

value 
Comment 

112.0 BEG_VAL DINT L#0 Start value 
116.0 END_VAL DINT L#0 End value 
120.0 LEN_VAL DINT L#0 Length 
56.0 JOB_ERR_M INT 0 Communication Errors 
58.0 JOBBUSY_M BOOL FALSE Job active 

Reaction to errors 
The cause of a job error can be read at the JOB_ERR_M parameter of the channel DB. 

See also 
● Options of error diagnostics (Page  137) 
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7.6 Data blocks 

7.6.1 Templates for data blocks 

Templates for data blocks 
The included library (FMx52LIB) contains a block template (UDT) for each data block. Based 
on this UDT, you can create data blocks with user-specific numbers and names.  

Optimizing the UDT 
To save memory, you can delete unused data areas at the end of the UDT 
CAM_CHANTYPE. Save the modified UDT under a different name. 
You can then generate a channel DB based on this UDT you optimized for your application. 
Functions which access deleted data areas can no longer be used.  
The included UDT for the machine and cam data are already tuned to the possible numbers 
of cams. They can be optimized in steps of 16 cams. 

7.6.2 Channel DB 

Task 
The channel DB forms the data interface between the user program and the FM 452 
electronic cam controller. It contains and accepts all data required for controlling and 
operating the module.  

Configuration 
The channel DB is divided into various areas: 

 
Areas of the channel DB 

Address* / version switch 
Control signals 
Return signals 
Function switch 
Trigger bits for write jobs 
Activation bits for read jobs 
Done bits 
Error bits 
Job management for functions 
Data for jobs  
* You can enter the address in the programming interface 
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7.6.3 Diagnostics DB 

Task 
The diagnostics DB provides the data storage for FC CAM_DIAG, and contains the module's 
diagnostics buffer prepared by this function.  

Configuration 
 

Structure of the diagnostics DB 
Module address 
Internal data 
Job status 
Trigger bit 
Prepared diagnostics buffer  
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7.6.4 Parameter DB 

Task 
All machine and cam data are saved to the parameter DB. These parameters can be 
modified by the user program, or by an operating and monitoring system. The modified data 
can be imported to the programming interface and visualized there. You can export data 
visualized on the programming interface to a parameter DB.  
A module may contain several parameter sets (for example, for various recipes) that you can 
select program-controlled.  

Configuration 
 

Structure of the parameter DB 
CAM_P016TYPE (UDT3) 
Machine data 
Cam data of cams 0 to 15 
CAM_P032TYPE (UDT4) 
Machine data 
Cam data of cams 0 to 31 
CAM_P064TYPE (UDT5) 
Machine data 
Cam data of cams 0 to 63 
CAM_P0128TYPE (UDT6) 
Machine data 
Cam data of cams 0 to 127 
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7.7 Interrupts 

7.7.1 Interrupt processing 

Procedure 
The FM 452 can trigger hardware and diagnostic interrupts. Process those interrupts in an 
interrupt OB. If an interrupt is generated and the corresponding OB is not loaded, the CPU 
changes to STOP (refer to the manual Programming with STEP 7).  
You can enable interrupt processing at the following levels: 
Enabling general interrupts for the entire module: 
● Select the module in HW Config. 
● Using the menu command Edit > Object Properties > Basic Parameters, enable 

diagnostic and/or hardware interrupts. 
● Select the OB number for the hardware interrupt using Edit > Object Properties > 

Addresses. 
● Save and compile the hardware configuration. 
● Download the hardware configuration to the CPU. 
Enabling events for hardware interrupts in the machine data. 
Setting parameters for hardware interrupts in the cam data for cams 0 to 7. 
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7.8 Evaluation of a hardware interrupt 

Hardware interrupt data 
If FM 452 generates a hardware interrupt, the following information is available at variable 
OB40_POINT_ADDR (or at the corresponding variable of a different hardware interrupt OB): 
Content of double word OB40_POINT_ADDR 

 
Byte Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0 

0 0 0 0 0 0 0 0 0 
1 0 0 Start of 

measure
ment 

0 0 Cams End of 
measure
ment 

0 

2 Cam 7 on Cam 7 off Cam 6 on Cam 6 off Cam 5 on Cam 5 off Cam 4 on Cam 4 off
3 Cam 3 on Cam 3 off Cam 2 on Cam 2 off Cam 1 on Cam 1 off Cam 0 on Cam 0 off

Byte 1 identifies the cause of the interrupt: 
● Cam: evaluate byte 2 and byte 3 according to the table. 
● Measurement start/measurement end: use the CAM_MSRM function to read the current 

measured values from the module. 

Lost hardware interrupts 
If the processing of a hardware interrupt is not yet completed in the hardware interrupt OB, 
the module registers all subsequent hardware interrupt events. If an event occurs again 
before the hardware interrupt could be triggered, the module triggers the "hardware interrupt 
lost" diagnostic interrupt.  
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7.9 Evaluating a diagnostics interrupt 

Diagnostics interrupt data 
Following a diagnostic interrupt, the diagnostic information is available in the local data of the 
OB82 and can be used for fast analysis. Call FC CAM_DIAG to find out the exact cause of 
error by reading the diagnostics buffer.  
The local data of the diagnostics interrupt OB that are supported are listed below. 

 
Tag Data type Description 

OB82_MDL_DEFECT BOOL Module error 
OB82_INT_FAULT BOOL Internal error 
OB82_EXT_FAULT BOOL External error 
OB82_PNT_INFO BOOL Channel error 
OB82_EXT_VOLTAGE BOOL Missing external auxiliary supply 
OB82_FLD_CONNCTR BOOL Front connector missing 
OB82_WTCH_DOG_FLT BOOL Watchdog timeout 
OB82_INT_PS_FLT BOOL Internal power supply of the module failed 
OB82_HW_INTR_FLT BOOL Hardware interrupt lost 
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7.10 Technical data 

Overview 
The following table provides an overview of the technical data of the functions.  

 
No. Block name Project 

version 
Load memory 
requirements 
(bytes) 

Work memory 
requirements 
(bytes) 

Local data area 
requirements 
(bytes) 

MC7 
code/data 
(bytes) 

System functions 
called 

FC 0 FC CAM_INIT 1.0 192 138 2 102  
FC 1 FC CAM_CTRL 1.0 5232 4754 32 4718 SFC 58: WR_REC, 

SFC 59: RD_REC 
FC 2 FC CAM_DIAG 1.0 1782 1638 42 1602 SFC 59: RD_REC 
FC 3 FC CAM_MSRM 1.0 296 226 16 190 SFC 59: RD_REC 
 Channel DB - 986 804 - 372  
 Parameter DB 16  

Parameter DB 32 
Parameter DB 64  
Parameter DB 128 

- 
- 
- 
- 

616 
808 
1192 
1960 

336 
528 
912 
1680 

- 
- 
- 
- 

300 
492 
876 
1644 

 

 Diagnostics DB - 460 338 - 302  

Module cycle 
The module refreshes return data (except in the pulses measuring system) at intervals of 4 
ms. 
In the pulses measuring system, the data for the actual position value and track signals are 
available after 0.5 ms. 
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Execution times 
The following table provides you with an overview of the execution times of the FM 452 
functions. It shows the runtime between the first function call to the done alarm (trigger bit 
reset). The cycle is extended by between 1 and 2 ms when a function is called. 
Execution times of FM 452 functions 

 
CPU 416-2 (6ES7 416-2XK01-0AB0) Block Block name/job 
Runtime in ms 

FC 0 FC CAM_INIT 0,01 
FC 1 FC CAM_CTRL 

control/return 
MDWR_EN 
MDWR_EN and MD_EN 
CAM1WR_EN (0 cams enabled) 
CAM1WR_EN (16 cams enabled) 
REFPT_EN 
SIM_ON 
AVAL_EN 
FVAL_EN 
ZOFF_EN 
CH01CAM_EN 
CH16CAM_EN (1 cams with check) 
CH16CAM_EN (1 cams without check) 
CH16CAM_EN (16 cams with check) 
CH16CAM_EN (16 cams without check) 
MDRD_EN 
CAM1RD_EN 
MSRRD_EN 
CNTTRC_EN 
ACTPOS_EN 
ENCVAL_EN 
CAMOUT_EN (FM_TYPE = 0, 16 bytes) 
CAMOUT_EN (FM_TYPE = 1, 24 bytes) 

0,06 
11,8 
15,6 
3,1 
5,4 
2,2 
2,3 
2,3 
2,3 
2,3 
2,3 
2,3 
2,3 
9,2 
8,5 
1,6 
2,1 
1,0 
1,0 
1,0 
1,0 
1,1 
1,1 

FC 2 FC CAM_DIAG 
Idle run 
Read diagnostic buffer 

0,02 
1,9 

FC 3 FC CAM_MSRM 0,5 
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7.11 High-speed access to module data 

Application 
Special applications or interrupt levels require particularly fast access to return and control 
signals. You can obtain those data directly by reading the IO areas of the module.  
To coordinate startup following each module startup (for example, after inserting the module, 
CPU STOP → RUN), call FC CAM_CTRL continuously until the end of the startup is 
indicated by RET_VAL = 0.  

 

 Note 
For direct access to FM 452 data, always use the non-internal data and method described in 
this section. Otherwise, your user program will encounter difficulties accessing the module. 

 

Direct access for reading return signals 
The byte addresses are defined with an offset to the output address of the module. The bit 
names correspond to the names in the channel DB. 
In STL, you access the data using the PIB (read 1 byte) and PID (read 4 bytes) commands.  

 
Address Bit number 

 7 6 5 4 3 2 1 0 
Byte 0 PARA interne interne DATA_ERR interne DIAG interne interne 
Byte 1 0 0 0 CAM_ACT 0 0 0 0 
Byte 2 interne 
Byte 3 0 0 FVAL_DONE HYS GO_P GO_M MSR_DONE SYNC 
Byte 4 
Byte 5 
Byte 6 
Byte 7 

 
ACT_POS 

Byte 8 
Byte 9 
Byte 10 
Byte 11 

 
TRACK_OUT 
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Direct write access to control signals 
The byte addresses are defined with an offset to the input address of the module. The bit 
names correspond to the names in the channel DB. 
In STL, you access the data using the PQB (write 1 byte) and PQW (write 2 bytes) 
commands.  

 
Address Bit number 

 7 6 5 4 3 2 1 0 
Byte 0 interne 
Byte 1 0 CNTC1_EN CNTC0_EN CAM_EN DIR_P DIR_M 0 0 
Byte 2 
Byte 3 

TRACK_EN 

Example: Actual position value (ACT_POS) 
 

STL 

Example The start address of the module is 512 
L PID 516 Direct read access to the actual position value (ACT_POS): 

module start address + 4 

 



Programming FM 452  
7.12 Parameter transfer routes 

 FM 452 Installation and Parameter Assignment 
56 Operating Instructions, 07/2007, A5E01071729-01 

7.12 Parameter transfer routes 

Transfer routes 
The term parameter refers to the following machine and cam data. 

 
Figure 7-1 Parameter transfer routes 

 
1 Save the parameters in the programming interface. 
2 Saving and compiling the HW configuration, and download to the CPU. 
3 The CPU writes the parameters to the module during system parameter assignment. 
4 Upload the module parameters to the PG by selecting the "PLC > Upload to PG" command. 
5 Download parameters from FM Config to the module with the "Download" command. 
6 Write parameters to the module using jobs in the user program. 
7 Read parameters from the module using jobs in the user program. 
8 Save parameters from the user program to the online DB. 
9 Write parameters from the online DB to the user program. 
10 Export parameters from the programming interface to the DB (offline or online DB); download 

the offline DB to the CPU. 
11  Import parameters from an online or offline DB into the programming interface. 
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Some use cases for the transfer of parameters: 
1. You edit the parameters on the programming interface. The parameter should then be 

assigned automatically to module during startup. 
Perform steps 1, 2, and 3 

2. You edit parameters on the programming interface in the commissioning test mode: 
Perform steps 4 and 5 

3. You set the parameters with the parameter assignment user interface. 
Perform steps 1, 2, and 3 

4. Create the parameters using the programming interface. When it starts up, the module 
should be assigned parameters only by the user program using data blocks: 
Perform steps 10 and 6 

5. You modify parameters (exclusively) using the user program: 
Perform steps 7, 9, 8, and 6 

6. Create the parameters using the programming interface. These should be available to the 
user program for temporary modifications. 
Perform steps 1, 2, and 3 for automatic programming. 
Perform steps 10, 7 to enable access by the user program. 

7. You want to create data for recipes: 
Perform step 10 

8. You want to see the data modified by the user program in the parameter assignment user 
interface. 
Perform step 11 

9. The parameters modified by the user program should be downloaded automatically 
during startup: 
Perform steps 6, 11, 1, 2, and 3 
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Commissioning the FM 452 8
General information 

Pay particular attention to the warnings below. 
 

 Note 
In order to prevent injury and material damage, please note the following: 
• Install an EMERGENCY STOP switch in the area of the computer. This is the only way to 

ensure that the system can be switched off safely in the event of a computer or software 
failure. 

• Install an EMERGENCY STOP limit switch which directly affects the power units of all 
drives. 

• Always make sure to prevent access to the plant areas containing moving parts. 
• When controlling and monitoring the FM 452 at the same time in both your program and 

in the Test > Commissioning dialog box, conflicts can arise whose effects are 
unpredictable. Hence, always set the CPU to STOP when working in the Test screen 
form, or disable the user program. 
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Hardware installation and wiring 
In this first section, you install the FM 452 in your S7-400, and wire the front connector. 

 
Step Action ✓ 

1 Installing the FM 452  
Insert the module in one of the slots available. 

 
⃞ 

2 Wiring the FM 452 
Wire the front connector of the FM 452: 
• Digital inputs 
• Digital outputs 
• Encoder connection 
• Power supply to the FM 452 

 
 

⃞ 
⃞ 
⃞ 
⃞ 

3 Check the limit switches relevant for safety 
Check for proper functioning 
• of the limit switches 
• of the emergency off equipment 

 
 

⃞ 
⃞ 

4 Front connectors 
The front connector must engaged. 

 
⃞ 

5 Check the shielding of the various cables ⃞ 
6 Switch on the power supply 

Switch the CPU to STOP (safe state). 
Switch on the 24 V supply for the FM 452. 

 
⃞ 
⃞ 

Setting up a project 
Now set up a project in STEP 7. 
The section below describes the steps when using SIMATIC Manager (without assistance 
from the wizard).  

 
Step Action ✓ 

1 If not already done, install the programming interface. ⃞ 
2 Create a new project in SIMATIC Manager by selecting File > New. ⃞ 
3 Add a station to your project (Insert > Station). ⃞ 
4 Select the station, then double-click "Hardware" to open the "HW Config" 

configuration interface. 
⃞ 

5 Insert a rack in your hardware configuration with the following: 
• Power supply module (PS) 
• CPU 
• Function module (FM) 

 
⃞ 
⃞ 
⃞ 

6 Save this hardware configuration in HW Config (Station > Save). ⃞ 
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Programming using the programming interface 
For initial commissioning of the module, program the device using the programming 
interface. Keep to the order specified below: 

 
Step Action ✓ 

1 Select the tier in the rack containing the FM 452 module. ⃞ 
2 Next, double-click the entry to open the programming interface for FM 452. ⃞ 
3 Select File > Properties to edit the following settings: 

• General 

You can edit the name, and enter a comment. 
• Addressed 

You can edit the start address, and assign the address area to a process image 
partition. Note down the module address shown. 

• Basic parameters 

You can set the interrupt class, and the reaction to a CPU STOP. 

⃞ 

4 In the block diagram shown, you can select the Axis, Encoders, Cams, Tracks and 
and Interrupt Enable dialog boxes, and set the relevant parameters. 

⃞ 

5 Save the parameter assignment with File > Save. ⃞ 
6 Close the programming interface by selecting File > Exit. ⃞ 
7 Save the hardware configuration in HW Config with Station > Save and Compile. ⃞ 
8 Go online and download the hardware configuration to the CPU. At each change 

from STOP to RUN, these data are transferred to the FM 452. 
⃞ 

9 Select Test > Commissioning. ⃞ 

Test and Commissioning 
You can now test your entries and changes. 

 
Step Action ✓ 

1 To test your commissioning data, select the Test > Commission, Test > Service and 
Test > Error Evaluation screen forms. 

⃞ 

2 You can modify faulty machine data in the Test > Commissioning  screen form. 
These modifications remain valid until the next STOP-RUN change on the CPU. 

⃞ 

3 You can save the corrected machine data to the CPU by repeating steps 7 to 9 of 
the sequence. 

⃞ 
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Tests for axis synchronization and switching behavior  
The tests described in the next section help you to validate FM 452 parameters. 

 
Step Action ✓ 

Synchronize the axis  
• Incremental encoder 

– Select "Set reference point". Enter 
the relevant value 

or 
– Set the "Retrigger reference point" 

function switch. 

• Absolute encoder 
– The FM 452 is always 

synchronized immediately after it 
has received its parameters. 

– Adjust the absolute encoder. You 
may first have to determine the 
precise value using the "set 
reference point" function. 

⃞ 
1 

Check the actual status of the axis. The physical position must match the value 
output on the display. 

⃞ 

2 Check the switching characteristics of the programmed cams and tracks. 
• Enable testing. 
• Execute the "Set reference point" function. 
• Activate cam processing. 
• Enable the track signals. 
• Rotate the encoder or 
• Set the simulation function switch. 

⃞ 

3 Test the other settings according to your application 
• Set reference point 
• Set actual value 

⃞ 

Getting prepared for programming 
You still need to create the blocks required in your project. 

 
Step Action ✓ 

1 Select the FMX52LIB library in SIMATIC Manager (File > Open > Libraries). ⃞ 
2 Copy the FC0 and FC1 functions, and the channel DB template UDT1 from the 

library to the blocks folder. 
⃞ 

3 Create a channel DB for each module based on the UDT1 template. ⃞ 
4 If you want to use a programmed diagnostic evaluation, copy FC2 and UDT2 and 

create a diagnostic DB for each module. 
⃞ 

5 If you require length measurement or edge detection with hardware interrupt, copy 
FC3. 

⃞ 

6 To write and read machine data in the user program, you require UDT3 for 16 cams, 
UDT4 for 32 cams, UDT5 for 64 cams, or UDT6 for 128 cams. 

⃞ 
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Preparing the channel DB 
 

Step Action ✓ 
1 Open the channel DB. ⃞ 
2 Check whether the module address has already been entered in the MOD_ADDR 

parameter. If not, enter it now. 
⃞ 

3 Save the channel DB (File > Save). ⃞ 

Preparing the diagnostics DB 
 

Step Action ✓ 
1 Open the diagnostics DB. ⃞ 
2 Check whether the module address has already been entered in the MOD_ADDR 

parameter. If not, enter it now. 
⃞ 

3 Save the diagnostic DB (File > Save). ⃞ 

Implementing the functions 
 

Step Action ✓ 
1 Implement the required functions in your user program. ⃞ 

Downloading blocks to the CPU 
 

Step Action ✓ 
1 Select the blocks in SIMATIC Manager, then download these with PLC > Download 

to CPU. 
⃞ 
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Machine and cam data 9
9.1 Machine data and cam data 

General information 
This chapter is relevant if you want to write the parameters directly to the module in the user 
program, and without using the programming interface. 
All machine and cam data are saved to the parameter DB. Enter the parameter DB number 
at the corresponding channel DB. 
On the programming interface, use the "Export" function to write data to the parameter DB, 
and the "Import" function to read its data. 

Steps in writing machine data and cam data 
Always edit machine data and cam data in the following order: 
1. Write machine data 
2. Enable machine data 
3. Writing cam data 
If you set the trigger bits for these jobs all at once, FC CAM_CTRL makes sure the jobs are 
processed in the correct order. 

9.2 Writing and enabling machine data 

Writing and enabling machine data 
Machine data are used to adapt the FM 452 to the axis and encoder. 
Machine data are stored in the parameter DB at addresses 3.1 to 104.0.  
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Initial parameter assignment 
If the module does not yet contain machine data (return signal PARA = 0), follow the steps 
outlined below to set initial parameters without using the programming interface: 
● Enter the new values in the parameter DB. 
● Download the parameter DB to the CPU. 
● Set the trigger bit in the channel DB: 

– Write machine data (MDWR_EN) 
● Call FC CAM_CTRL in the cyclic user program. 

Editing machine data 
To modify existing machine data (return signal PARA = 1) by means of the user program: 
● Enter the new values in the parameter DB. 
● Set the trigger bits at the channel DB: 

– Write machine data (MDWR_EN) 
– Enable machine data (MD_EN) 

● Call FC CAM_CTRL in the cyclic user program. 
● Check whether the previous cam data and the modified machine data are compatible. 
● Always write new cam data for the programmed cams, irrespective whether or not they 

have been changed (CAM1WR_EN...CAM8WR_EN) 
 

  Note 
If any parameters relevant for synchronization were modified, the synchronization will be 
canceled when the machine data are enabled. This operation also resets your settings, 
and deletes all machine data and cam data from the module. 
Parameters relevant to synchronization: 
• Axis Type 
• End of rotary axis 
• Encoder type 
• Distance per encoder revolution 
• Increments per encoder revolution 
• Number of revolutions 
• Reference point coordinate 
• Absolute encoder adjustment 
• Type of reference point retriggering 
• Direction adaptation 
• Number of cams 
• Start and end software limit switch 
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9.3 Read machine data 

Read machine data 
To read actual machine data from the module: 
● Set the trigger bit in the channel DB: 

– Read machine data (MDRD_EN) 
● Call FC CAM_CTRL in the cyclic user program. 

This saves the current machine data to the parameter DB on the CPU. 

Excerpt from the channel DB 
 

Address Name Type Start value Comment 
35.0 MDWR_EN BOOL FALSE 1 = write machine data  
35.1 MD_EN BOOL FALSE 1 = enable machine data 
37.1 MDRD_EN BOOL FALSE 1 = read machine data 

 

9.4 Writing cam data 

Writing cam data 
Cam data define the type and function principle of the cams and their assignment to the 
tracks. 
Cam data are stored in the parameter DB, starting at address 108.0. These data are 
grouped in packets, each consisting of 16 cams. 
Cam data are active immediately after having been written. 
To write cam data without using the programming interface: 
● Enter the new values in the parameter DB. 
● Download the parameter DB to the CPU. 
● Set the trigger bits at the channel DB (CAM1WR_EN...CAM8WR_EN) 
● Call FC CAM_CTRL in the cyclic user program. 
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9.5 Reading cam data 

Reading cam data 
To read actual cam data from the module: 
● Set the trigger bit in the channel DB: 

– Read cam data (CAM1RD_EN ... CAM8RD_EN) 
● Call FC CAM_CTRL in the cyclic user program. 

This saves the actual cam data to the parameter DB on the CPU. 

Excerpt from the channel DB  
 

Address Name Type Start value Comment 
35.3 CAM1WR_EN BOOL FALSE 1 = write cam data 1 (cams 0 to 15) 
35.4 CAM2WR_EN BOOL FALSE 1 = write cam data 2 (cams 16 to 31) 
35.5 CAM3WR_EN BOOL FALSE 1 = write cam data 3 (cams 32 to 47) 
35.6 CAM4WR_EN BOOL FALSE 1 = write cam data 4 (cams 48 to 63) 
35.7 CAM5WR_EN BOOL FALSE 1 = write cam data 5 (cams 64 to 79) 
36.0 CAM6WR_EN BOOL FALSE 1 = write cam data 6 (cams 80 to 95) 
36.1 CAM7WR_EN BOOL FALSE 1 = write cam data 7 (cams 96 to 111) 
36.2 CAM8WR_EN BOOL FALSE 1 = write cam data 8 (cams 112 to 127) 
37.2 CAM1RD_EN BOOL FALSE 1 = read cam data 1 (cams 0 to 15) 
37.3 CAM2RD_EN BOOL FALSE 1 = read cam data 2 (cams 16 to 31) 
37.4 CAM3RD_EN BOOL FALSE 1 = read cam data 3 (cams 32 to 47) 
37.5 CAM4RD_EN BOOL FALSE 1 = read cam data 4 (cams 48 to 63) 
37.6 CAM5RD_EN BOOL FALSE 1 = read cam data 5 (cams 64 to 79) 
37.7 CAM6RD_EN BOOL FALSE 1 = read cam data 6 (cams 80 to 95) 
38.0 CAM7RD_EN BOOL FALSE 1 = read cam data 7 (cams 96 to 111) 
38.1 CAM8RD_EN BOOL FALSE 1 = read cam data 8 (cams 112 to 127) 
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9.6 System of units 

Selecting a system of units 
Open the programming interface of the cam controller to select a specific system of units for 
data input and output (default: mm).  
You can also select the following physical units: 
● mm, inches, degree, and pulses. 

 

  Note 
When you change the system of units in the programming interface, all values will be 
converted based on the new physical unit system. This may lead to rounding errors.  
If you change the system of units using the machine data, the values are not recalculated 
automatically. 
Any change of the system of units from or to "pulses" disables cam processing, and 
prevents axis synchronization. 

System of units in the parameter DB 
 

Address Name Type Start value Comment 
8.0 UNITS DINT L#1 System of units 

1 = 10-3 mm  
2 = 10-4 inch 
3 = 10-4 degrees 
4 = 10-2 degrees 
5 = pulses 
6 = 10-3 degrees 

Standard physical units 
This manual always defines limit values in mm units. To define the limits in other physical 
units, convert the values as shown below: 

 
To convert you calculate 
mm → inch Limit value (inches) = limit value (mm) x 0.1 
mm → degrees  10-4 (4 decimal places) 

10-3 (3 decimal places) 
10-2 (2 decimal places) 

Limit value (grad) = limit value (mm) x 0.1 
Limit value (grad) = limit value (mm) x 1 
Limit value (grad) = limit value (mm) x 10 

mm → pulse Limit value (pulses) = limit value (mm) x 1000 
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9.7 Machine data of the axis 

Axis type 
 

Address Name Type Start value Comment 
12.0 AXIS_TYPE DINT L#0 Axis type 

0 = linear axis 
1 = rotary axis 

A linear axis has a limited physical traversing range. 
 

 
 
A rotary axis is not restricted in its motion range by mechanical limit stops. 
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End of rotary axis 
 

Address Name Type Start value Comment 
16.0 ENDROTAX DINT L#100000 End of rotary axis 

Range: 1 µm to +1 000 000 000 µm 
The "end of rotary axis" value is theoretically the highest actual value of the axis. However, the 
theoretical maximum value is never indicated, because it also represents the physical start position of 
the rotary axis (= zero).  
The highest rotary axis value displayed is:  
End of the rotary axis [µm] - resolution [µm/pulse] x 1 [pulse]  
 
Example: End of rotary axis = 1000 mm 
The displayed value jumps: 
• from 999 mm to 0 mm, at a positive rotational direction 
• from 0 mm to 999 mm, at a negative rotational direction. 
 
Rotary axis with absolute value encoders 
The rotary range (0 to end of rotary axis) of a rotary axis with an absolute encoder must be precisely 
equivalent to the total number of encoder steps. 

 
 

Reference point coordinate 
 

Address Name Type Start value Comment 
44.0 REFPT DINT L#0 Reference point coordinate 

Range: 
- 1 000 000 000 µm to + 1 000 000 000 µm 

Incremental encoder and proximity switch 
The "Retrigger reference point" function and a synchronization event defined by the "Type of 
reference point retriggering" assign the reference point coordinate to this event. 
Absolute encoder (SSI)  
An axis with an absolute encoder is always synchronized provided no error is detected (after transfer 
of the first error-free SSI frame). For further information, refer to the description of absolute encoder 
adjustment, which describes the interaction of the absolute encoder adjustment with other data. 
Linear axis 
The value of the reference point coordinate must always lie within the working range (including the 
start and end software limit switches). 
Rotary axis 
The value of the reference point coordinate must be greater than or equal to 0, and less than the "end 
of rotary axis" value (0 ≤ reference point coordinate < "end of rotary axis"). 
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Retrigger reference point:  
 

Address Name Type Start value Comment 
52.0 RETR_TYPE DINT L#0 Type of reference point retriggering 

Ranges: 
0 = reference point switch and zero mark 
direction + 
1 = reference point switch and zero mark 
direction - 
6 = only reference point switch 
7 = only zero mark 

By setting the "type of reference point retriggering", you define the synchronizing conditions of an 
axis operating with an incremental encoder or a proximity switch. 

Start and end software limit switch 
 

Address Name Type Start value Comment 
64.0 
68.0 

SSW_STRT 
SSW_END 

DINT 
DINT 

L# -100 000 000 
L# 100 000 000 

Start software limit switch 
End software limit switch 
Range: 
- 1 000 000 000 µm to 1 000 000 000 µm 

 
Those axis data are only of significance to a linear axis. 
The software limit switches are enabled after the FM 452 is synchronized. The range set by 
the software limit switches represents the working range. FM 452 can monitor working range 
limits. 
The value of Software Limit Switch Start (SLSS) must always be less than the value of 
Software Limit Switch End (SLSE). 

 
 

Absolute encoder 
The FM 452 is synchronized after it has received a faultless frame. It monitors the software 
limit switches as of this time. The absolute encoder used must cover at least the working 
range (software limit switch start position to software limit switch end position). 
Incremental encoder and proximity switch 
The axis is not yet initialized after the restart of FM 452. The programmed software limit 
switches are not monitored unless the module has completed a synchronization cycle. 
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Relationship: working range, encoder range, traversing range:  
● The "working range" is defined by your task-specific software limit switch settings. 
● The "encoder range" represents the effective encoder range. For linear axes, the module 

imposes this range symmetrically across the working range, i.e., it shifts the encoder 
range in order to equalize the distances between the software limit switches and the ends 
of the encoder range (see the figure above). 

● The "traversing range" represents the range of values the FM 452 is capable of 
processing. It is dependent on the resolution. 
The following applies: working range ≥ encoder range ≥ traversing range 

Hysteresis 
 

Address Name Type Start value Comment 
80.0 HYS DINT L#0 Hysteresis 

Ranges: 
0...65535 [Imp] x resolution [µm/Imp] 

The range of values is determined by the resolution:  
Maximum input value: 
- to linear axes: max. input value < ¼ of the working range 
- to rotary axes: max. input value < ¼ of the rotary axis range 

Position-based cams and hysteresis 
A position-based cam is activated when the following conditions have been met: 
● The detected actual value lies within the position-based cam. 
● Hysteresis is not active. 
Switching points may vary, depending on the position of the direction reversal.  

 
Figure 9-1 Enabling position-based cams with hysteresis 

 
 Cams 
 Hysteresis 

1) Cam is activated, as the cam start position is passed in positive effective direction. 
2) The cam remains active due to the hysteresis, irrespective of a direction reversal 
3) At the end of hysteresis, the cam is deactivated. 
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4) Cam remains deactivated after a direction reversal. 
5) The cam is activated again at the end of the hysteresis. 

 
 

 Note 
When the direction is reversed, the hysteresis cannot reduce a cam actuation time shorter 
than the hysteresis. 

 
Time-based cams with hysteresis 
A time-based cam is activated when the following conditions have been met: 
● A cam start is overrun in the effective direction. 
● Hysteresis is not active. 

 

  Note 
The hysteresis will hide a time-based cam if its range between the reversal point and start 
position is less than the hysteresis. 

The figure illustrates a time-based cam that is not activated again. 

 
Figure 9-2 Activation of a time based cam with hysteresis 

 
 Cams 
 Hysteresis 

1) Cam is activated, as the cam start position is passed in positive effective 
direction. 

2) After the direction reversal, the cam remains active until the cam activation 
time has expired, regardless of the hysteresis. 

3) Cam start position is hidden by the hysteresis, the cam is not activated. 
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Simulation velocity 
 

Address Name Type Start value Comment 
84.0 SIM_SPD DINT L#0 Simulation velocity 

The simulation velocity depends on the 
resolution. 
0 = standstill  
5 ∗ 108 = highest setting supported by the 
module 
Within this range, the simulation velocity 
depends on the resolution: 
1000 x resolution ≤ simulation velocity  
≤ 3  x 107 x resolution  

This machine parameter determines the simulation velocity. The physical simulation velocity 
Vsim may deviate from the setting at Vsim, V, and is calculated according to the following 
formula: 

 
 

Meaning of this formula 
● Vsim: Simulation velocity set by FM 452. Unit: µm/min 
● Vsim, V:  Default simulation velocity you set in machine data. Unit: µm/min 
● RES: Resolution derived from encoder data. Unit: µm/pulse 
● Integer ( ): this expression ignores the value after the decimal point in further calculations. 

In all calculations, this expression must lie within the range from 2 to 65536. 
The actual simulation velocity changes abruptly as a result of the relationships (see the 
formula). 

Minimum edge interval 
 

Address Name Type Start value Comment 
4.0 EDGEDIST DINT L#0 Minimum edge interval 

Range: 
0 ... 1 000 000 000 µm 

This machine parameter defines a range after detection of the start of a measurement for an edge 
detection. The measurement is discarded if the end of the measurement lies within this range.  
The start of the measurement is not reported unless the minimum edge interval has been traveled. 
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See also 
● Determining the correct absolute encoder adjustment (Page  77) 
● Example: Adjusting the absolute encoder (Page  79) 
● Execute "Retrigger reference point" (Page  116) 
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9.8 Determining the correct absolute encoder adjustment 

Definition 
The absolute encoder adjustment and reference point coordinate maps the encoder's range 
of values unambiguously to the axis coordinate system. 

 
Address Name Type Start value Comment 
48.0 ENC_ADJ DINT L#0 Absolute encoder adjustment 

Range: 0 to 225 -1  
The "Absolute encoder adjustment" determines the encoder value that represents the reference point 
coordinate on the axis. The value must be less than the total number of steps of the absolute 
encoder. 

Procedure: Determining the correct absolute encoder adjustment 
After you completed the basic program, you need to define a balanced correlation between 
the encoder and the coordinate system. The procedure shown in the next section is based 
on the use of the programming interface.  
1. Move the axis to a known and physically unambiguous, reproducible point. 

This could be the "end software limit switch". 
2. Call the "set reference point" function, using the coordinate position defined in step 1. 

FM 452 now calculates an encoder value for the reference point coordinate entered in the 
channel DB (REFPT in channel DB), namely the absolute encoder adjustment. You can 
view this value at the service screen of the programming interface. 

3. Enter the value from the service screen in the "Absolute encoder adjustment" field on the 
"Axis" tab of the programming interface. 

4. Save your parameter assignment to the corresponding parameter DB using the export 
function. 

5. Close the programming interface by selecting File and Exit. 
6. In HW Config, download the data to the CPU. 
7. Restart the CPU to apply the data. 

 

  Note 
This adjustment is made once during commissioning. During its startup, the programmed 
FM 452 will be synchronized after it has received a complete, faultless frame from the 
encoder. 
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Data in the channel DB 
 

Address Name Type Start value Comment 
98.0 REFPT DINT L#0 Reference point coordinate 

Range: 
-1 000 000 000 µm to +1 000 000 000 µm 
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9.9 Example: Adjusting the absolute encoder 

Example of absolute encoder adjustment 
For this example, let us presume: 
● reference point coordinate = -125 mm 
● working range of SSW_STRT = -1,000 mm to SSW_END = 1,000 mm 
● absolute encoder adjustment = 0 
● encoder range = 2048 increments (= pulses) , at a resolution of 1 mm/pulse 
● A precise mechanical adjustment of the absolute encoder is not possible, and it does not 

provide a function for setting a selective actual value. 

1)

2)
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(1) Assignment of the coordinate system to encoder values, based on the absolute encoder 
adjustment. Encoder value 0 is equivalent to actual value -125. 

(2) Required assignment of the coordinate system to the encoder. The coordinate value 
should be -125 at this position. 

Result of "Set reference point" 
The Set reference point operation creates the following relationship between the encoder 
and coordinate system: 
The reference point coordinate on the axis (-125) is assigned to the encoder value (1798) 
which is determined by the absolute encoder adjustment. 
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The encoder returns 2048 unambiguous values. The working range is determined by the 
software limit switches. However, due to the set resolution of 1 mm/pulse, the encoder's 
working range extends beyond the set software limit switch range.  
At the set resolution, the working range is already covered by 2001 values. In the example, 
this produces a "remainder" of 47 pulses which symmetrically enclose the working range.  

Alternative: Mechanical adjustment of an encoder 
To create a proper relationship between the coordinate system and the encoder: 
1. Move the axis to a reproducible position (for example, the start software limit switch). 
2. Set this coordinate value at the machine parameters as reference point coordinate. 
3. Read the encoder value indicated at this position in the service screen form of the 

programming interface. 
4. Set this value as absolute encoder adjustment at the machine parameters. 
The parameters will thus always return the correct actual value. 
As an alternative to steps 3 and 4, you can also zero the encoder by means of a "Reset" 
signal (if this exists), and then set the value "0" as the absolute encoder adjustment in the 
machine data.  
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9.10 Machine data of the encoder 

Definition 
The encoder returns position data to the module, where these are evaluated and converted 
into an actual value based on the set resolution.  
The correct definition of the encoder's machine data is essential for ensuring consistency 
between the calculated and physical actual position of the axis. 

Data in the parameter DB 
Encoder type and frame length 

 
Address Name Type Start value Comment 
20.0 ENC_TYPE DINT L#1 Encoder type and frame length 

Range of values: 
1 = 5 V, incremental 
2 = 24 V, incremental 
3 = SSI 13 bit frame length 
4 = SSI 25 bit frame length 
5 = listen in 
6 = 24 V proximity switch positive direction 
7 = 24 V proximity switch negative direction 
8 = SSI 13 bit (right-aligned) 
9 = SSI 25 bit (right-aligned) 
10 = listen in (right-aligned) 

At the "frame length" you define the clock frame output by FM 452. The "listen in" selection disables 
the clock pulse of FM 452. FM 452 can then listen to other SSI frames with length of 13 or 25 bits. 
The transmission rate is determined by the clock rate of the master module.  

 
Distance per encoder revolution  

 
Address Name Type Start value Comment 
24.0 DISP_REV DINT L#80000 Distance per encoder revolution  

Range of values: 1 µm to 1 000 000 000 µm 

 
The machine parameter "distance per encoder revolution" returns the distance covered by 
the drive system per encoder revolution to FM 452. 
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Increments per encoder revolution 
 

Address Name Type Start value Comment 
32.0 INC_REV DINT L#500 Increments per encoder revolution 

Range of values: 
1 to 225 
Note:  
This entry is irrelevant when using pulse units. 

The machine parameter "increments per encoder revolution" defines the number of 
increments output by an encoder per revolution. FM 452 calculates he resolution based on 
this value and the machine parameter "Distance per encoder revolution". 
● Incremental encoder 

Any value within the range of values can be input. The module evaluates the increments 
in 4 operations. 

● Proximity switch 
Any value within the range of values. 

● Absolute encoder 
Limits differ between the various encoder types: 

 
Encoder type Frame length/type Value range can be used as 

linear axis 
Single-turn encoder 13 bit half fir tree 64 ... 8192 in powers of 2  
Single-turn encoder 13 bit right-aligned 64 ... 8192 all values X 
Single-turn encoder 25 bit right-aligned 64 ... 225 all values X 
Multiturn encoder 25 bit fir tree 64 ... 8192 in powers of 2  
Multiturn encoder 25 bit right-aligned 64 ... 214 all values  
Listen in Fir tree 64 ... 8192 in powers of 2  
Listen in Right-aligned 64 ... 215 all values X 
Special setting: 
Multiturn encoder in 
single-turn mode 

25 bit half fir tree 64 ... 8192 in powers of 2  

 
 

 Note 
The number of encoder pulses is calculated by multiplying the "increments per encoder 
revolution" with the "number of revolutions" parameter values. 
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Number of encoder revolutions 
 

Address Name Type Start value Comment 
36.0 NO_REV DINT L#1024 Number of encoder revolutions 

Range of values: 
1 (single-turn encoder) 
2 to  219 (multiturn encoder) 

The machine parameter "number of encoder revolutions" is only required for absolute 
encoder. You use it to define the maximum number of revolutions of this encoder. To obtain 
more information about absolute encoders, start by reading the "Encoder" section in this 
Manual.  
Single-turn encoder 
Only the value "1: is possible. 
Multiturn encoder 
Multiturn encoder / listen in (fir tree): 2 ... 4096 in powers of 2 
Multiturn encoder / listen in (right-aligned): 2 ... 219 all values, but with the following 
restriction: Increments/encoder revolution x number encoder revolutions ≤ 225. 
Linear scale 
You can also interconnect a linear scale. To do so, enter the value "1". 
Total number of encoder steps 
The total number of steps is not a machine parameter. 
Total no. of steps = increments per encoder revolution x no. of revolutions 
Baud rate 

 
Address Name Type Start value Comment 
40.0 BAUDRATE DINT L#0 Baud rate 

Range of values: 
0 = 125 kHz 
1 = 250 kHz 
2 = 500 kHz 
3 = 1000 kHz 

At the "BAUDRATE" machine parameter, you define the data transfer rate between the SSI 
encoder and FM 452. 
This entry has no significance for incremental encoders. 
The maximum cable length depends on the baud rate:  
● 125 kHz → 320 m 
● 250 kHz → 160 m 
● 500 kHz → 63 m 
● 1000 kHz → 20 m 
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Count direction 
 

Address Name Type Start value Comment 
59.0 CNT_DIR BOOL FALSE Count direction 

0 = normal 
1 = inverted 

At the "count direction" machine parameter, you adapt the position detection direction to the 
direction of the axis movement. Also, take the rotary direction of all transmission elements 
into account (for example, couplings and gears). 
● Normal = incremental count pulses (incremental encoder) or encoder values (absolute 

encoder) represent increasing actual position values 
● Inverted = incremental count pulses (incremental encoder) or encoder values (absolute 

encoder) represent decreasing actual position values 
It is not allowed to implement a derivative-action time in combination with an absolute 
encoder (SSI) and inverted count direction. 
Monitoring 

 
Address Name Type Start value Comment 
 
63.0 
63.1 
63.2 

 
MON_WIRE 
MON_FRAME 
MON_PULSE 

 
BOOL 
BOOL 
BOOL 

 
TRUE 
TRUE 
TRUE 

Monitoring functions 
1 = wire-break 
1 = frame error (must always be 1) 
1 = missing pulses 

Wire-break 
The enabled monitoring function of FM 452 monitors the A, /A, B, /B, N and /N signals of an 
incremental encoder. It detects: 
● Wire-break 
● Short circuit on individual cables 

For incremental encoders without zero marks, you must take one of the following 
measures:  
– switch the wire-break monitoring function off 
– interconnect the N and /N signals externally 

● Edge interval of count pulses 
● Encoder supply failure 
Frame error  
Frame error monitoring for absolute encoders (SSI) cannot be disabled. It monitors the 
frame: 
● Start and stop bit errors 
● Monitoring of the monostable time of the connected encoder 
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Missing pulses (incremental encoder)  
An incremental encoder must return a consistent number of increments between two 
successive zero marks. FM 452 checks whether the zero mark of an incremental encoder 
coincides with the correct encoder value. You must disable missing pulse monitoring for 
encoders without zero mark. Also disable wire-break monitoring, or interconnect the zero 
mark inputs N and /N externally. 

See also 
● Incremental encoder (Page  129) 
● Resolution (Page  86) 
● Absolute encoders (Page  133) 
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9.11 Resolution 

Definition 
The resolution reflects the accuracy of cam processing. You also define the 
maximum possible traversing range 
To calculate the resolution (RES): 

 
 Incremental encoder Absolute encoder / proximity 

switch 
Input values • Distance per encoder 

revolution 
• Increments per encoder 

revolution 
• Pulse evaluation: quadruple 
• 1 increment = 4 pulses 

• Distance per encoder 
revolution 

• Increments per encoder 
revolution 

• 1 increment = 1 pulse 

Calculation RES = (distance/encoder revolution) / (pulse/encoder revolution) 

 
 

 Note 
The resolution of the physical unit pulses is always 1. 
All position values are rounded to the integer multiple of the resolution. This allows you to 
distinguish between the set and used values. 

 

Range of values of the resolution 
Convert the range of values for the resolution according to the defined physical units. The 
resolution must be kept within this range when setting the "distance per encoder revolution" 
and "increments per encoder revolution" values. 
Range of values for the resolution derived from the physical units:  

 
System of units Representation in... Range of values of the resolution 
mm 10-3 mm 0,1 * 10-3 mm .... 1000 x 10-3 mm/pulse 
inch 10-4 inch 0,1 * 10-4 inch .... 1000 x 10-4 inch/pulse 
degrees 10-4 degrees 

10-3 degrees 
10-2 degrees 

0,1 * 10-4 degrees to 1000 x 10-4 degrees/pulse 
0,1 * 10-3 degrees to 1000 x 10-3 degrees/pulse 
0,1 * 10-2 degrees to 1000 x 10-2 degrees/pulse 

pulses 1 pulse 1 
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Example 
● An incremental encoder has the following data: 

– Increments per encoder revolution 5000 
– Distance per encoder revolution 1000 mm 
– Increment = 4 pulses 
Resultant resolution (quadruple evaluation): 
Resolution 
= 1000 mm / 5000 increments  
= 0,2000 mm/increments 
= 0,2000 mm/4Impulse 
= 0,0500 mm/pulse 

● An SSI encoder has the following data: 
– Increments per encoder revolution 4096 
– Distance per encoder revolution 1000 mm 
– Increment = 1 pulse 
Resultant resolution: 
Resolution 
= 1000 mm / 4096 increments  
= 0,2441 mm/increments 
= 0,2441 mm/pulse 

Dependency between the traversing range and the resolution 
The traversing range is limited by the numeric representation in FM 452. The number 
representation varies, depending on the resolution. You should thus make sure the default 
values do not violate permitted limits. 
The table below shows the maximum traversing range: 

 
Resolution (RES) is in the range Maximum traversing range 
0,1 µm/pulse ≤ AUFL < 1 µm/pulse -108 µm to 108 µm (-100 m to + 100 m) 
1 µm/pulse ≤ RES ≤ 1000 µm/pulse -109 µm to 109 µm (-1000 m to + 1000 m) 

Dependency between the velocity and resolution 
The velocity indicated may vary within the following limits, depending on the resolution (data 
relate to mm units): 
● from 1 µm/min to 90 m/min, at a resolution < 1 µm/pulse 
● from 1 µm/min to 900 m/min, at a resolution ≥ 1 µm/pulse 
The velocity value is calculated and filtered by the module at intervals of 4 ms. 
Its minimum inaccuracy of one pulse/4 ms rules it out for loop control tasks. 
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See also 
● Basics of Programming an FM 452 (Page  35) 
● Cam data (Page  92) 
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9.12 Number of cams and track data 

Number of cams  
The number of cams determines the cam cycle time and the maximum number of 
programmable cams.  

 
Number of cams Cam cycle time 

16 cams 20.48 µs 
32 cams 40.96 µs 
64 cams 81.92 µs 
128 cams 163.84 µs 

Number of cams in the parameter DB 
 

Address Name Type Start value Comment 
 
76.0 

 
C_QTY 

 
DINT 

 
UDT3: L#0 
UDT4: L#1 
UDT5: L#2 
UDT6: L#3 

Number of cams: 
0 = max. 16 cams 
1 = max. 32 cams 
2 = max. 64 cams 
3 = max. 128 cams 

Track data in the parameter DB  
Activation of track outputs:  

 
Address Name Type Start value Comment 
90.0 TRACK_OUT WORD W#16#0 Activation of track outputs 

Range: 
0 = cam controller 
1 = CPU 
Bit number = track number 

The machine parameter "activation of track outputs" defines how the track signals of tracks 0 
to 15 are activated. Tracks can be activated by: 
● The cam controller: Track signals are activated and deactivated by FM 452 cam 

processing functions. 
● CPU: The track signals represent the corresponding values of the track enables in the 

channel DB. 
This allows the explicit activation of track outputs in the user program.  
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Enable input:  
 

Address Name Type Start value Comment 
 
95.0  
 
...... 
95.7 

 
EN_IN_I3 
 
... 
EN_IN-I10 

 
BOOL 
 
... 
BOOL 

 
FALSE 
 
... 
FALSE 

Enable input 
1 = track signal track 3 AND enable input I3 
... 
1 = track signal track 10 AND enable input I10 

Track signal Q3 to 10 is switched on when the following conditions have been met: 
• The track is enabled with TRACK_EN. 
• The relevant external enable input I3 to I13 is set. 
• The track result is 1. 

Special tracks:  
 

Address Name Type Start value Comment 
 
99.0 
99.1 
99.2 

 
SPEC_TRC0 
SPEC_TRC1 
SPEC_TRC2 

 
BOOL 
BOOL 
BOOL 

 
FALSE 
FALSE 
FALSE 

Special tracks 
1 = track 0 is counter cam track 
1 = track 1 is counter cam track 
1 = track 2 is brake cam track 

You can program tracks 0, 1 and 2 as special tracks. 

High count value at counter cam track (track 0))  
 

Address Name Type Start value Comment 
100.0 
 
104.0 

CNT_LIM0 
 
CNT_LIM1 

DINT 
 
DINT 

L#2 
 
L#2 

Count limit counter cam track  
(track 0) 
Count limit counter cam track  
(track 1) 
Range: 2 ... 65535 

At this machine parameter, you define the high limit of the programmed counter cam track. 
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9.13 Interrupt enable 

Definition 
You can define whether to generate hardware interrupts when cams 0 to 7 are activated 
and/or deactivated. 
● Cam on/off 

At the cam parameters, you can define whether to generate hardware interrupts when 
cams 0 to 7 are activated and/or deactivated. 

● Measurement starts 
With the "edge detection" setting, a rising edge at digital input I1 can trigger a hardware 
interrupt.  

● Measurement completed 
Both with the "edge detection" setting and with the "length measurement" setting, a falling 
edge at digital input I1 can trigger a hardware interrupt. 

Machine data for interrupt enable in the parameter DB 
 

Address 
absolute

Name Type Start value Comment 

3.1 PI_MEND BOOL FALSE 1 = enable hardware interrupt: End of 
measurement 

3.2 PI_CAM BOOL FALSE 1 = enable hardware interrupt: cam on/off 
3.5 PI_MSTRT BOOL FALSE 1 = enable hardware interrupt: Start of 

measurement 

Cam data for interrupt enable in the parameter DB 
 

Address 
relative 

Name Type Start value Comment 

+0.4 PI_SW_ON BOOL FALSE 1 = hardware interrupt on activation 
+0.5 PI_SW_OFF BOOL FALSE 1 = hardware interrupt on deactivation 
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9.14 Cam data 

Definition 
Cam data describe the characteristics of a cam, the assignment of each cam to a track, and 
the switching behavior of the cam. The cam data listed below are set separately at each 
cam. 
● The module interprets and processes only the cams with "valid" settings. 
● Cams 0 to 7 support hardware interrupts. 
● The number of programmable cams depends on the number of cams. 

Switching characteristics of cams based on their effective direction 
A positive effective direction is always assumed, with the exception of example 5. 

 
No. Description Position-based cam Time-based cam 
1 A cam is overrun in the effective direction. 

  
2 A cam is overrun in reversed effective direction. 

  
3 A cam is approached in effective direction; the 

motion direction of the axis is reversed while the 
cam is active. 

 

 
4 A cam is approached in reversed effective 

direction; the axis reverses its direction of 
movement on the cam in the effective direction. 

 

Cam not switched 
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No. Description Position-based cam Time-based cam 
5 A cam is approached from any direction, and 

exited in any direction; both directions are set as 
the effective direction. 

 

 
 Programmable cam 
 Switched cam 

Cam data in the parameter DB 
 

Address 
relative 

Name Type Start value Comment 

+0.0 CAMVALID BOOL FALSE 1 = cam valid 
+0.1 EFFDIR_P BOOL TRUE 1 = positive effective direction (plus)  
+0.2 EFFDIR_M BOOL TRUE 1 = negative effective direction (minus)  
+0.3 CAM_TYPE BOOL FALSE 0 = position-based cam  

1 = time-based cam 
+0.4 PI_SW_ON BOOL FALSE 1 = hardware interrupt on activation 
+0.5 PI_SW_OFF BOOL FALSE 1 = hardware interrupt on deactivation 
+1.0 TRACK_NO BYTE B#16#0 Track number  

Range: 0 to 31 
Effective direction 
Two effective directions are supported: 
positive: The cam is set at the start position, if the axis is moving in direction of increasing actual 
values. 
negative: The cam is set at the end position, if the axis is moving in direction of decreasing actual 
values. 
You may set both effective directions in parallel. 
Track number  
You define the track controlled by the cam by setting the track number. 

 
 

 Note 
Unused cams should always be set "invalid" (CAMVALID = FALSE). 
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Cam start (CBEGIN) / Cam end (CEND) of position-based cams 
 

Address 
relative 

Name Type Start value Comment 
of position-based cams 

+2.0 
+6.0 

CBEGIN 
CEND 

DINT 
DINT 

L#-100000000 
L#100000000 

Cam start (CBEGIN) 
Cam end (CEND) 
Range: 
- 1 000 000 000 µm to 1 000 000 000 µm 

 
Minimum length of a position-based cam 

 
Figure 9-3 Shortest cam with axis motion in positive direction 

 
① Pulses; calculated from the encoder signals 
② Shortest cam 

CBEGIN = 103 and CEND = 103 
③ Shortest inactive cam when CBEGIN is greater than CEND: 

CBEGIN = 105 and CEND = 101 

The inactive part of a cam must always have a minimum clearance of 4 pulses between the 
cam end (CEND) and cam start (CBEGIN). 
If CEND = CBEGIN, the cam is activated for the duration of one pulse. 
Cam start (CBEGIN) / Cam end (CEND) of time-based cams 

 
Address 
relative 

Name Type Start value Comment 
of time cams 

+2.0 
+6.0 

CBEGIN 
CEND 

DINT 
DINT 

L#-
100000000 
L#100000000 

Cam start (CBEGIN)  
Cam end (CEND)  
Cam activation time 
Range: 
(0 to 13421) x 100 µs with up to 16 cams 
(0 to 26843) x 100 µs with up to 32 cams 
(0 to 53686) x 100 µs with up to 64 cams 
(0 to 65535) x 100 µs with up to 128 cams 
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At a time-based cam, always define a cam start and a cam activation time, rather than a cam 
end parameter. You can set a resolution of 100 µs for the cam activation time. The time runs 
starting with the activation of the cam. 
Conditions of setting default times: 
● 0 µs: A cam with 0 µs activation time is never activated 
● 0 µs < t ≤ 400 µs: FM 452 sets a minimum cam activation time of approx. 330 µs. 
● t < 400 µs: FM 452 calculates the actual cam activation time ttats based on the default cam 

activation time tdef according to this formula: 

t
t         = Integer * Cam cycle timeCam cycleact

spec(                  )
 

 
The maximum error is always less than one cam cycle. 
Derivative action time 

 
Address 
relative 

Name Type Start value Comment 

+ 10.0 LTIME INT 0 Derivative action time 
Range: 
(0 to 53686) x 100 µs with max. 16 cams 
(0 to 65535) x 100 µs with max. 32, 64 or 128 cams 

You can compensate any delays caused by the connected switchgear by setting a lead time. 
Define the lead time with a resolution of 100 µs. You can assign one lead time to each cam. 
The lead time applies to the cam start and end position. 
Actuation distance 
The actuation distance of a cam is calculated continuously based on the current velocity and 
lead time. The entire cam is shifted in direction of the actual value by this value. The 
assigned range is designated as the "static range," and the range calculated based on the 
lead time is designated as the "dynamic range". 
Actuation distance = [lead time] x [actual velocity] 
FM 452 calculates the actuation distance of all cams within 1/4 of the longest programmed 
lead time. A very high lead time setting at a cam reduces the number of calculation cycles for 
dynamic adjustment. 
Actual lead time 
To calculate the actual lead time: 
1. Determine the cam cycle time: This is the time FM 452 requires to complete processing of 

all cams, and depends on the number of cams assigned. 
2. Calculate the actual lead time based on the following formula: 
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The identifiers have the following meanings: 
Lead time actis the lead time set by FM 452 
Lead time V is your default setting. 
Integer ( ) means that the values after the decimal point are ignored in the calculation of the 
parenthesis. 
The maximum error of the lead timeact is always < [cam cycle time] x 4. 
Example: 
The following values are defined: 
Number of cams: maximum of 32 cams 
Cam cycle time: 40.96 µs 
Lead timeV = 1000 µs 
You obtain an actual lead time of 983 µs. 
It is not allowed to implement a lead time in combination with an absolute encoder (SSI) and 
inverted count direction. 

 

 Note 
The actual is always less than the programmed lead time. It may assume 0 value, 
irrespective of a programmed lead time ≥100 µs. 
The actuation distance of a rotary axis must be less than its range, and represent the 
inactive part of the cam. This must be guaranteed for all velocities. 
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Dynamic cam adjustment 
There are two distinct situations relating to the cam range: 
1. The static and dynamic range of the cam overlap. 
2. The static and dynamic range of the cam do not overlap. 

 
Dynamic cam adjustment (different use cases) 
Dynamic adjustment Description 

 

If the dynamic range of the cam overlaps its static range: 
• The cam is activated when its dynamic range is reached. 

At the same time, calculation of a new dynamic 
adjustment is disabled. 

• When the actual value reaches the static range of the 
cam, the calculation of a new dynamic adjustment is 
enabled again. A change in velocity affects the cam end. 

• When the cam is deactivated at the end of the dynamic 
range, dynamic adjustment will be disabled again until 
the end of the static range of the cam. 

 
 

If the cam's dynamic and static ranges do not overlap: 
• The cam is activated when its dynamic range is reached. 

At the same time, calculation of a new dynamic 
adjustment is disabled. 

• At the end of the static range of the cam, dynamic 
adjustment is enabled again. 

 Dynamic range 
 Static range 
 A new dynamic adjustment is possible 

 
 

 Note 
When the direction of rotation changes, calculation of the dynamic adjustment is enabled 
again. 
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Settings 10
10.1 Influence of settings on the switching characteristics of time-based 

cams 

Actual value changes 
A time cam can be skipped by the following settings that change the actual value: 
● Set actual value 
● Set actual value on-the-fly 
● Zero offset 
● Retrigger reference point 

Activating a time-based cam 
A time-based cam is always activated, regardless whether you skip its start position due to 
one of the settings listed above, provided the actual direction of movement of the axis 
matches the effective direction set at the cam. The programmed cam activation time starts. 

 

 Note 
If the axis is at a standstill, the direction of movement is influenced by fluctuations of the 
actual value. 
Set a hysteresis higher than the fluctuation of the actual value signal in order to suppress 
flutter when the axis is at a standstill.  
This retains the last determined direction of movement while the axis is at a standstill. 

 
WARNING  

Injury to persons or damage to equipment can occur. 
Any modification of the actual value at rotary axes may cause unwanted activation of time-
based cams. 
You should always set the "invalid" option at the time-based cams of a rotary axis if you 
want to influence the actual value using the settings mentioned earlier. 
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10.2 Modifying the "Set Actual Value/Set Actual Value on-the-fly/Cancel Set 
Actual Value" settings 

Definition 
You program the "Set actual value/Set actual value on-the-fly" settings in order to assign a 
new coordinate to the actual encoder value. This shifts the coordinate system by the value: 
ACTnew - ACTcurrent 
Whereby: 
● ACTnew is the default value 
● ACTcurrent is the actual value at the time of execution 

Determining new coordinates 
Calculate all your default positions in the shifted coordinate system based on the following 
formula: 
Coordinatenew = Coordinateold + (ACTnew - ACTcurrent) 

Requirements 
● The axis must be synchronized. 
● With "Set actual value on-the-fly": Digital input I1 must be interconnected. 

Programming steps 
1. Enter the coordinate for the actual value, or for the actual value to set on-the-fly in the 

channel DB. 
– Linear axis: 

Select an actual value so that the software limit switches are still within the permissible 
traversing range after the setting is called. 
The offset value derived from (ACTnew - ACTcurrent) must be less than or equal to the 
value of the permitted traversing range (maximum 100 m or 1000 m). 

– Rotary axis: 
Rule for the defined actual value: 
0 ≤ actual value < end of rotary axis 

2. Set the appropriate trigger bits at the channel DB. 
3. Call FC CAM_CTRL. 

"Set actual values" is executed immediately. 
"Set actual value on-the-fly" is executed at the next positive edge at digital input I1. The 
FVAL_DONE bit is set. 
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Data used in the channel DB 
 

Address Name Type Start value Comment 
36.4 AVAL_EN BOOL FALSE 1 = set actual value 
36.5 FVAL_EN BOOL FALSE 1 = set actual value on-the-fly 
90.0 AVAL DINT L#0 Actual value coordinate 
94.0 FVAL DINT L#0 Coordinate for on-the-fly actual value 
25.5 FVAL_DONE BOOL FALSE 1 = set actual value on-the-fly executed 

Effects of the setting 
Based on the example of "set actual value" to 400 mm (at position 200 mm), you can see 
how this setting shifts the coordinate system. Result: 
● The position of the working range is not physically shifted. 
● The various points, such as the software limit switches, are assigned new coordinate 

values. 
● The cams retain their coordinate values, and are therefore located at a different physical 

position. 
● When the axis is synchronized and the cam processing is enabled, the actual position 

may skip cam edges or complete cams as a result of this setting. 
● Status changes of the cam which would normally trigger an interrupt may be lost. 

 

  Note 
Make allowances for the switching reaction of time-based cams. 

Table 10-1 Shift of the coordinate system by "Set Actual Value" / "Set Actual Value on-the-Fly" 

Set actual value SLS 
[mm] 

ACT 
[mm] 

SLE 
[mm] 

 
 
-400 
 
 

 
 
200 
 
 
 

 
 
400 
 
 
 

 
 

 
 
 
-200 
 

 
 
 
400 
 

 
 
 
600 
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Canceling the setting 
The "Cancel set actual value" setting can be used to set the coordinate shift caused by "Set 
actual value" or "Set actual value on-the-fly". 
Once "Set actual value on-the-fly" has been triggered, it can no longer be deleted before 
execution by a positive edge at input I1. However, it can be overwritten by a new "Set actual 
value on-the-fly". 
These settings will be reset at the next start of the module. 

Parameter used in the channel DB 
 

Address Name Type Start value Comment 
35.2 AVALREM_EN BOOL FALSE 1: Cancel actual value setting 

Possible causes of error 
"Set actual value on-the-fly" and "Retrigger reference point" may not be executed in parallel.  
With the setting "set actual value on-the-fly", an error can be signaled if the setting means 
that a software limit switch would be exceeded with the rising edge at I1. This operating error 
is signaled by a diagnostic interrupt, and written to the diagnostic buffer. 

See also 
● Influence of settings on the switching characteristics of time-based cams (Page  99) 
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10.3 Execute "Set zero offset" 

Definition 
The "zero offset" setting lets you shift the zero position in the coordinate system by a defined 
value. The sign determines the offset direction. 

Determining a new coordinate 
All values of the shifted coordinate system can be calculated according to the following 
formula: 
Coordinatenew = Coordinateold - (ZPOnew - ZPOold) 
ZPOold identifies any existing zero offset. If no zero offset was active prior to the call, set a 0 
value at ZPOold. 
Based on this formula, you can calculate the coordinates for the software limit switches, for 
example. 

Programming steps 
1. Write the zero offset value to the channel DB. 

– Linear axis: 
The zero offset must be selected so that the software limit switches remain within the 
permissible traversing range after the setting is called. 

– Rotary axis: 
Rule for the zero offset:  
value of zero offset ≤ end of the rotary axis. 

2. Set the relevant trigger bit. 

Data used in the channel DB 
 

Address Name Type Start value Comment 
36.6 ZOFF_EN BOOL FALSE 1 = set zero offset 
86.0 ZOFF DINT L#0 Zero offset 
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Effects on a linear axis 
Based on the example of a zero offset of -200 mm, you can see that this setting shifts the 
coordinate system in positive direction. Result: 
● The working range is not physically shifted. 
● The various points, such as the software limit switches, are assigned new coordinate 

values. 
● The cams retain their coordinate values, and are therefore located at a different physical 

position. 
● When the axis is synchronized and the cam processing is enabled, the actual position 

may skip cam edges or complete cams as a result of this setting. 
● Status changes of the cam which would normally trigger an interrupt may be lost. 

Coordinate system shift as a result of zero offset 
 

Zero offset SLS 
[mm] 

ACT 
[mm] 

SLE 
[mm] 

 
 
 
-400 
 
 

 
 
 
200 
 
 

 
 
 
400 
 
 

 
 

 
 
 
-200 
 

 
 
 
400 

 
 
 
600 

 
 

 Note 
Make allowances for the switching reaction of time-based cams. 
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Effects on a rotary axis 
Based on the example of a zero offset by -45°, you can see how this setting rotates the 
coordinate system: 

 
Rotation of the coordinate system as a result of zero offset 

Tool when ACT = 340°  Tool when ACT = 25° 

0 _

180 _

0 _

180 _

ACT = 340 _ ACT = 25 _

ZPO = -45 _

 
The zero position rotates by -45 degrees. All axis points are assigned new coordinate values. 

Including a ZPOold = 0, the result is a new value of 385°. 
As actual value resumes at 0 at the end of the rotary axis operating in positive directional 
rotation, the calculation returns an actual value of 25°: 
Coordinatenew = Coordinateold - (ZPOnew - ZPOold) - end of rotary axis 
The end of rotary axis value only needs to be subtracted when  
Coordinateold - (ZPOnew - ZPOold) is greater than the end of rotary axis. 

Loss of synchronization 
If synchronization is lost due to an error, or reset due to "retrigger reference point", a zero 
offset is retained. 

Canceling the setting 
A zero offset of 0 resets any existing zero offset. 

See also 
● Influence of settings on the switching characteristics of time-based cams (Page  99) 
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10.4 Execute "Set reference point" 

Definition 
The "set reference point" setting is used to synchronize the axis. This setting shifts the 
working area. All shifts generated by a zero offset or "set actual value" function are retained. 

Requirements 
Cam processing must be disabled. 

Programming steps 
1. Write the value for the reference point coordinate to the channel DB. 

– Linear axis: 
The reference-point coordinate may not exceed the range of the software limit 
switches. This also applies to the reference point coordinate in a shifted coordinate 
system. 

– Rotary axis: 
Rule for the reference point coordinate: 
0 ≤ reference point coordinate < end of rotary axis 

2. Set the relevant trigger bit. 

Data used in the channel DB 
 
Address Name Type Start value Comment 
36.3 REFPT_EN BOOL FALSE 1 = set reference point coordinate 
98.0 REFPT DINT L#0 Reference point coordinate 
25.0 SYNC BOOL FALSE 1 = axis synchronized 

Effects of the setting 
Based on the example "set reference point" to 300 mm, you can see how this setting shifts 
the working range of the axis. 
This has the following effects: 
● The actual position is set to the value of the reference point coordinate. 
● The working range is physically shifted on the axis. 
● The various points retain their original coordinates, but are now at new physical positions. 
● The SYNC bit is set in the return signals. 
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Shifting the working range on the axis using "Set Reference Point" 
 
Set reference point SLS 

[mm] 
ACT 
[mm] 

SLE 
[mm] 

 
 
 
-400 
 
 

 
 
 
100 
 
 

 
 
 
400 
 
 

 
 

 
 
-400 
 

 
 
300 
 

 
 
400 
 

Special features of absolute encoders 
This setting is required for an absolute encoder adjustment.  

See also 
● Determining the correct absolute encoder adjustment (Page  77) 
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10.5 Execute "Change cam edges" 

Definition 
The "change cam edges" setting can be used to edit the cam start in RUN, and also the end 
of each position-based cam. 

Requirements 
The cam you want to change must be valid. 

Programming steps: 
1. Enter the cam number in the channel DB. 
2. At a position-based cam: 

Define the cam start and end values at the channel DB. 
At a time-based cam: 
Define the cam start value at the channel DB. 

3. Set the relevant trigger bit. 

Data used in the channel DB 
 
Address Name Type Start value Comment 
36.7 CH01CAM_EN BOOL FALSE 1 = write setting for 

cam edges (1 cam) 
102.0 CAM_NO INT 0 Cam number  
104.0 CAM_START DINT L#0 Cam start 
108.0 CAM_END DINT L#0 Cam end position 
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Effects of the setting 
The FM 452 first shifts the on-triggering edge, and then the off-triggering edge of the cam. 
This sequence does not depend on the direction in which the cam is shifted. 
Special case: 
The sequence described above may briefly generate an inverse cam if the new cam start 
value is higher than the old cam end value.  

 
Figure 10-1 Step-by-step change of the cam edges 

 

 Note 
FM 452 can trigger one or two hardware interrupts when it detects the inverse cam, 
depending on your parameter settings, and on the interrupt enable status of this cam. 
Changing the on and/or off edge can result in a cam edge or the entire cam being skipped. 
Make allowances for the switching reaction of time-based cams. 
Cam status changes that would normally trigger a hardware interrupt can be lost. 

 

Reading modified values 
You can read modified values by calling one of the jobs CAM1RD_EN to CAM8RD_EN.  

Canceling the setting 
The changes are lost when you restart the module. 

See also 
● Influence of settings on the switching characteristics of time-based cams (Page  99) 
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10.6 Perform "Fast Cam Parameter Change" 

Definition 
The "Fast cam parameter change" setting can be used to modify a group of up to 16 cams 
while the system is in RUN.  

Requirements 
The cams you want to modify must be valid. 

Programming steps 
1. Enter the number of cams to be modified in the channel DB. 
2. Enter the number of the first cam to be modified in the channel DB. 
3. Set the trigger bits for the required modifications. 
4. Declare the new values at the channel DB. 
5. Repeat steps 2 to 4 for each cam to be modified. 
6. Set the relevant trigger bit in the channel DB. 

Data used in the channel DB 
 

Address 
absolute 

Name Type Start value Comment 

37.0 CH16CAM_EN BOOL FALSE 1 = write Fast cam parameter change 
settings (16 cams) 

176.0 C_QTY BYTE B#16#0 Number of cams to modify 
177.0 DIS_CHECK BOOL FALSE 1 = disable data check 

 
Address 
relative 

Name Type Start value Comment 

+0.0 CAM_NO BYTE B#16#0 Number of the cam to modify 
+1.0 C_EFFDIR BOOL FALSE 1 = change the effective direction of the 

cam 
+1.1 C_CBEGIN BOOL FALSE 1 = change the cam start to the value 

CBEGIN 
+1.2 C_CEND BOOL FALSE 1 = change the cam end / cam activation 

time to the value CEND 
+1.3 C_LTIME BOOL FALSE 1 = change the lead time to the value in 

LTIME 
+1.4 CAM_OFF BOOL FALSE 1 = deactivate the cam during the cam 

modification 
+1.5 EFFDIR_P BOOL FALSE 1 = positive effective direction (plus) 
+1.6 EFFDIR_M BOOL FALSE 1 = negative effective direction (minus) 
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Address 
relative 

Name Type Start value Comment 

+2.0 CBEGIN DINT L#0 New cam start 
+6.0 CEND DINT L#0 New cam end / new cam activation time 
+10.0 LTIME INT 0 New lead time 

Deactivating a cam during modification 
To maintain consistency, always deactivate the cam (CAM_OFF) when you modify the cam 
start and end settings.  

Data check by the module 
At the DIS_CHECK (channel DB) parameter you enable or disable the check of transferred 
data by the FM 452. If you disable the data check, verify that only permitted values are 
transferred. If you enter illegal values without a check, this can lead to unexpected reactions 
on the module. 
● FALSE: The module checks all data to be transferred. 
● TRUE: The check of cam parameter data is disabled. This allows the faster integration of 

the data to be changed on the FM 452. 
Regardless of this setting, the module always checks whether 
– the axis is programmed 
– the number of cams to be modified (C_QTY) is permitted 
– the cam (cam number) to change is valid 

The data are only enabled on the module after having been checked and found faultless. 
Any faulty data are rejected. 

Effects of the setting  
 

 Note 
Make allowances for the switching reaction of time-based cams. 

 

Reading modified values 
You can read the modified values by calling one of the jobs CAM1RD_EN to CAM8RD_EN .  

Canceling the setting 
 The changes are lost when you restart the module. 

See also 
● Influence of settings on the switching characteristics of time-based cams (Page  99) 
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10.7 Executing "Length measurement" and "Edge detection" 

Definition  
The "length measurement" and "edge detection" let you determine the length of a part. 
Length measurement and edge detection are and remain active until you disable these 
functions, or select a different measuring method. If you select both measuring methods in 
parallel, FC CAM_CTRL enables length measurement. 

Requirements 
A bounce-free switch must be connected to input I1.  

Sequence of the Settings 
Depending on the type of measurement, the FM 452 updates the data on the module at 
different times. FM 452 reports every update in a parameter on the return interface. 
Sequence of length measurement: 

 
 
 

(1) MSR_ON 
(2) I1 
(3) Update data 
(4) MSR_DONE 

1. Set the function switch for "length measurement." 
2. A positive edge at input I1 starts the length measurement. 
3. The negative edge at input I1 stops the current measurement. FM 452 updates the start 

value, end value, and length data. 
4. When parameter MSR_DONE is set, FM 452 reports the data update. The parameter 

indicates completion of the measurement. The results of the measurement can be read. 
5. The next start of a measurement at the positive edge at I1 resets the MSR_DONE 

parameter. 
If the setting is disabled during a length measurement, the FM 452 does not update the data. 
The MSR_DONE parameter remains reset. 
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Sequence of edge detection: 

 
 
 

(1) EDGE_ON 
(2) I1 
(3) Update data 
(4) MSR_DONE 

1. Enter a value for the minimum edge interval at the parameter DB. Write and enable 
machine data. 

2. Set the "edge detection" function switch. This sets the MSR_DONE parameter. 
3. The positive edge at input I1 starts edge detection. The results of the measurement are 

updated and can be read out, the start of the measurement is entered; the end value and 
length become -1. 

4. After the update, FM 452 reports the change by resetting the MSR_DONE parameter. 
5. The negative edge at input I1 stops the current measurement. The FM 452 updates the 

data for end value of the measurement and length. 
6. After the update, FM 452 reports the change by setting the MSR_DONE parameter. The 

results of the measurement can be read. 
7. The next start of a measurement at the positive edge at I1 resets the MSR_DONE 

parameter. 
If the setting is disabled during edge detection, the FM 452 does not update the data. The 
MSR_DONE parameter remains reset. 

Data used in the channel DB 
 

Address Name Type Start value Comment 
25.1 MSR_DONE BOOL FALSE 1 = length measurement completed 
34.0 EDGE_ON BOOL FALSE 1 = edge detection on 
34.2 MSR_ON BOOL FALSE 1 = length measurement on 
38.2 MSRRD_EN BOOL FALSE 1 = read measured values 
112.0 BEG_VAL DINT L#0 Starting value 
116.0 END_VAL DINT L#0 End value 
120.0 LEN_VAL DINT L#0 Length 
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Data used in the parameter DB 
 

Address Name Type Start value Comment 
4.0 EDGEDIST DINT L#0 Minimum edge distance for edge detection 

Range: 
0 ... 1 000 000 000 µm 

The minimum edge interval is used to define an edge detection range after the start of a 
measurement is detected. The measurement will be discarded if its end lies within this 
range. 
The start of the measurement is not reported unless the distance defined by the "minimum 
edge interval" has been traversed. 

Conditions of length measurement 
● The CPU program requires an interval of sufficient length between the off and on edges 

at input I1 in order to be able evaluate the result before a new measurement is triggered. 
● The minimum interval between positive and negative edges, and between negative and 

next positive edges at input I1 must be longer than 2 ms. 

Hardware interrupts 
The start and end of a measurements can be reported using hardware interrupts.  

Faulty measurement 
FM 452 returns the length value -1 for the length when it detects a faulty measurement / 
edge detection. 
A "length measurement" or "edge detection" may only perform up to 126 zero transitions in 
one direction. The zero transition represents the rotary axis transition from the end of rotary 
axis value to 0, or vice versa. FM 452 reports a faulty "length measurement" or "edge 
detection" if it detects more than 126 zero transitions, regardless whether or not it then 
detects any zero transitions in the opposite direction. 
A length measurement is also considered faulty if: 
● the length measured at a rotary axis is greater than 231. 
● the on and off edges are detected simultaneously by FM 452 (for example, caused by 

switch bounce). 
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Shift of the coordinate system during a length measurement 
Conditions under which a shift of the coordinate system will influence the measured length: 
● You are using an incremental encoder or a proximity switch, or operate FM 452 in 

simulation mode. 
● You are executing a "set reference point" or "retrigger reference point" function while a 

length measurement is active. 

Example 
To utilize the above mentioned influences on the measured length: 
Your system always develops slip when you perform a length measurement. 
The retrigger reference point function can be used to correct this slip in order to output 
correct measured values. 

See also 
● Basics of Programming an FM 452 (Page  35) 
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10.8 Execute "Retrigger reference point" 

Definition 
The "Retrigger reference point" setting can be used to synchronize the axis as a reaction to 
a recurring external event. 
The setting remains active until you cancel it. 

Requirements 
● You are using an incremental encoder or proximity switch. 
● The external event may represent the zero mark signal of an incremental encoder or 

reference point switch at input I2. 

Programming steps 
1. Set the value for the reference point coordinate at the parameter DB. 
2. Set the type of "retrigger reference point" at the parameter DB. 

Options: 
– Only the zero mark of the encoder is evaluated (RETR_TYPE = 7). 
– Only the reference point switch is evaluated (RETR_TYPE = 6). 
– The zero mark is evaluated. 

In the positive direction: evaluation of the first positive edge of the zero mark after 
passing the reference point switch in positive direction (RETR_TYPE = 0). 
In the negative direction: evaluation of the first negative edge of the zero mark after 
passing the reference point switch in negative direction (RETR_TYPE = 1). 

3. Write and enable machine data. 
4. Set the function switch at the channel DB. 

Data used in the channel DB 
 

Address Name Type Start value Comment 
34.3 REFTR_ON BOOL FALSE 1 = retrigger reference point 
25.0 SYNC BOOL FALSE 1 = axis is synchronized 

Data used in the parameter DB 
 

Address Name Type Start value Comment 
44.0 REFPT DINT L#0 Reference point coordinate 
52.0 RETR_TYPE DINT L#0 Type of reference point retriggering 
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Effects of the setting 
● FM 452 evaluates the zero mark signal and reference point switch based on the direction 

of movement of the axis. 
– It evaluates the positive edges when the axis moves in positive direction. 
– It evaluates the negative edges when the axis moves in negative direction. 

● It sets the actual position to the value of the reference point coordinate. 
● The working range is physically shifted on the axis. 
● The various points retain their original values, but are now at new physical positions. 
● Cam status changes that would normally trigger a hardware interrupt can be lost. 
● The SYNC bit is set in the return signals. 

 

  Note 
Make allowances for the switching reaction of time-based cams. 

Example 
Rules for the example: 
● The module evaluates the positive edges of the reference point switch and zero mark 

signals (axis moving in positive direction). 
● Value of the reference point coordinate = 300 mm. 
● No zero offset is active at the time of execution. 

Table 10-2 Shift of the axis working range by "retrigger reference point" 

Retrigger reference point SLS 
[mm] 

REF 
[mm] 

ACT 
[mm] 

SLE 
[mm] 

 
 
 
-400 
 
 

 
 
 
300 
 
 

 
 
 
100 
 
 

 
 
 
400 
 
 

 

 
 
-400 

 
 
300 

 
 
300 

 
 
400 
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Inclusion of a zero offset 
Any active zero offset is included in the retrigger reference point setting. The reference point 
coordinate setting is thus calculated according to the formula: 
Ref = RefMD - Zero offset 
RefMD is the value of the reference point coordinate store in machine data. 

Table 10-3 Shift of the axis working range by "Retrigger reference point" when zero offset is active 

Retrigger reference point SLS 
[mm] 

REF 
[mm] 

ACT 
[mm] 

SLE 
[mm] 

 
 
-500 
 
 

 
 
300 
 
 

 
 
0 
 
 

 
 
300 
 

 
-400 
 

 
400 
 

 
100 
 

 
400 
 

 

 
 
 
-400 

 
 
 
400 

 
 
 
400 

 
 
 
400 

 

See also 
● Influence of settings on the switching characteristics of time-based cams (Page  99) 
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10.9 Execute "Disable software limit switch" 

Definition 
Use the "Disable software limit switches" function to disable monitoring of the software limit 
switches at a linear axis. 
The setting remains active until you cancel it. This re-enables the originally programmed 
software limit switches. 

Programming steps 
Set the function switch at the channel DB. 

Data used in the channel DB 
 

Address Name Type Start value Comment 
34.4 SSW_OFF BOOL FALSE 1 = software limit switch disabled 

Data used in the parameter DB 
 

Address Name Type Start value Comment 
64.0 SSW_STRT DINT L#-1000000000 Start software limit switch 
68.0 SSW_END DINT L#1000000000 End software limit switch 

Effects of the setting 
● simulation 

– Simulation mode stops when the axis passes a software limit switch. 
– You can resume simulation mode by enabling software limit switch monitoring. The 

axis moves in the defined direction. 
● Zero offset when monitoring is disabled 

With a zero offset setting, and software limit switches operating within traversing range 
limits, the actual value may still be out of the permissible number range. 

● Cams not operating within the programmed range of the software limit switches can be 
activated. 

 

CAUTION  
 

Risk of material damage! 
If you restrict the traversing range using the software limit switches as a safety measure, 
deactivating the limit switches can result in serious damage to equipment. 
In the planning and engineering phases for your plant, you should be certain that the 
drive is capable of covering the entire physical range.  
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10.10 "Simulation" 

Definition 
The "Simulation" setting allows you to activate the cam controller with open encoder 
connections. 

Programming steps 
1. Set the simulation velocity at the parameter DB. 
2. Write and enable machine data. 
3. Set either a positive or negative simulation direction at the channel DB. 
4. Set the function switch at the channel DB. 

Data used in the channel DB 
 

Address Name Type Start value Comment 
15.2 DIR_M BOOL FALSE 1 = simulation in negative direction 
15.3 DIR_P BOOL FALSE 1 = simulation in positive direction 
34.1 SIM_ON BOOL FALSE 1 = simulation on 

Data used in the parameter DB 
 

Address Name Type Start value Comment 
84.0 SIM_SPD DINT L#0 Simulation velocity 

Effects when activating simulation mode 
● Encoder signals will be ignored. 
● The encoder input monitoring functions are disabled. 
● All encoder errors reported will be reset. 
● FM 452 simulates the axis motion at a constant simulation velocity. 
● Cam processing is disabled while simulation mode is active. However, you can then 

enable these operations again. Synchronism will be retained in this case. 
● Starting at the current actual value, the actual position value changes dynamically based 

on the simulation velocity and direction. 
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Effects when disabling simulation mode 
● Cam processing will be disabled. 
● The synchronization of an incremental encoder or proximity switch will be cleared.. The 

actual value will be reset to the value of the reference point coordinate. 
● The module reports the actual position value which corresponds with the absolute 

encoder value. The module then evaluates the encoder signals as defined at the machine 
parameters. 

Limit values 
The min./max. simulation velocity depends on the resolution. 

Velocity 
The module may operate with differences between the online velocity and offline settings. 

See also 
● Machine data of the axis (Page  70) 
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10.11 Read "count values of counter cam tracks" 

Definition 
The "count values of counter cam tracks" is used to read the actual count values. 

Programming steps 
1. Set the counter cam tracks and the high limit of count values at the machine parameters. 
2. Write and enable machine data. 
3. Enable the count function. 
4. The module sets the count value to its high limit. 
5. The count value decrements by the count of 1 at each positive edge of the track result 

signal. 
6. Set the trigger bit at the channel DB to read the count values. 
7. The module writes both count values to the channel DB. The module outputs a 0 value 

for tracks not programmed for operation as count cam track. 
8. The module sets track flag bit = 1 at the counter cam track when the count value = 0. 
9. It resets the track flag bit = 0 at the next negative edge of the track result signal, and 

resets the counter to its high limit. 

Data used in the channel DB 
 

Address Name Type Start value Comment 
15.5 CNTC0_EN BOOL FALSE 1 = enable count function of counter cam 

track 0 
15.6 CNTC1_EN BOOL FALSE 1 = enable count function of counter cam 

track 1 
38.3 CNTTRC_EN BOOL FALSE 1 = read count values of counter cam 

tracks 
124.0 CNT_TRC0 INT 0 Actual count value of counter output cam 

track 0 
126.0 CNT_TRC1 INT 0 Actual count value of counter output cam 

track 1 

Data used in the parameter DB 
 

Address Name Type Start value Comment 
99.0 SPEC_TRC0 BOOL FALSE 1 = track 0 is counter cam track 
99.1 SPEC_TRC1 BOOL FALSE 1 = track 1 is counter cam track 
100.0 CNT_LIM0 DINT L#2 Upper count value for counter output cam 

track 0 
104.0 CNT_LIM1 DINT L#2 Upper count value for counter output cam 

track 1 
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10.12 Read "position and track data" 

Definition 
The "position and track data" function can be used to read the actual position value, the 
velocity, and the track flag bits. The track flag bits are recorded before being logically linked 
to machine and channel data. 
The algorithm implemented in FM 452 calculates velocity changes greater than 1 pulse / 4 
ms. The indicated velocity includes this inaccuracy, and is thus unsuitable in particular for 
closed-loop control. The internal velocity value used for dynamic cam control offers a higher 
precision. 

Programming steps 
1. Set the trigger bit at the channel DB. 
2. The data will be saved to the channel DB. 

Data used in the channel DB 
 

Address Name Type Start value Comment 
38.4 ACTPOS_E

N 
BOOL FALSE 1 = read position and track data 

128.0 ACTPOS DINT L#0 Actual position 
132.0 ACTSPD DINT L#0 Actual velocity 
136.0 TRACK_ID DWORD DW#16#0 Track flag bits of tracks 0 to 31 
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10.13 Read "Encoder data" 

Definition 
The "encoder data" setting an be used to read actual encoder data, and the value for 
absolute encoder adjustment.  

Preconditions 
The value for absolute encoder adjustment can be read after "set reference point" is 
configured. 

Programming steps 
1. Set the trigger bit at the channel DB. 
2. The data will be saved to the channel DB. 

Data used in the channel DB 
 

Address Name Type Start value Comment 
38.5 ENCVAL_EN BOOL FALSE 1 = read encoder values  
140.0 ENCVAL DINT L#0 Encoder value / counter value (internal 

representation) 
144.0 ZEROVAL DINT L#0 Counter value at the last zero mark 

(internal representation) 
148.0 ENC_ADJ DINT L#0 Absolute encoder adjustment 

 

See also 
● Determining the correct absolute encoder adjustment (Page  77) 
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10.14 Read "Cam and track data" 

Definition 
The "cam and track data" setting can be used to read the actual cam / track flag bits and the 
position. The track flag bits are recorded before being logically linked to machine and 
channel data. 

Programming steps 
1. Enter type ID = 1 at the FM_TYPE parameter of the channel DB. This allows you to read 

24 bytes of cam and track data. 
If you enter type ID = 0, only the cam flag bits (16 bytes) will be read. 

2. The data will be saved to the channel DB. 

Data used in the channel DB 
 

Address Name Type Start value Comment 
12.0 FM_TYPE BOOL FALSE 0 = FM 352 up to V4.0 

1 = FM 452 or FM 352 V5.0 or higher 
38.6 CAMOUT_EN BOOL FALSE 1 = read cam and track data  
152.0 CAM_00_31 DWORD DW#16#0 Cam flag bits for cams 0 to 31 
156.0 CAM_32_63 DWORD DW#16#0 Cam flag bits for cams 32 to 63 
160.0 CAM_64_95 DWORD DW#16#0 Cam flag bits for cams 64 to 95 
164.0 CAM_96_127 DWORD DW#16#0 Cam flag bits for cams 96 to 127 
168.0 TRACK_ID1 DWORD DW#16#0 Track flag bits of tracks 0 to 31 
172.0 ACTPOS1 DINT L#0 Actual position  
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10.15 Setting "Control signals for the cam controller" 

Definition 
The "control signals for the cam controller" setting can be used to enable cam processing 
and the tracks. 

Programming steps 
The data are transferred to the module at each call of FC CAM_CTRL. 

Data used in the channel DB 
 

Address Name Type Start value Comment 
15.4 CAM_EN BOOL FALSE 1 = enable cam processing 
16.0 TRACK_EN WORD W#16#0 Enable cam tracks 0 to 15 

Bit 0 = track 0 

Effects 
Cam processing will be started or stopped based on the enable status. 
The track flag bits of enabled tracks are transferred to the track signals and digital outputs.  
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10.16 Querying "Return signals for the cam controller" 

Definition 
The "return signals for the cam controller" setting informs you about the current state of the 
cam control and track signals. Consistency between the reported position and track signals 
is not guaranteed. 

Programming steps 
The data will be saved to the channel DB at each call of FC CAM_CTRL. 

Data used in the channel DB 
 

Address Name Type Start value Comment 
23.4 CAM_ACT BOOL FALSE 1 = cam processing busy 
26.0 ACT_POS DINT L#0 Current position of axis 
30.0 TRACK_OUT DWORD DW#16#0 Current signals of tracks 0 to 31 

Bit 0 = track 0 
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10.17 Querying the "return signals for diagnostics" 

Definition 
The "return signals for diagnostics" setting is used to report diagnostic events.  

Programming steps 
1. The module sets the DIAG bit in the check-back interface each time it writes a new entry 

to the diagnostics buffer. Error events belonging to any of the error classes listed in 
Appendix C are logged in the diagnostics buffer. 

2. The module sets the DATA_ERR bit in the check-back interface when it detects faulty 
data in a write job. The cause of the error is logged to the diagnostics buffer. 

3. The data will be saved to the channel DB. 
4. If the diagnostic buffer is read by FC DIAG or by the error evaluation of the parameter 

assignment user interface, the module sets the DIAG bit back to 0. 

Data used in the channel DB 
 

Address Name Type Start value Comment 
22.2 DIAG BOOL FALSE 1 = diagnostics buffer modified 
22.4 DATA_ERR BOOL FALSE 1 = data error 
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Encoders 11
11.1 Incremental encoder 

Connectable incremental encoders 
The module supports incremental encoders outputting two pulses with 90° phase shift, and 
with or without zero mark signal: 
● Encoders with asymmetrical 24 V output signals 

– Limit frequency = 50 kHz 
– cable length max. 100 m 

● Encoders with symmetrical output signals and 5 V differential interface conforming to 
RS422 
– Limit frequency = 1 MHz 
– With 5 V supply voltage: cable length max. 32 m 
– With 24 V supply voltage: cable length max. 100 m 

 

  Note 
If the encoder (5 V) does not output a zero mark signal and wire-break monitoring is 
enabled, interconnect the zero mark signal inputs N and /N externally so that the 
inputs will exhibit different signal levels (for example, N to 5 V, /N to ground). 

http://www.efesotomasyon.com/html/siemens/siemens.html
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Signal shapes 
The diagram below shows the signal shapes of encoders with asymmetrical and symmetrical 
output signals.  

A*

B*

N*

A

B

N

/A

/B

/N

asymmetrical symmetrical

 
Figure 11-1 Signal shapes of incremental encoders 

Signal evaluation 
Increments 
An increment identifies a signal period of signals A and B of an encoder. This value is 
specified in the technical data and/or on the rating plate of the encoder. 

 
Figure 11-2 Increments and pulses 
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Pulses 
FM 452 evaluates all 4 edges of the A and B (see the diagram) signals in each increment 
(quadruple evaluation).  
1 increment (encoder default) = 4 pulses (FM evaluation)  

Reaction times 
FM 452 reaction times for connected incremental encoders: 
Minimum reaction time = cam cycle time + switching time of the connected switching 
elements 
Maximum reaction time = 2 x cam cycle time + switching time of the connected switching 
elements 

Example 
Example of the min./max. reaction time with a load of 16 cams: 
● Cam cycle time: approx. 20 µs 
● Response time of the hardware: approx. 150 µs 
Minimum reaction time = 20 µs + 150 µs = 170 µs 
Maximum reaction time = 2 x 20 µs + 150 µs = 190 µs 

 

 Note 
You can compensate the reaction time with appropriate parameter settings for the cams or 
using dynamic adjustment. 

 

Flat gain 
The flat gain is equivalent to the difference between the min./max. reaction time. For 
incremental encoders this is: 
Flat gain = cam cycle time 

 

 Note 
If the switching time of the hardware on the FM 452 and the switching time of the connected 
switching elements can be ignored, then reliable switching of the cam is guaranteed if the 
cam is longer than the distance traveled within the cam cycle time. 
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11.2 Proximity switches 

Definition 
Proximity switches are simple switches which output pulse-shaped signals, and do not return 
a directional signal. You define the direction based on the machine data for selecting the 
proximity switch. 

 

CAUTION  
Risk of material damage! 
Incorrect direction settings may cause serious errors in the system (for example, faulty 
control of aggregates). 
Check the direction settings in the commissioning phase, and whenever you replace 
proximity switch. 

 

Supported proximity switches 
FM 452 supports the following proximity switches: 
● Proximity switches with 24 V signal level (proximity switches) and limit frequency = 50 

kHz( 
● max. 100 m cable length 

Signal evaluation 
The module counts the positive edges at signal A* of the proximity switches. 
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11.3 Absolute encoders 

Single-turn and multiturn encoders 
Absolute encoders are divided into the categories: 
● Single-turn encoder 

The total range of single-turn encoders is scale to one revolution.  
● Multiturn encoder 

The total range of multiturn encoders is scaled to several revolutions. 

Connectable absolute encoders 
Absolute encoders with serial interface. Position data are transferred synchronously using 
the SSI protocol (SynchronousSerialInterface). FM 452 only supports GRAY code. Due to 
the arrangement of the data bits in the transferred frames, the data formats "fir tree", "half fir 
tree" and "right-justified" are used. 

 
Encoder type Frame length / type 
Single-turn encoder 
Single-turn encoder 
Single-turn encoder 
Multiturn encoder 
Multiturn encoder 
Listen in 
Listen in 

13 bit half fir tree 
13 bit right-aligned 
25 bit right-aligned 
25 bit fir tree 
25 bit right-aligned 
Fir tree 
Right-aligned 

Special setting: 
Multiturn encoder in single-turn mode 

 
25 bit half fir tree 

Data transmission 
The data rate for data transmission depends on the cable length (see Technical 
Specifications). 

Pulse Evaluation with Absolute Encoder 
1 increment (encoder default) = 1 pulse (FM evaluation)  

Listen in 
"Listen in" means: An absolute encoder is operated in parallel on two modules (for example, 
FM 451 and FM 452). The FM 451 positioning module is the master and the clocks the 
absolute encoder, and the FM 452 electronic cam controller is the slave and listens in to the 
signals of the SSI frame. 
Set "Increments/Encoder Revolution" and "Number of Revolutions" to the master setting. 
The baud rate is irrelevant. Depending on the encoder type select "Listen in" or "Listen in 
right-justified" for "Frame length". 
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Wiring listen In 
The following diagram uses the example of an FM 451 and FM 452 to illustrate how to 
connect the absolute encoder so that the FM 452 listens in. 

 
Figure 11-3 Connection Scheme for Absolute Encoders (SSI) 

 

 Note 
If you want the FM 452 to listen in, you must connect the ground (M) of the encoder power 
supply of the master (for example FM 451: front connector, pin 48) and of the slave module 
(FM 452: front connector, Pin 48) making a low-resistance connection with the ground of the 
CPU. 

 

Reaction times 
With absolute encoders, the FM 452 has the following reaction times: 
Minimum reaction time = frame run time + cam cycle time + switching time of the connected 
switching elements 
Maximum reaction time = 2 x frame run time + monostable flip-flop time + 2 x cam cycle time 
+ switching time of the connected switching elements 
With programmable absolute encoders: 
Maximum reaction time = frame run time + monostable flip-flop time + 2 x cam cycle time + 
switching time of the connected switching elements +1/max. step train sequence 
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Monostable flip-flop time 
The following limit values apply to the monostable flip-flop time: 
● Minimum monostable flip-flop time: > 15 µs 
● Maximum monostable flip-flop time: < 64 µs 
Encoders with values outside the limits shown here are not permitted. 

Frame run times 
The frame run times depend on the baud rate: 

 
Baud rate Frame run time for 13 bits Frame run time for 25 bits 
0.125 MHz 112 µs 208 µs 
0.250 MHz 56 µs 104 µs 
0.500 MHz 28 µs 52 µs 
1.000 MHz 14 µs 26 µs 

Example of reaction times 
The following example shows how to calculate the minimum and maximum reaction time. In 
the example a programmable encoder is not used. 
● Cam cycle time: approx. 20 µs for max. 16 cams 
● Response time of the hardware: approx. 150 µs 
● Frame run time: 26 µs at a baud rate of 1 MHz (25 bit frame) 
● Monostable time: 20 µs (depends on the encoder: typical 20 µs to 40 µs 
Maximum reaction time = 26 µs + 20 µs + 150 µs = 196 µs 
Maximum reaction time = 2 x 26 µs + 20 µs + 2 x 20 µs + 150 µs = 262 µs  

 

 Note 
You can compensate the reaction time with appropriate parameter settings for the cams or 
using dynamic adjustment. 

 

Flat gain 
The flat gain is equivalent to the difference between the min./max. reaction time.  
With an absolute encoder it is as follows: 
Flat gain ≙ cam cycle time + frame runtime + monostable flip-flop time 
With an absolute encoder it is as follows: 
Flat gain ≙ cam cycle time + frame runtime + monostable flip-flop time 
+ 1/max. step sequence rate  
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 Note 
If the switching time of the hardware on the FM 452 and the switching time of the connected 
switching elements can be ignored, then reliable switching of the cam is guaranteed if the 
cam is longer than the distance traveled within the cam cycle time.  

 

See also 
● Technical data (Page  155) 
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Diagnosis 12
12.1 Options of error diagnostics 

Overview 
● With the programming device/PC, you can read the diagnostic buffer using the Test > 

Error Evaluation programming interface. 
– You will see the error class and error number along with plain text. 

● You can evaluate errors in your program. The following options are available: 
– The return values (RET_VAL) of the linked FC as a group display for errors that 

occurred while the FC was being executed. 
– The error bits of the jobs as a group display for errors that occurred while executing a 

job. 
– The error bit DATA_ERR as a group display for an error detected by the FM 452 

during a write job. 
– The error flag in JOB_ERR, for the cause of error in the communication between the 

FC and FM 452. 
– FC CAM_DIAG for reading out the diagnostic buffer of the FM 452. Here, you can find 

out the causes of errors in jobs and asynchronous events (operating errors, diagnostic 
errors). 

– Diagnostics interrupts for fast reaction to events. 
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12.2 Meaning of the error LEDs 

Display 
The status and error display indicate various error states. The LEDs are lit, even with errors 
that occur briefly, for at least 3 seconds. 

 
Figure 12-1 Status and Fault/Error Indicators of the FM 452 

 
Display Meaning Notes 

INTF (red) 
LED - ON 

Group error for 
internal error 

This LED indicates the following error states on the FM 452: 
• Hardware interrupt lost 
• Watchdog expired 
• FM 452 is not configured. 
• Incorrect FM 452 parameter assignment (only when 

parameters assigned with SDB) 
EXTF (red) 
LED - ON 

Group errorfor 
external errors 

This LED indicates the following error states: 
• No external 24 V auxiliary supply 
• Front connector missing 
• Encoder wire break 
• Process error 
• Absolute encoder frame error 
• Incremental encoder pulse missing or zero mark signal 

missing 
INTF 
EXTF 

Module defective All outputs are disabled. The module must be replaced. 
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12.3 Diagnostics interrupts 

12.3.1 Enable diagnostics interrupts 

Alarm Processing 
The FM 452 can trigger hardware and diagnostic interrupts. Process those interrupts in an 
interrupt OB. If an interrupt is generated and the corresponding OB is not loaded, the CPU 
changes to STOP (refer to the manual Programming with STEP 7).  
You enable the servicing of diagnostic interrupts as follows: 
1. Select the module in HW Config 
2. Use the Edit > Object Properties > Basic Parameters command to enable the diagnostic 

interrupt. 
3. Save and compile the hardware configuration. 
4. Download the hardware configuration to the CPU. 

Overview of the Diagnostic Interrupts 
Events and errors triggering a diagnostic interrupt: 
● Process error 
● Incorrect machine data (when programmed with SDB) 
● Incorrect cam data (when programmed with SDB) 
● Diagnostics errors 
For detailed information on this error, refer to the appendix. 

See also 
● Data and Structure of the Diagnostic DB (Page  180) 
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12.3.2 Reaction of FM 452 to errors with diagnostics interrupt 

Reactions 
● Cam processing will be disabled. 
● The synchronization will be cleared by the following diagnostic interrupts: 

– Front connector missing, external power supply missing 
– Zero mark error detected, cable fault (5 V encoder signals) 
– Traversing range exceeded (indicated by a process/hardware error) 
– Set actual value cannot be executed (indicated by a process error). 

● With one exception, control signals are no longer processed 
Exception: 
After the software limit switch has been passed, a reversal of direction is still possible in 
simulation mode. 

● Function switch and job processing continues. 

FM 452 detects an error ("incoming") 
A diagnostic interrupt is an "incoming" event if at least one error is pending. If not all errors 
were cleared, the queued errors are reported once again as "incoming" events. 
Sequence: 
1. FM 452 detects one or several errors, and generates a diagnostics interrupt. The "INTF" 

or "EXTF" LED lights up. The error event is logged to the diagnostics buffer. 
2. The CPU operating system calls OB82. 
3. You can now evaluate the start information of OB82. 
4. The OB82_MOD_ADDR parameter shows the interrupt triggering module. 
5. For further information, call FC CAM_DIAG. 

FM 452 detects a transition to error-free state ("outgoing")  
A diagnostics interrupt is only registered "outgoing" if all errors on the module are cleared. 
Sequence: 
1. FM 452 detects that all errors have been cleared, and generates a diagnostics interrupt. 

The LED "INTF" or "EXTF" is no longer lit. The diagnostics buffer remains unchanged. 
2. The CPU operating system calls OB82. 
3. The OB82_MOD_ADDR parameter shows the interrupt triggering module. 
4. Evaluate the OB82_MDL_DEFECT bit. 

When this bit is "0", no errors are present on the module. You can close the evaluation 
session at this point. 
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Diagnostics interrupt control by CPU states 
● When the CPU is in the STOP state, diagnostic interrupts from the FM 452 are disabled. 
● If none of the queued errors were cleared while the CPU was in STOP, the FM 452 

reports all these errors as "incoming" event at the next CPU transition to RUN. 
● If all existing errors have been eliminated in the CPU STOP state, then the error-free FM 

452 state is not signaled with a diagnostic interrupt after the CPU changes to RUN. 
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Examples 13
13.1 Introduction 

Example project folder 
The FM 352/FM 452 software package you installed contains two example projects showing 
you several typical applications based on a number of selected functions.  
The German example project for the FM 452 is located in the folder 
...\STEP7\EXAMPLES\zEn19_02. 
This folder contains several S7 programs of varying complexity and objectives. 

13.2 Preconditions 

Overview 
Requirements: 
● A completely wired S7 station, consisting of a power supply module, a CPU and an FM 

452 module, version V5 or higher. The characteristics of earlier module versions may 
deviate from the description. 

● You have correctly installed STEP 7 and the configuration package for the FMx52 on 
your programming device/PC. 

● The PG is connected to the CPU. 

http://www.efesotomasyon.com/html/siemens/siemens.html
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13.3 Preparing the examples 

Procedure 
Preparations for online sessions with the example project: 
1. Open the \STEP7\EXAMPLES\zEn19_02_FMx52___Prog example project in SIMATIC 

Manager, then copy it under a suitable name to your project folder. 
2. Insert a station in this project according to your hardware configuration. 
3. Complete the hardware configuration with HW Config and save the configuration. 
4. Select an example program and copy its block folder to your station. 
5. Assign parameters to the FM 452 in HW Config using the instructions provided in the 

section entitled "Set the Parameters for the FM 452" of the FM 452 - Getting Started 
Manual. 

6. Select the FM 452 in HW Config and point to "Edit > Object Properties" to display the 
object properties. 
Open the "Mod Addr..." dialog box, then enter the current module address in all offline 
channel DBs and diagnostics DBs in the block folder. Invoke the dialog box for each 
block. 
You can also enter the module address in the MOD_ADDR block parameter with the 
LAD/STL/FBD editor. 

7. Download the hardware configuration to your CPU. 
8. Download the blocks to your CPU. 
9. To try out the next example, go to step 4. 

13.4 Displaying the code of the examples 

Display 
The samples are written in STL. You can view them directly in the LAD/STL/FBD editor.  
Select the view with "Symbolic representation", "Symbol selection" and "Comment." If your 
screen provides sufficient space, you can also open the "Symbol information" view. 
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13.5 Testing the example 

Procedure 
After you have successfully completed all necessary entries, download the entire block folder 
to the CPU.  
The sample programs include variable tables (VATs) which you can use to monitor and 
modify data blocks online (i.e. in CPU RUN-P mode).  
● From the variables table, select the "Symbol" and "Symbol Comment" views. 
● Open a variables table. 
● Open the variables table with the configured CPU, and monitor the variables cyclically. 
This updates the variables dynamically when the CPU is RUN-P or RUN mode. 
All the samples require that the machine and cam data were entered and saved using the 
programming interface. This allows you to execute the samples successively.  

13.6 Reusing an example project 

Restrictions 
The code of the samples in neither optimized nor designed for all eventualities.  
Error evaluation is not programmed in detail in the sample programs in order to avoid the 
programs becoming unwieldy.  

13.7 Sample program 1 "Getting Started" 

Objective 
In this sample, you commission your cam controller after you have programmed it in the 
programming interface according to the "Getting Started" manual.  
The sample extends the program shown in the "Integration in the User Program" chapter of 
the getting started by adding error evaluation. 

Preconditions 
You have programmed the cam controller as described in the "Getting Started."  
The address of your module is entered correctly at MOD_ADDR in the channel DB.  

Startup 
In the startup OB (OB100), call FC CAM_INIT to resets all control and return signals, as well 
as job management in the channel DB. 
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Cyclic mode 
● Open the variables table. 
● Go online to the configured CPU to monitor the variables. 
● Transfer the prepared control values. 
The module changes to simulation mode. You can see how the actual value 
(CAM.ACT_POS) and track signals (CAM.TRACK_OUT) change dynamically.  
● Now change the simulation direction, specify different reference point coordinates, then 

disable simulation etc. by modifying and transferring the control values. 

Error evaluation 
Generate a data error by entering a reference point coordinate greater than the end of the 
rotary axis (for example, 10000000). The CPU goes into STOP. (In a sample, this is the 
simplest method of indicating an error. You can, of course, program a more sophisticated 
method.)  
Open HW Config, the double-click FM 352 or FM 452. This opens the programming 
interface. Select Test > Error evaluation to view the cause of the error.  
To clear the error: 
1. Enter a valid control value. 
2. Switch the CPU to STOP. 
3. Switch the CPU to RUN-P. 
4. Enable the control values. Control values enabled before the restart of the CPU restarts 

are reset by the initialization routine in OB100, and thus have no effect. 
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13.8 Sample Program 2 "Commissioning" 

Objective 
In this sample, you commission a cam controller without using the programming interface. 
You control and monitor the system using the variables tables (VATs).  

Preconditions 
You have programmed the cam controller as described in the "Getting Started."  
The module address is entered at the MOD_ADDR block parameter in the channel and 
diagnostics DBs.  
The included channel DBs already contain the DB number (3) at the PARADBNO parameter 
of the parameter DB. 
PARADB included in this example contains default machine and cam data.  

Startup 
In the startup OB (OB100), call FC CAM_INIT to initialize the channel DB. Next, set the 
trigger bits for all jobs and control signals you require when the module has completed its 
startup.  

Cyclic mode 
Open the variables tables VAT1 and VAT2, then go online to the configured CPU to monitor 
the variables. 
At VAT1, you can view the changes in the actual position and the track signals. The module 
is in operation.  
In VAT2, you can see the most important entries of the diagnostics buffer of the module. For 
information on error classes and numbers, refer to the appendix of the Manual.  
Edit the machine and cam data at DB PARADB, download the DB to the CPU, and then 
enable the control values in VAT1. This writes the new data to the module, and enables 
these. Faulty data are indicated in VAT2. For information on machine and cam data, refer to 
the Manual. 

Error evaluation 
Try to generate further errors: 
● Define a reference point coordinate which is higher than the end of the rotary axis. 
● Switch off the external power supply. 
● Delete PARADB from the CPU (online), and then attempt to write machine data. (The 

error evaluation is once again programmed [maliciously] so that the CPU changes to 
STOP. If you update VAT1 again, the error code for this error is indicated in 
CAM.JOB_ERR.) 
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See also 
● Data and Structure of the Diagnostic DB (Page  180) 
● Machine data and cam data (Page  65) 

13.9 Sample program 3 "OneModule" 

Objective 
In this example, you control a cam controller in a user program. The user program puts the 
module into operation after a CPU restart. Next, it executes a step sequence which is 
triggered by certain events.  
Using the variables tables, you define events, monitor the reactions of the module, and 
evaluate the diagnostics buffer.  
This slightly more complex sample shows you the block options: 
● Requesting a batch of jobs 
● Mixing read and write jobs 
● Reading using a continuous job without waiting for the end of the job 
● Evaluating the return signals of the block 
● Evaluating the return signals for an individual job 
● Resetting the done and error bits for individual, or all jobs 
● Central CAM_CTRL call at the end of the user program 
● Central error evaluation by CAM_DIAG at the end of the user program 
● Evaluation of the diagnostic buffer in conjunction with DATA_ERR 

Preconditions 
You have programmed the cam controller as described in the "Getting Started."  
The module address is entered at the MOD_ADDR block parameter in the channel and 
diagnostics DBs. 
The included channel DBs already contain the DB number (3) at the PARADBNO parameter 
of the parameter DB. 
PARADB included in this example contains default machine and cam data. 

Startup, 
At the startup OB (OB100), set the startup flag (step 0) for the user program in the 
corresponding instance DB.  
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Operation 
The CPU is in STOP.  
● Open variables table VAT1, then transfer the control values. 
● Restart the CPU (STOP > RUN-P). 
You can see how the actual position (CAM.ACT_POS), the cam data (CAM.CAM_00_31) 
and the track signals (CAM.TRACK_OUT) change. You should also observe the step 
number of the step sequence (PROGDB.STEPNO).  
When cam 4 is set (130 degrees), the cam 0 and 1 parameters are assigned the new values 
you defined in VAT1. You can view the change in the VAT. 
Next, the program waits for an external event.  
● Once again, transfer the prepared control values from the VAT (this time, 

PROGDB.SWITCH is evaluated). 
The previous values will be restored in the cam data.  
The step sequence is completed after this cycle, the step number = -2, and simulation is 
stopped. 
If you want to repeat the entire sequence again, restart the CPU (STOP > RUN-P). (This 
procedure is, of course, only acceptable in the sample program.) 
If you have not activated the PROGDB.SWITCH switch before a CPU STOP, the parameters 
of the cam in the parameter DB are not set back to the original values. In this case, once 
again download the parameter DB to the CPU. 

Error evaluation 
Any processing error will stop the step sequence and disable simulation mode. Step number 
-1 will be entered.  
Try to generate cam errors the central error evaluation will save to the PROGDB.CAM_ERR 
bit as group error.  
● Set cam positions in VAT1 which are higher than the end of the rotary axis. 
● Define negative cam positions in VAT1. 

User program (FB PROG) 
The user program accesses data in the module-specific data blocks using the 
<blockname>.<symbolic name> syntax. The user program can thus operate exactly one 
module. The DB numbers defined at the call of the user program are merely passed on to 
supply FC CAM_CTRL and FC CAM_DIAG. With this type of programming, you can access 
DB data using symbolic names. Indirect addressing of several modules is part of sample 
program 5 "MultiModules." 
The user program executes a step sequence as follows: 
Step 0: Initialization of the cam controller. Sets the jobs and corresponding data to be 
executed at a restart of the module. The restart of the module may be triggered by a CPU 
restart, or by the return of a rack, for example.  
Step 1: The program waits for the set jobs to be executed. 
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Step 2: The program continuously reads the output cam ID bits and waits until output cam 4 
is set. 
Step 3: Cams 0 and 1 receive new parameters. To let you view the change, the cam data 
are read before and after the change and indicated at VAT1.  
Step 4: The program waits for the set jobs to be executed. 
Step 5: The program waits for the "external" event "switch on" (CAM.SWITCH = 1) that you 
can set at the VAT.  
Step 6: The incoming event resets cams 0 and 1 to the value read in the initialization step.  
Step 7: The program waits for the set jobs to be executed. 
FC CAM_CTRL and FC CAM_DIAG are called at the end of the step sequence. Output 
CAM_ERR will be set if the diagnostics function has detected an alarm indicating incorrect 
cam data. 
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13.10 Sample program 4 "Interrupts" 

Objective 
This sample contains a user program with the same task as in sample program 3 
"OneModule". In this sample, you are shown how to evaluate a diagnostics interrupt for 
specific modules, and how to process this in the user program to produce a general module 
error.  

Preconditions 
You have programmed the cam controller as described in the "Getting Started."  
The module address is entered at the MOD_ADDR block parameter in the channel and 
diagnostics DBs. 
In HW Config, enable the diagnostics interrupt for this module with Edit > Object Properties > 
Basic Parameters > Select Interrupt > Diagnostics. Compile the hardware configuration, and 
then download it to the CPU.  
The included channel DBs already contain the DB number (3) at the PARADBNO parameter 
of the parameter DB. 
PARADB included in this example contains default machine and cam data. 

Startup 
At the startup OB (OB100), the startup flag (step 0) for the user program is set in the 
instance DB.  

Operation 
As in sample program 3 "OneModule".  

Error evaluation 
As in sample program 3 "OneModule".  
Generate diagnostics interrupts by disconnecting the auxiliary power supply to the module, 
or by removing the front connector. The module error MOD_ERR and the diagnostic error 
OB82_ERR are set to 1 and the step number becomes -1. When you eliminate the problem, 
the error flags are also reset. Cam processing and simulation, however, remain disabled. 

User program (FB PROG) 
The task is the same as in the sample program 3 "OneModule". However, the block was 
expanded by adding evaluation of the diagnostics event.  
In this sample, no special measures have been taken for restarting after eliminating the 
error. We have left this up to you as part of the exercise.  
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Diagnostics interrupt (OB82) 
Depending on the address of the module that triggered the interrupt (OB82_MDL_ADDR), 
the error ID in the corresponding instance DB of the user program is entered in the 
diagnostics interrupt.  
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13.11 Sample program 5 "MultiModules" 

Objective 
This sample contains the same user program as sample program 3 "OneModule", however it 
is used to operate two modules with different cam parameters. The same copy of the user 
program is used for both modules. Of course, each module has its own set of data blocks. 

Requirements 
You have inserted 2 FMx52 modules and configured these in HW Config.  
You have assigned parameters for both cam controllers as described in the "Getting Started" 
manual. 
The address of the relevant module has been entered in the block parameter MOD_ADDR in 
the channel DBs and diagnostic DBs.  
The included channel DBs already contain the DB number (3 or 13) of the corresponding 
parameter DB in the PARADBNO parameter. 
The PARADB and PARADB2 parameter DBs of the sample project contain default machine 
and cam data for both modules.  
A set of variables tables is also prepared for each module.  

Startup 
At the startup OB (OB100), set the startup flag (step 0) for the user program at both instance 
DBs.  

Operation 
The CPU is in STOP.  
● Open VAT1 and VAT11, and transfer their control values. 
● Restart the CPU (STOP > RUN-P). 
You can see how monitor the change of the actual positions, of cam data, and of the track 
signals of both modules.  

Error evaluation 
As in sample program 4 "Interrupts", but separately for each of the two modules..  
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User program (FB PROG) 
The objectives and steps of the user program are as in example program 4 "Interrupts" and 
in example program 3 "One Module". 
The user program is designed for the operation of more than one module, since it indirectly 
accesses module-specific DBs (channel DB, diagnostics DB, and parameter DB). In addition 
to transferring the DB numbers specified in the call to FC CAM_CTRL and FC CAM_DIAG, 
these are also deployed by the user program itself. With this type of programming, you 
cannot use symbolic names for the data in the data blocks.  

Diagnostics interrupt (OB82) 
Depending on the address of the module that triggered the interrupt (OB82_MDL_ADDR), 
the error ID in the corresponding instance DB of the user program is entered in the 
diagnostics interrupt.  
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Technical data A
A.1 Technical data 

Technical data 
 

Dimensions and weight 
Dimensions W x H x D (mm) 25 x 290 x 280 
Weight Approx. 650 g 

Current, voltage and power 
Current consumption (from the backplane bus) Max. 500 mA 
Power loss Typically 8.1 W 
Current consumption of encoders, digital inputs 
and outputs from 1L+, 2L+ and 3L+ (no-load) 

max. 40 mA (front connector: pin 3, 26, 36) 

Supply of digital inputs and outputs • Supply voltage: 24 V DC 
(permissible range: 20.4 V to 28.8 V) 

• Permissible potential difference between the 
input ground connection M (front connector: 
pin 48) 
– and the central grounding point (shield): 

60 V AC; 75 V DC 
– Insulation test voltage: 500 V DC 

Encoder supply • Encoder power supply 5 V 
– 5.2 V ± 2 % 
– Max. 300 mA 
– Short-circuit proof 

• Encoder power supply 24 V 
– aux. voltage -1.5 V 
– Max. 300 mA 
– Short-circuit proof 

Load voltage polarity reversal protection No 
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Encoder inputs 
Position acquisition • Incremental 

• Absolute 
Signal voltages • Symmetrical inputs: 5 V to RS422 

• Asymmetrical inputs: 24 V/typ. 9 mA 
Input frequency and cable length for symmetrical 
incremental encoder with 5 V supply 

max. 1 MHz with 32 m shielded cable length 

Input frequency and cable length for symmetrical 
incremental encoder with 24 V supply 

max. 1 MHz with 100 m shielded cable length 

Input frequency and cable length for 
asymmetrical incremental encoder with 24 V 
supply 

• max. 50 KHz with 25 m shielded cable length 
• max. 25 KHz with 100 m shielded cable 

length 
Data transfer rate and cable length for absolute 
encoders 

• max. 125 KHz with 320 m shielded cable 
length 

• max. 250 KHz with 160 m shielded cable 
length 

• max. 500 KHz with 63 m shielded cable 
length 

• max. 1 MHz with 20 m shielded cable length 
Listen mode with absolute encoders Yes 
Input signals • Incremental: 2 pulse trains, 90° phase shift, 1 

zero pulse 
• Absolute: Absolute value; SSI and Gray code 
• Proximity switch 24 V 

Digital inputs 
Number of digital inputs 11 
Number of simultaneously controllable digital 
inputs 

11 

Electrical isolation No 
Status display Yes, green LED per input 
Input voltage • 0 signal: -30 ... 5 V 

• 1 signal: 11 ... 30 V 
Input current • 0 signal: ≤ 2 mA (quiescent current) 

• 1 signal: 9 mA 
Input delay • 0 → 1 signal: max. 200 µs 

• 1 → 0 signal: max. 200 µs 
Connection of a 2-wire BERO supported 
Unshielded cable length max. 32 m 
Shielded cable length max. 600 m 
Switching rate max. 500 Hz 
Dielectric strength test to VDE 0160 
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Digital outputs 
Number of outputs 16 
Electrical isolation No 
Status display Yes, green LED per channel 
Output current • 0 signal: 0.5 mA 

• High signal: 0.5 A 

(permissible range: 5 ... 600 mA) 
• Lamp load: 5 W 

Output delay for output current 0.5 A • 0 → 1 signal: max. 150 µs 
• 1 → 0 signal: max. 150 µs 

Signal level for 1 signal 1L+, 2L+, 3L+: -0.8 V 
Controlling of digital inputs Yes 
Control of a counter input Only conditionally, see note 
Short-circuit protection Yes, electronically clocked 
Limit of inductive cut-off voltage 1L+, 2L+, 3L+: -48 V 
Switching rate • resistive load: max. 500 Hz 

• inductive load: max. 0.5 Hz 
Total current of the digital outputs Simultaneity factor 100%: 8 A 
Unshielded cable length max. 100 m 
Shielded cable length max. 600 m 
Dielectric strength test to VDE 0160 

 
 

 Note 
When the 24 V power supply is turned on using a mechanical contact, the FM 452 applies a 
pulse to the outputs. The pulse may assume a length of 50 µs within the permissible output 
current range. Make allowances for this factor when using FM 452 in combination with high-
speed counters. 
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A.2 Standards and approvals 

Cross-reference 
The following technical data are described in the installation manual S7-400/M7-400 
Programmable Controllers, Hardware and Installation. 
● Electromagnetic compatibility (EMC) 
● Transport and storage conditions 
● Mechanical and Climatic Environmental Conditions 
● Information on insulation testing, safety class and degree of protection 

UL/CSA approvals 
Certifications available for S7-400: 
● UL-Recognition-Mark 

Underwriters Laboratories (UL) according to  
Standard UL 508, File E 116536 

● CSA-Certification-Mark 
Canadian Standard Association (CSA) according to  
Standard C 22.2 No. 142, File LR 48323 

FM approval 
FM approval is available for S7-400: 
FM approval in accordance with Factory Mutual Approval Standard Class Number 3611, 
Class I, Division 2, Group A, B, C, D. 

 

WARNING  
Risk of injury and material damage! 
In potentially explosive environments, there is a risk of injury or damage if you disconnect 
any connectors while the S7-400 is in operation. 
Always isolate the S7-400 operated in such areas before you disconnect and connectors. 
 

 
WARNING  

WARNING - DO NOT DISCONNECT WHILE CIRCUIT IS LIVE UNLESS LOCATION IS 
KNOWN TO BE NON-HAZARDOUS 
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CE label 
Our products meet the requirements of EC Directive 89/336/EEC "Electromagnetic 
Compatibility" and the harmonized European Standards (EN) listed there. 
The EU declarations of conformity are kept according to the above-mentioned EC Directive, 
Article 10 for the responsible authorities at: 
Siemens corporation 
Automation Group  
A&D AS E4 
P.O. Box 1963 
D-92209 Amberg, Germany 

Field of application  
SIMATIC products are designed for industrial applications.  

 
Field of application Requirements for 

 Emitted Interference Interference Immunity 
Industrial EN 50081-2 : 1993 EN 50082-2 : 1995 

Observance of installation guidelines 
SIMATIC products meet the requirements if you follow the installation instructions described 
in the manuals when installing and operating the equipment. 
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A.3 Technical Support 

SIMATIC Technical Support 
You can reach technical support for all A&D projects 
● on the Internet using the Support Request:  

http://www.siemens.com/automation/support-request 
● By e-mail: adsupport@siemens.com 
● Phone: +49 (0) 180 5050 222 
● Fax: +49 (0) 180 5050 223 
For further information about our Technical Support, refer to the Internet at 
http://www.siemens.com/automation/service 

Service & Support on the Internet 
Supplementary to our documentation offers, we offer you a comprehensive online knowledge 
base on the Internet. 
http://www.siemens.com/automation/service&support 
There you will find: 
● our Newsletter which continuously provides the latest information about your products. 
● the right documents for you, using our Service & Support search engine.. 
● our Forum where users and experts exchange their knowledge world-wide. 
● Your local partner of Automation & Drives. 
● Information about on-site services, repairs and replacement parts. Lots more can be 

found on our "Services" pages. 

http://www.siemens.com/automation/support-request
mailto:adsupport@siemens.com
http://www.siemens.com/automation/service
http://www.siemens.com/automation/service&support
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Additional support 
If you have any questions about using the products described in the manual, and do not find 
the right answers, please contact your local Siemens partner at your Siemens office. 
You can find your local partner at: 
http://www.siemens.com/automation/partner 
A guide to our technical documentation for the various SIMATIC products and systems is 
available at: 
http://www.siemens.de/simatic-tech-doku-portal 
The online catalog and online ordering systems are available at: 
http://mall.ad.siemens.com/ 

Training Centers 
Siemens offers appropriate courses to get you started. Please contact your regional Training 
Center, or the central Training Center in D-90327 Nuremberg. 
Phone:+49 (911) 895-3200 
http://www.sitrain.com 

http://www.siemens.com/automation/partner
http://www.siemens.de/simatic-tech-doku-portal
http://mall.ad.siemens.com
http://www.sitrain.com
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Connection diagrams B
B.1 Encoder types 

Overview 
The table below describes the encoders supported by FM 452. The connection diagrams for 
these encoders are described in this section:' 

 
Encoder type Connecting cable Remarks 

Incremental encoder 
Siemens 6FX 2001-2VVVV 

4 x 2 x 0.25 + 2 x 1 mm2 Vp=5 V, RS422 

Incremental encoder  
Siemens 6FX 2001-2VVVV 

4 x 2 x 0.5 mm2 Vp=24 V, RS422 

Incremental encoder  
Siemens 6FX 2001-4VVVV 

4 x 2 x 0.5 mm2 Vp=24 V, HTL 

Absolute encoder  
Siemens 6FX 2001-5VVVV 

4 x 2 x 0.5 mm2 Vp=24 V, SSI 

 



Connection diagrams  
B.2 Connection Diagram for Incremental Encoder Siemens 6FX 2001-2 (Up=5V; RS 422) 

 FM 452 Installation and Parameter Assignment 
164 Operating Instructions, 07/2007, A5E01071729-01 

B.2 Connection Diagram for Incremental Encoder Siemens 6FX 2001-2 
(Up=5V; RS 422) 

Connection diagram 

4
5

6
7

8
9

25

23

5
6

8
1

3
4

10

12

11

2

A 1)

1)

1)

1)

/A

/B
B

/N
N

FM 452

+5.2 V

Shield to
housing

Chassis ground

Wire 4 x 2 x 0.25 + 2 x 1 mm2

Whires twisted in pairs

Encoders

Shield to
housing

 
Figure B-1 Connection Diagram for Incremental Encoder Siemens 6FX 2001-2VVVV (Up=5 V: 

RS422) 

Socket 
Connection (solder) side, 12-pin circular female connector Siemens 6FX 2003-0CE12 

 
Figure B-2 Circular connector 
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B.3 Connection Diagram for Incremental Encoder Siemens 6FX 2001-2 
(Up=24V; RS 422) 

Connection diagram 
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Figure B-3 Connection diagram for incremental encoder Siemens 6FX 2001-2vvv (Up=24V; RS 

422) 

Socket 
Connection (solder) side, 12-pin circular female connector Siemens 6FX 2003-0CE12 

 
Figure B-4 Circular connector 



Connection diagrams  
B.4 Wiring Diagram of the Incremental Encoder Siemens 6FX 2001-4 (Up = 24 V; HTL) 

 FM 452 Installation and Parameter Assignment 
166 Operating Instructions, 07/2007, A5E01071729-01 

B.4 Wiring Diagram of the Incremental Encoder Siemens 6FX 2001-4 (Up = 
24 V; HTL) 

Connection diagram 

12
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14
25

24
27

A*
B*

N*

+24 V
Computer Unit

5
8

3
10

12
11

FM 452

Chassis ground

Shield to
housing

Wire 4 x 2 x 0.5 mm2

Encoders

Shield to
housing

 
Figure B-5 Connection diagram for incremental encoder Siemens 6FX 2001-4vvv (Up=24V; HTL) 

Socket 
Connection (solder) side, 12-pin circular female connector Siemens 6FX 2003-0CE12 

 
Figure B-6 Circular connector 

 

 Note 
To connect a non-SIEMENS incremental encoder in a push-pull configuration (current 
sourcing/sinking), observe the following: 
• Current sourcing: Connect RE (27) to ground (25). 
• Current sinking: Connect RE (27) to +24 V (24). 
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B.5 Connection Diagram for Absolute Encoder Siemens 6FX 2001-5 
(Up=24V; SSI) 

Connection diagram 

 
Figure B-7 Connection diagram for absolute encoder Siemens 6FX 2001-5 (Up=24V; SSI) 

Socket 
Connection (solder) side, 12-pin circular female connector Siemens 6FX 2003-0CE12 

 
Figure B-8 Circular connector 
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Data blocks / error lists C
C.1 Content of the channel DB 
 

 Note 
Do not modify any data not listed in this table. 

 

Content of the channel DB 
 

Address Name Type Start value Comment 
Addresses/Version Switch 
0.0 MOD_ADDR (enter!) INT 0 Module address 
2.0 CH_NO INT 1 Channel number (always 1) 
10.0 PARADBNO 

 
INT -1 Number of the parameter DB 

-1 = DB not available 
12.0 FM_TYPE BOOL FALSE 0 = FM352 up to V4.0 

1 = FM452 or FM352 V5.0 or higher 

 
 

Control signals 
15.2 DIR_M BOOL FALSE 1 = simulation in negative direction 
15.3 DIR_P BOOL FALSE 1 = simulation in positive direction 
15.4 CAM_EN BOOL FALSE 1 = enable cam processing 
15.5 CNTC0_EN BOOL FALSE 1 = enable count function of counter cam 

track 0 
15.6 CNTC1_EN BOOL FALSE 1 = enable count function of counter cam 

track 1 
16.0 TRACK_EN WORD W#16#0 Enable cam tracks 0 to 15 

Bit 0 = track 0 
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Return signals 
22.2 DIAG BOOL FALSE 1 = diagnostics buffer modified 
22.4 DATA_ERR BOOL FALSE 1 = data error 
22.7 PARA BOOL FALSE 1 = module has parameters assigned 
23.4 CAM_ACT BOOL FALSE 1 = cam processing busy 
25.0 SYNC BOOL FALSE 1 = axis is synchronized 
25.1 MSR_DONE BOOL FALSE 1= length measurement or edge detection 

completed 
25.2 GO_M BOOL FALSE 1 = axis moving in negative direction 
25.3 GO_P BOOL FALSE 1 = axis moving in positive direction 
25.4 HYS BOOL FALSE 1 = axis within the hysteresis range 
25.5 FVAL_DONE BOOL FALSE 1 = set actual value on-the-fly executed 
26.0 ACT_POS DINT L#0 Current position of axis 
30.0 TRACK_OUT DWORD DW#16#0 Current signals of tracks 0 to 31 

Bit 0 = track 0 

 
 

Function switch 
34.0 EDGE_ON BOOL FALSE 1 = edge detection on 
34.1 SIM_ON BOOL FALSE 1 = simulation on 
34.2 MSR_ON BOOL FALSE 1 = length measurement on 
34.3 REFTR_ON BOOL FALSE 1 = retrigger reference point 
34.4 SSW_OFF BOOL FALSE 1 = software limit switch disabled 

 
 

Trigger bits for write jobs 
35.0 MDWR_EN BOOL FALSE 1 = write machine data  
35.1 MD_EN BOOL FALSE 1 = enable machine data 
35.2 AVALREM_EN BOOL FALSE 1 = set actual value, cancel set actual value 

on-the-fly 
35.3 CAM1WR_EN BOOL FALSE 1 = write cam data 1  

(cam 0 to 15) 
35.4 CAM2WR_EN BOOL FALSE 1 = write cam data 2  

(cam 16 to 31) 
35.5 CAM3WR_EN BOOL FALSE 1 = write cam data 3  

(cam 32 to 47) 
35.6 CAM4WR_EN BOOL FALSE 1 = write cam data 4  

(cam 48 to 63) 
35.7 CAM5WR_EN BOOL FALSE 1 = write cam data 5  

(cam 64 to 79) 
36.0 CAM6WR_EN BOOL FALSE 1 = write cam data 6  

(cam 80 to 95) 
36.1 CAM7WR_EN BOOL FALSE 1 = write cam data 7  

(cam 96 to 111) 
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Trigger bits for write jobs 
36.2 CAM8WR_EN BOOL FALSE 1 = write cam data 8  

(cam 112 to 127) 
36.3 REFPT_EN BOOL FALSE 1 = set reference point coordinates 
36.4 AVAL_EN BOOL FALSE 1 = set actual value 
36.5 FVAL_EN BOOL FALSE 1 = set actual value on-the-fly 
36.6 ZOFF_EN BOOL FALSE 1 = set zero offset 
36.7 CH01CAM_EN BOOL FALSE 1 = write cam edge setting (1 cam) 
37.0 CH16CAM_EN BOOL FALSE 1 = write Fast Cam Parameter Change 

settings (16 cams) 

 
 

Activation bits for read jobs 
37.1 MDRD_EN BOOL FALSE 1 = read machine data 
37.2 CAM1RD_EN BOOL FALSE 1 = read cam data 1  

(cam 0 to 15) 
37.3 CAM2RD_EN BOOL FALSE 1 = read cam data 2  

(cam 16 to 31) 
37.4 CAM3RD_EN BOOL FALSE 1 = read cam data 3  

(cam 32 to 47) 
37.5 CAM4RD_EN BOOL FALSE 1 = read cam data 4  

(cam 48 to 63) 
37.6 CAM5RD_EN BOOL FALSE 1 = read cam data 5  

(cam 64 to 79) 
37.7 CAM6RD_EN BOOL FALSE 1 = read cam data 6  

(cam 80 to 95) 
38.0 CAM7RD_EN BOOL FALSE 1 = read cam data 7  

(cam 96 to 111) 
38.1 CAM8RD_EN BOOL FALSE 1 = read cam data 8  

(cam 112 to 127) 
38.2 MSRRD_EN BOOL FALSE 1 = read measured values 
38.3 CNTTRC_EN BOOL FALSE 1 = read count values of counter cam 

tracks 
38.4 ACTPOS_EN BOOL FALSE 1 = read position and track data 
38.5 ENCVAL_EN BOOL FALSE 1 = read encoder values 
38.6 CAMOUT_EN BOOL FALSE 1 = read cam and track data  
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Done bits for function switches 
40.0 EDGE_D BOOL FALSE 1 = "Activate edge detection" or "Deactivate 

edge detection" completed 
40.1 SIM_D BOOL FALSE 1 = "Activate simulation" or "Deactivate 

simulation" completed 
40.2 MSR_D BOOL FALSE 1 = "Activate length measurement" or 

"Deactivate length measurement" 
completed 

40.3 REFTR_D BOOL FALSE 1 = "Activate retrigger reference point" or 
"Deactivate retrigger reference point" 
completed 

40.4 SSW_D BOOL FALSE 1 = "Activate software limit switch" or 
"Deactivate software limit switch" 
completed 

 
 

Done bits for write jobs 
41.0 MDWR_D BOOL FALSE 1 = "Write machine data" job completed 
41.1 MD_D BOOL FALSE 1 = "Enable machine data" job completed 
41.2 AVALREM_D BOOL FALSE 1 = "Cancel set actual value" or "Cancel set 

actual value on-the-fly" completed 
41.3 CAM1WR_D BOOL FALSE 1 = "Write cam data 1" job completed 
41.4 CAM2WR_D BOOL FALSE 1 = "Write cam data 2" job completed 
41.5 CAM3WR_D BOOL FALSE 1 = "Write cam data 3" job completed 
41.6 CAM4WR_D BOOL FALSE 1 = "Write cam data 4" job completed 
41.7 CAM5WR_D BOOL FALSE 1 = "Write cam data 5" job completed 
42.0 CAM6WR_D BOOL FALSE 1 = "Write cam data 6" job completed 
42.1 CAM7WR_D BOOL FALSE 1 = "Write cam data 7" job completed 
42.2 CAM8WR_D BOOL FALSE 1 = "Write cam data 8" job completed 
42.3 REFPT_D BOOL FALSE 1 = "Set reference point" job completed 
42.4 AVAL_D BOOL FALSE 1 = "Set actual value" job completed 
42.5 FVAL_D BOOL FALSE 1 = "Set actual value on-the-fly" job 

completed 
42.6 ZOFF_D BOOL FALSE 1 = "Set zero offset" job completed 
42.7 CH01CAM_D BOOL FALSE 1 = "Change parameters for 1 cam" job 

completed 
43.0 CH16CAM_D BOOL FALSE 1 = "Change parameters for 16 cams" 

completed (fast cam parameter change) 
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Done bits for read jobs 
43.1 MDRD_D BOOL FALSE 1 = "Read machine data" job completed 
43.2 CAM1RD_D BOOL FALSE 1 = "Read cam data 1" job completed 
43.3 CAM2RD_D BOOL FALSE 1 = "Read cam data 2" job completed 
43.4 CAM3RD_D BOOL FALSE 1 = "Read cam data 3" job completed 
43.5 CAM4RD_D BOOL FALSE 1 = "Read cam data 4" job completed 
43.6 CAM5RD_D BOOL FALSE 1 = "Read cam data 5" job completed 
43.7 CAM6RD_D BOOL FALSE 1 = "Read cam data 6" job completed 
44.0 CAM7RD_D BOOL FALSE 1 = "Read cam data 7" job completed 
44.1 CAM8RD_D BOOL FALSE 1 = "Read cam data 8" job completed 
44.2 MSRRD_D BOOL FALSE 1 = "Read measured values" job completed
44.3 CNTTRC_D BOOL FALSE 1 = "Read count values of counter cam 

tracks" job completed 
44.4 ACTPOS_D BOOL FALSE 1 = "Read position and track data" job 

completed 
44.5 ENCVAL_D BOOL FALSE 1 = "Read actual encoder value" job 

completed 
44.6 CAMOUT_D BOOL FALSE 1 = "Read position and track data" job 

completed 

 
 

Error bits for function switches 
46.0 EDGE_ERR BOOL FALSE 1 = error in "Activate edge detection" or 

"Deactivate edge detection" 
46.1 SIM_ERR BOOL FALSE 1 = error in "Activate simulation" or 

"Deactivate simulation" 
46.2 MSR_ERR BOOL FALSE 1 = error in "Activate length measurement" 

or "Deactivate length measurement" 
46.3 REFTR_ERR BOOL FALSE 1 = error in "Activate retrigger reference 

point" or "Deactivate retrigger reference 
point" 

46.4 SSW_ERR BOOL FALSE 1 = error in "Activate software limit switch" 
or "Deactivate software limit switch" 
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Error bits for write jobs 
47.0 MDWR_ERR BOOL FALSE 1 = error in "Write machine data" job 
47.1 MD_ERR BOOL FALSE 1 = error in "Activate machine data" job 
47.2 AVALREM_ERR BOOL FALSE 1 = error in "Cancel set actual value" or 

"Cancel set actual value on-the-fly" 
47.3 CAM1WR_ERR BOOL FALSE 1 = error in "Write cam data 1" job 
47.4 CAM2WR_ERR BOOL FALSE 1 = error in "Write cam data 2" job 
47.5 CAM3WR_ERR BOOL FALSE 1 = error in "Write cam data 3" job 
47.6 CAM4WR_ERR BOOL FALSE 1 = error in "Write cam data 4" job 
47.7 CAM5WR_ERR BOOL FALSE 1 = error in "Write cam data 5" job 
48.0 CAM6WR_ERR BOOL FALSE 1 = error in "Write cam data 6" job 
48.1 CAM7WR_ERR BOOL FALSE 1 = error in "Write cam data 7" job 
48.2 CAM8WR_ERR BOOL FALSE 1 = error in "Write cam data 8" job 
48.3 REFPT_ERR BOOL FALSE 1 = error in "Set reference point" job 
48.4 AVAL_ERR BOOL FALSE 1 = error in "Set actual value" job 
48.5 FVAL_ERR BOOL FALSE 1 = error in "Set actual value on-the-fly" job 
48.6 ZOFF_ERR BOOL FALSE 1 = error in "Set zero offset" job 
48.7 CH01CAM_ERR BOOL FALSE 1 = error in "Change parameters for 1 cam" 

job 
49.0 CH16CAM_ERR BOOL FALSE 1 = error in "Change parameters for 16 

cams" (fast cam parameter change) 

 
 

Error bits for read jobs 
49.1 MDRD_ERR BOOL FALSE 1 = error in "Read machine data" job 
49.2 CAM1RD_ERR BOOL FALSE 1 = error in "Read cam data 1" job 
49.3 CAM2RD_ERR BOOL FALSE 1 = error in "Read cam data 2" job 
49.4 CAM3RD_ERR BOOL FALSE 1 = error in "Read cam data 3" job 
49.5 CAM4RD_ERR BOOL FALSE 1 = error in "Read cam data 4" job 
49.6 CAM5RD_ERR BOOL FALSE 1 = error in "Read cam data 5" job 
9.7 CAM6RD_ERR BOOL FALSE 1 = error in "Read cam data 6" job 
50.0 CAM7RD_ERR BOOL FALSE 1 = error in "Read cam data 7" job 
50.1 CAM8RD_ERR BOOL FALSE 1 = error in "Read cam data 8" job 
50.2 MSRRD_ERR BOOL FALSE 1 = error in "Read measured values" job 
50.3 CNTTRC_ERR BOOL FALSE 1 = error in "Read count values of counter 

cam tracks" job  
50.4 ACTPOS_ERR BOOL FALSE 1 = error in "Read position and track data" 

job  
50.5 ENCVAL_ERR BOOL FALSE 1 = error in "Read current encoder value" 

job 
50.6 CAMOUT_ERR BOOL FALSE 1 = error in "Read cam and track data" job 
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Job management for FC CAM_CTRL 
52.0 JOB_ERR INT 0 Communication Errors 
54.0 JOBBUSY BOOL FALSE 1 = at least one job is busy  
54.1 JOBRESET BOOL FALSE 1 = reset all error and done bits  

 
 

Job management for FC CAM_MSRM 
56.0 JOB_ERR_M INT 0 Communication Errors 
58.0 JOBBUSY_M BOOL FALSE 1 = job active  

 
 

Parameter for "zero offset" job 
86.0 ZOFF DINT L#0 Zero offset 

 
 

Parameter for "Set actual value" job 
90.0 AVAL DINT L#0 Coordinate for "Set actual value" 

 
 

Parameter for "Set actual value on-the-fly" job 
94.0 FVAL DINT L#0 Coordinate for "Set actual value on-the-fly" 

 
 

Parameter for "Set reference point" job 
98.0 REFPT DINT L#0 Coordinate for "Set reference point" 

 
 

Data for "Change cam edges" job 
102.0 CAM_NO INT 0 Cam number  
104.0 CAM_START DINT L#0 Cam start 
108.0 CAM_END DINT L#0 Cam end position 

 
 

Data for the "Length measurement/edge detection" job 
112.0 BEG_VAL DINT L#0 Start value 
116.0 END_VAL DINT L#0 End value 
120.0 LEN_VAL DINT L#0 Length 
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Data for the "Read count values" job 
124.0 CNT_TRC0 INT 0 Actual count value of counter output cam 

track 0 
126.0 CNT_TRC1 INT 0 Actual count value of counter output cam 

track 1 

 
 

Data for the "Read position and track data" job 
128.0 ACTPOS DINT L#0 Actual position 
132.0 ACTSPD DINT L#0 Actual velocity 
136.0 TRACK_ID DWORD DW#16#0 Track flag bits of tracks 0 to 31 

 
 

Data for the "Read encoder data" job 
140.0 ENCVAL DINT L#0 Encoder value 
144.0 ZEROVAL DINT L#0 Count value at the last zero mark 
148.0 ENC_ADJ DINT L#0 Absolute encoder adjustment 

 
 

Data for the "Read cam and track data" job 
152.0 CAM_00_31 DWORD DW#16#0 Cam flag bits for cams 0 to 31 
156.0 CAM_32_63 DWORD DW#16#0 Cam flag bits for cams 32 to 63 
160.0 CAM_64_95 DWORD DW#16#0 Cam flag bits for cams 64 to 95 
164.0 CAM_96_127 DWORD DW#16#0 Cam flag bits for cams 96 to 127 
168.0 TRACK_ID1 DWORD DW#16#0 Track flag bits of tracks 0 to 31 
172.0 ACTPOS1 DINT L#0 Actual position  

 
 

Data for the "Fast cam parameter change" job 
176.0 C_QTY BYTE B#16#0 Number of cams to modify 
177.0 DIS_CHECK BOOL FALSE 1 = disable data check 
180.0 CAM ARRAY 

[0...15] 
STRUCT 

 Note: 
The following structure must be 
completed for each cam to be modified 
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Relative address 
+0.0 CAM_NO BYTE B#16#0 Number of the cam to modify 
+1.0 C_EFFDIR BOOL FALSE 1 = change the activation direction 
+1.1 C_CBEGIN BOOL FALSE 1 = change the cam start to the value 

CBEGIN (new cam start) 
+1.2 C_CEND BOOL FALSE 1 = change the cam end / cam activation 

time to the value CEND (new cam end) 
+1.3 C_LTIME BOOL FALSE 1 = change the lead time to the value 

LTIME (new lead time) 
+1.4 CAM_OFF BOOL FALSE 1 = deactivate the cam during the cam 

change 
+1.5 EFFDIR_P BOOL FALSE 1 = new effective direction positive (plus)
+1.6 EFFDIR_M BOOL FALSE 1 = new effective direction negative 

(minus) 
+2.0 CBEGIN DINT L#0 New cam start 
+6.0 CEND DINT L#0 New cam end / new cam activation time 
+10.0 LTIME INT 0 New lead time 
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C.2 Content of the Parameter DB 
 

 Note 
Do not modify any data not listed in this table. 

 

Content of the Parameter DB 
 

Address Name Type Start value Comment 
Machine data 
3.1 PI_MEND BOOL FALSE 1: enable hardware interrupt: End of 

measurement 
3.2 PI_CAM BOOL FALSE 1: enable hardware interrupt: Cam on/off 
3.5 PI_MSTRT BOOL FALSE 1: enable hardware interrupt: Start of 

measurement 
4.0 EDGEDIST DINT L#0 Minimum edge distance for edge detection 
8.0 UNITS DINT L#1 System of units 
12.0 AXIS_TYPE DINT L#0 0: Linear axis, 1: Rotary axis 
16.0 ENDROTAX DINT L#100000 End of rotary axis 
20.0 ENC_TYPE DINT L#1 Encoder type, frame length 
24.0 DISP_REV DINT L#80000 Distance per encoder revolution 
32.0 INC_REV DINT L#500 Increments per encoder revolution 
36.0 NO_REV DINT L#1024 Number of encoder revolutions 
40.0 BAUDRATE DINT L#0 Baudrate 
44.0 REFPT DINT L#0 Reference point coordinate 
48.0 ENC_ADJ DINT L#0 Absolute encoder adjustment 
52.0 RETR_TYPE DINT L#0 Type of retrigger reference point 
56.0 CNT_DIR DINT L#0 Count direction: 

0: normal, 1: inverted 
63.0 MON_WIRE BOOL TRUE 1: Wire-break monitoring 
63.1 MON_FRAME BOOL TRUE 1: Frame error monitoring 
63.2 MON_PULSE BOOL TRUE 1: Missing pulse monitoring 
64.0 SSW_STRT DINT L#-100000000 Start software limit switch 
68.0 SSW_END DINT L#100000000 End software limit switch 
76.0 C_QTY DINT L#0 Quantity framework: 0, 1, 2, 3 = max. 16, 32, 

64, 128 cams 
80.0 HYS DINT L#0 Hysteresis 
84.0 SIM_SPD DINT L#0 Simulation velocity 
90.0 TRACK_OUT WORD W#16#0 Control of track outputs:  

0 = cam controller, 1 = CPU;  
Bit number = track number 

95.0 EN_IN_I3 BOOL FALSE Enable input I3 
95.1 EN_IN_I4 BOOL FALSE Enable input I4 



 Data blocks / error lists 
 C.2 Content of the Parameter DB 

FM 452 Installation and Parameter Assignment 
Operating Instructions, 07/2007, A5E01071729-01 179 

Address Name Type Start value Comment 
Machine data 
95.2 EN_IN_I5 BOOL FALSE Enable input I5 
95.3 EN_IN_I6 BOOL FALSE Enable input I6 
95.4 EN_IN_I7 BOOL FALSE Enable input I7 
95.5 EN_IN_I8 BOOL FALSE Enable input I8 
95.6 EN_IN_I9 BOOL FALSE Enable input I9 
95.7 EN_IN_I10 BOOL FALSE Enable input I10 
99.0 SPEC_TRC0 BOOL FALSE 1 = track 0 is counter cam track 
99.1 SPEC_TRC1 BOOL FALSE 1 = track 1 is counter cam track 
99.2 SPEC_TRC2 BOOL FALSE 1 = track 2 is brake cam track 
100.0 CNT_LIM0 DINT L#2 Upper count value for counter output cam 

track 0 
104.0 CNT_LIM1 DINT L#2 Upper count value for counter output cam 

track 1 

 
 

Data for cams 0 to 15 / 0 to 31 / 0 to 63 / 0 to 127 
108.0  STRUCT  (12 bytes length per element) 

 
 

Relative 
Address 
+0.0 CAMVALID BOOL FALSE 1: Cam valid 
+0.1 EFFDIR_P BOOL TRUE 1: Positive effective direction (plus) 
+0.2 EFFDIR_M BOOL TRUE 1: Negative effective direction (minus) 
+0.3 CAM_TYPE BOOL FALSE 0: Distance cam, 1: Time-based cam 
+0.4 PI_SW_ON BOOL FALSE 1: hardware interrupt on activation 
+0.5 PI_SW_OFF BOOL FALSE 1: Hardware interrupt on deactivation 
+1.0 TRACK_NO BYTE B#16#0 Track number 
+2.0 CBEGIN DINT L#-100 000 000 Cam start 
+6.0 CEND DINT L#100 000 000 Cam end/activation time 
+10.0 LTIME INT 0 Lead time 
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C.3 Data and Structure of the Diagnostic DB 
 

 Note 
Do not modify any data not listed in this table. 

 

Content of the diagnostics DB 
 

Address Name Type Start value Comment 
0.0 MOD_ADDR 

(enter!) 
INT 0 Module address 

256.0 JOB_ERR INT 0 Communication Errors 
258.0 JOBBUSY BOOL FALSE 1 = job busy 
258.1 DIAGRD_EN BOOL FALSE 1 = read diagnostic buffer unconditional 
260.0 DIAG_CNT INT 0 Number of valid entries in the list 
262.0 DIAG[1] STRUCT  Diagnostic data latest entry 
272.0 DIAG[2] STRUCT  Diagnostic data second entry 
282.0 DIAG[3] STRUCT  Diagnostic data third entry 
292.0 DIAG[4] STRUCT  Diagnostic data oldest entry 

Structure of the Diagnostic Entry 
 

Address Name Type Start value Comment 
+0.0 STATE BOOL FALSE 0 = event outgoing 

1 = event incoming 
+0.1 INTF BOOL FALSE 1 = Internal error 
+0.2 EXTF BOOL FALSE 1 = external error 
+2.0 FCL INT 0 Error class: 

1: Process error 
4: Data error 
5: Machine data error 
7: Cam data error 
15: Alarms 
128: Diagnostics errors 

+4.0 FNO INT 0 Error number 0 to 255 
+6.0 CH_NO INT 0 Channel number (always 1) 
+8.0 CAMNO INT 0 Cam numbers 0 to 127 with error class = cam data 

error 
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List of JOB_ERR alarms 
 

JOB_ERR 
(hex) 

JOB_ERR 
(dec) 

JOB_ERR 
(int) 

Meaning 

80A0 32928 -32608 Negative acknowledgment when reading from module. 
Module removed during read operation or module defective.  

80A1 32929 -32607 Negative acknowledgment when writing to module. Module 
removed during write operation or module defective.  

80A2 32930 -32606 DP protocol error at layer 2 
80A3 32931 -32605 DP protocol error at user interface / user 
80A4 32932 -32604 Communication problem on K bus 
80B1 32945 -32591 Specified length wrong. Faulty FM_TYPE parameter setting at 

the channel DB for the module in use. 
80B2 32946 -32590 The configured slot is empty. 
80B3 32947 -32589 Actual module type does not match configured module type. 
80C0 32960 -32576 The module has not yet prepared the data to be read. 
80C1 32961 -32575 The data of a write job of the same type have not yet been 

processed on the module.  
80C2 32962 -32574 The module is currently processing the maximum number of 

jobs. 
80C3 32963 -32573 Required resources (memory etc.) currently in use.  
80C4 32964 -32572 Communication Errors 
80C5 32965 -32571 Distributed I/Os not available. 
80C6 32966 -32570 Priority class abort (restart or background) 
8522 34082 -31454 Channel DB or parameter DB too short. The data cannot be 

read from the DB. (write job) 
8532 34098 -31438 DB number of the parameter DB too high. (write job) 
853A 34106 -31430 Parameter DB does not exist. (write job) 
8544 34116 -31420 Error in nth (n > 1) read access to a DB after error occurred. 

(write job) 
8723 34595 -30941 Channel DB or parameter DB too short. The data cannot be 

written to the DB. (read job) 
8730 34608 -30928 Parameter DB on the CPU write-protected. The data cannot 

be written to the DB (read job). 
8732 34610 -30926 DB number of the parameter DB too high. (read job) 
873A 34618 -30918 Parameter DB does not exist. (read job) 
8745 34629 -30907 Error in nth (n > 1) write access to a DB after error occurred. 

(read job) 
The errors 80A2 to 80A4 and 80Cx are temporary, i.e. these can be cleared after a waiting time 
without user intervention. Alarms in the format 7xxx indicate temporary states in communication. 

See also 
● Machine data of the encoder (Page  81) 
● Cam data (Page  92) 
● Enable diagnostics interrupts (Page  139) 
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C.4 Error class 1: Process error 

Meaning 
Operating errors are detected asynchronous to operator input/commands. 

 
No. Meaning Diagnostics 

interrupt 
1 Software limit switch start passed Yes 
2 Software limit switch end passed Yes 
3 Traversing range start passed Yes 
4 Traversing range end passed Yes 

Set actual value on-the-fly cannot be executed 
Cause After the actual value was set on-the-fly, the software limit 

switch is outside the traversing range. 
(-100 m to +100 m or -1000 m to +1000 m.)  
The shift resulting from set actual value / set actual value on-
the-fly is more than ± 100 m or ± 1000 m.  

13 

Effect Axis not synchronized 

Yes 

 

C.5 Error class 4: Data error 

Meaning 
Data errors are detected synchronous to operator input/commands. 

 
No. Meaning Diagnostics 

interrupt 
Zero offset error 10 
Cause The zero offset is higher than ± 100 m or ± 1000 m.  

The software limit switches are outside the travel range (-
100m...+100 m or -1000 m...+1000 m) after setting the zero 
offset.  
Rotary axis: The zero offset value is higher than the end of the 
rotary axis. 

No 

Faulty actual value setting 11 
Cause Linear axis: the coordinate is outside the current (possibly 

shifted) software limit switches. 
Rotary axis: The coordinate is < 0, or higher than the end of the 
rotary axis. 

No 
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No. Meaning Diagnostics 
interrupt 

Reference point error 12 

Cause Linear axis: the coordinate is outside the current (possibly 
shifted) software limit switches. 
Rotary axis: The coordinate is < 0, or higher than the end of the 
rotary axis. 

No 

Enable machine data not permitted 20 
Cause There are no new (error-free) machine data on the module. 

No 

Set actual value on-the-fly not permitted 21 
Cause An attempt was made to execute "set actual value on-the-fly" 

while "retrigger reference point" was active. 

No 

Illegal bit-coded setting 27 
Cause Unused and, in this case, unwritten bits are not 0. 

An attempt was made to select "length measurement" and 
"edge detection" at the same time. 

No 

Retrigger reference point is not permitted 28 
Cause An attempt was made to execute "retrigger reference point" 

while "set actual value on-the-fly" was active. 
An attempt was made to execute "retrigger reference point" 
with an SSI encoder. 

No 

Illegal bit-coded command 29 
Cause Unused and, in this case, unwritten bits are not 0. 

No 

30 Incorrect lead time No 
Invalid cam number 31 
Cause The cam is not valid. 

The cam number is not in the range 0 to 127. 

No 

Invalid cam start 32 
Cause The cam start is outside the travel range (-100m...+100m or -

1000m...+1000m). 
Rotary axis: The cam start is < 0 or higher than the end of the 
rotary axis. 

No 

Invalid cam end / invalid activation time 33 
Cause The cam end is outside the travel range (-100 m...+100 m or -

1000 m...+1000 m). 
Rotary axis: The cam end is < 0 or higher than the end of the 
rotary axis.  
The cam is not active at least for the duration of one pulse. 

No 

Cancel set actual value not possible 34 
Cause The actual position value would be outside the working range 

with an SSI encoder and linear axis after making the setting. 

No 
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No. Meaning Diagnostics 
interrupt 

Incorrect actual value specified by "set actual value" / "set actual value on-the-
fly" 

35 

Cause The specified actual value is outside the permitted numeric 
range of ± 100 m or ± 1000 m.  
The software limit switches would be outside the travel range 
when executing the set parameter  
(-100 m...+100 m or -1000 m...+1000 m.)  
The shift derived from set actual value / set actual value on-
the-fly would be more than ± 100 m or ± 1000 m. 

No 

Parameters not set for the axis 107 
Cause There are no machine data on the axis. 

There are no machine data activated on the axis. 

No 

Axis not synchronized 108 
Cause One of the settings "set actual value", "set actual value on-the-

fly", and "retrigger reference point" was started although the 
axis is not synchronized. 

No 

109 Output cam processing running No 
110 Invalid number of cams to be modified. No 
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C.6 Error class 5: Machine data error 

Meaning 
The diagnostics interrupt is only triggered if an error is detected in the system data block 
(SDB). 

 
No. Meaning Diagnostics 

interrupt 
Error in hardware interrupt setting 5 
Cause You have attempted to select a hardware interrupt that the 

module does not support. 

Yes 

Incorrect minimum edge interval 6 
Cause You have entered a value < 0 or > 109 µm as the minimum 

edge interval. 

Yes 

Invalid axis type 8 
Cause You have specified neither 0 nor 1 as the axis type. 

Yes 

Invalid rotary axis end 9 
Cause The value for the end of the rotary axis is outside the permitted 

range from 1 to 109 µm or 1 to 108 µm (depending on the 
resolution). 

Yes 

Invalid encoder type 10 
Cause The value for the encoder type is outside the permitted range 

of 1 to 10. 

Yes 

Wrong distance/encoder revolution 11 
Cause The value of the distance/encoder revolution is outside the 

permitted range of 1 to 109 µm (regardless of the resolution). 

Yes 

13 Incorrect number of increments(encoder revolution  Yes 
14 Incorrect number of revolutions  Yes 

Invalid baudrate 15 
Cause You have specified a baudrate outside the permitted range of 0 

to 3. 

Yes 

Invalid reference point coordinate 16 
Cause The coordinate is outside the range of -100 m to +100 m or -

1000 m to +1000 m, depending on the resolution. 
Linear axis: The coordinate is outside the working range.  
Rotary axis: The coordinate is < 0, or higher than the end of the 
rotary axis. 

Yes 

Incorrect absolute encoder adjustment 17 
Cause SSI encoder: The value of the absolute encoder adjustment is 

not in the encoder range: [increments per encoder revolution] x 
[number of revolutions - 1]. 

Yes 

Incorrect type of reference point retrigger 18 
Cause You have specified a value other than 0, 1, 6 and 7. 

Yes 

Incorrect direction adaptation 19 
Cause You have specified a value other than 0 and 1. 

Yes 
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No. Meaning Diagnostics 
interrupt 

Hardware monitoring not possible 20 

Cause You set frame error monitoring = FALSE at the parameter DB. 
Yes 

Incorrect start software limit switch 21 
Cause Linear axis: The start software limit switch is outside the travel 

range (-100 m...+100 m or -1000 m...+1000 m, depending on 
the resolution). 
Linear axis: The software limit switch start (including any 
existing zero offset) is less than -100 m or -1000 m (depending 
on the resolution). 

Yes 

Incorrect end software limit switch 22 
Cause Linear axis: The software limit switch end is outside the travel 

range (-100 m...+100 m or -1000 m...+1000 m, depending on 
the resolution) or is less than the start software limit switch. 
The software limit switch end (including any existing zero 
offset) is higher than +100 m or +1000 m (depending on the 
resolution). 

Yes 

Invalid quantity framework 144 
Cause You have specified a value other than 0 to 3 for the number of 

cams. 

Yes 

Incorrect hysteresis 145 
Cause The hysteresis is outside the range 0...65535*resolution.  

The hysteresis is higher than ¼ x working range or ¼ x rotary 
axis range. 

Yes 

Incorrect simulation velocity 146 
Cause The simulation velocity is outside the range 1000*RES to 

3*107*RES, or is higher than 5* 108 µm/min. 
The simulation velocity cannot be set internally. 

Yes 

Illegal track 147 
Cause Activation of a track outside 0 to 15 (bits 0 to 15) was selected. 

Yes 

Incorrect selection of enable inputs 148 
Cause You wanted to enable a track outside 3 to 10 (bits 0 to 7) using 

an external signal. 

Yes 

Incorrect special track selection. 149 
Cause You wanted to define a track outside 0, 1 and 2 (bits 0, 1 and 

2) as a special track 

Yes 

Wrong count value high limit at track 0 150 
Cause You have specified a counter value < 2 or > 65535 as the 

upper counter value. 

Yes 

Wrong count value high limit at track 1 151 
Cause You have specified a counter value < 2 or > 65535 as the 

upper counter value. 

Yes 
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No. Meaning Diagnostics 
interrupt 

Incorrect resolution 200 

Cause You have specified a resolution < 0.1 µm/pulse or >1000 
µm/pulse. 
You have specified a distance/encoder revolution and a 
number of pulses/encoder revolution, that results in a 
resolution of < 0.1 or > 1000. 

Yes 

Position encoder does not match the working range/rotary axis range 201 
Cause SSI position encoder and rotary axis: The encoder does not 

exactly cover the rotary axis range. 
Linear axis: The position encoder does not cover at least the 
working range (including software limit switches). 

Yes 
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C.7 Error class 7: Cam data error 

Meaning 
The diagnostics interrupt is only triggered if an error is detected in the system data block 
(SDB.) 

 
No. Meaning Diagnostics 

interrupt 
Illegal hardware interrupt 1 
Cause You attempted to define a hardware interrupt for a cam with a 

cam number > 7. 

Yes 

Incorrect track number 2 
Cause The track number is outside the range 0 to 31. 

Yes 

Invalid cam start 3 
Cause The cam start is outside the travel range (-100m...+100m or -

1000m...+1000m). 
Rotary axis: The cam start is < 0 and/or higher than the end of 
the rotary axis.  

Yes 

Invalid cam end 4 
Cause The cam end is outside the traversing range (-100 m to +100 m 

or -1000 m to +1000 m). 
The cam is at least one pulse long.  
Rotary axis: The cam end is < 0 and/or higher than the end of 
the rotary axis.  

Yes 

Incorrect cam activation time 5 
Cause The cam activation time is < 0µs. The max. value depends on 

the quantity framework.  

Yes 

Incorrect lead time 6 
Cause The lead time is < 0 µs. The max. value depends on the 

quantity framework.  

Yes 

Too many cam sets 50 
Cause You wanted to enter more cam records than is possible with 

this number of cams. 

Yes 

Axis in operation 51 
Cause You wanted to enter cam records while the cam controller is 

active. 

Yes 

Parameters not set for the axis 52 
Cause You want to enter cam data although not machine data are 

active yet. 

Yes 
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C.8 Error class 15: Alarms 

Meaning 
 

No. Meaning Diagnostic 
Interrupt 

Start of parameter assignment 1 
Cause The module has detected a parameter assignment by a 

system data block. 

No 

End of parameter assignment 2 
Cause The module has processed the parameter assignment by a 

system data block error-free. 

No 

 

C.9 Error class 128: Diagnostics errors 

Meaning 
 

No. Meaning Diagnostics 
interrupt 

Missing external auxiliary supply 
Cause External 24 V auxiliary supply not connected or failed. 
Effect • Cam processing will be disabled 

• Track outputs will be disabled 
• With incremental encoders, synchronization is deleted. 
• The FM 452 has not had parameters assigned (return 

signal PARA = 0). 

4 

Rectification Make sure that the 24 V connection is correct (If 24 V 
connection is correct, then the module is defective.) 

Yes 

Front connector missing 
Cause Front connector not plugged in 
Effect • No external 24 V auxiliary supply 

• Module not ready for operation 

5 

Rectification Inserting the front connector 

Yes 
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No. Meaning Diagnostics 
interrupt 

Watchdog expired 
Cause • strong interference on the FM 452. 

• Error in the FM 452. 
Effect • Module is reset. 

• Provided that after resetting the module, no module defect 
is detected, the module is ready for operation again. 

• The module signals the expired WATCHDOG with 
"incoming" and "outgoing". 

51 

Rectification • Eliminate the interference. 
• Contact the relevant sales department who will require 

details of the circumstances leading to the error. 
• Replace the FM 452. 

Yes 

Internal module power supply failed 
Cause Error in the FM 452. 
Effect • Module is reset. 

• Provided that after resetting the module, no module defect 
is detected, the module is ready for operation again. 

52 

Rectification Replace the FM 452. 

Yes 

Hardware interrupt lost 
Cause A hardware interrupt event detected by FM 452 cannot be 

reported, because the same event has not yet been processed 
by the user program/CPU. 

Effect • Cam processing will be disabled 
• Track outputs will be disabled 
• With incremental encoders, synchronization is deleted. 

70 

Rectification • Link OB40 into the user program 
• Check bus connection of the module 
• Deactivate process interrupt 
• Upgrade hardware and software to suit your process 

requirements (for example faster CPU, optimize user 
program). 

Yes 

Encoder wire break 
Cause • Encoder cable cut or not plugged in. 

• Encoder has no transverse signals. 
• Incorrect pin assignment. 
• Cable length too long. 
• Encoder signals short circuited. 

Effect • Cam processing will be disabled 
• Track outputs will be disabled 
• With incremental encoders, synchronization is deleted. 

144 

Rectification • Check the encoder cable. 
• Keep within encoder specifications. 
• Monitoring can be temporarily disabled using the 

programming interface, but at the responsibility of the 
operator. 

• Keep to the module's technical data. 

Yes 
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No. Meaning Diagnostics 
interrupt 

Absolute encoder frame error 
Cause The frame traffic between FM 452 and the absolute encoder 

(SSI) is incorrect or interrupted: 
• Encoder cable cut or not plugged in. 
• Incorrect encoder type 
• Encoder incorrectly set (programmable encoders) 
• Frame length incorrectly specified 
• Encoder returns incorrect values (encoder defective) 
• Interference on measuring system cable 
• Baud rate selected too high 

Effect • Cam processing will be disabled 
• Track outputs will be disabled 
• The last correct actual value remains unchanged till the end 

of the next correct SSI transfer 

145 

Rectification • Check the encoder cable. 
• Check the encoder 
• Check the frame traffic between the encoder and FM 452. 

Yes 

Incremental encoder pulse error frame 
Cause • Encoder monitoring has detected missing pulses. 

• Number of increments per encoder revolution is incorrectly 
entered. 

• Encoder defective: does not return the defined number of 
pulses. 

• Bad or missing zero marker 
• Interference on the encoder cable. 

Effect • Cam processing will be disabled 
• Track outputs will be disabled 
• Synchronization is deleted. 

146 

Rectification • Enter the correct number of increments/encoder revolution 
• Check the encoder and its cable. 
• Keep to shielding and grounding regulations. 
• Monitoring can be temporarily disabled using the 

programming interface, but at the responsibility of the 
operator. 

Yes 
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Index 

A 
Absolute encoder, 71, 133 

Data Transmission, 133 
Frame run times, 135 
Monostable flip-flop time, 135 
Pulse evaluation, 133 
Response time, 134 

Absolute encoder adjustment, 75, 77 
Alternative, 80 
Data in the channel DB, 78 
Definition, 77 
determination, 77 
Example, 79 

Activation bits for read jobs, 171 
Actual value change, 99 
Addressed, 169 
adjustment 

Dynamic, 19 
Adjustment 

Fast cam parameter change, 110 
Adjustment of the coordinate system 

Length measurement, 115 
Alarms, 189 
Applying glue tracks, 10 
Asymmetrical output signals, 130 
Auxiliary Voltage, 27 
AVAL, 101 
AVAL_EN, 101 
AVALREM_EN, 102 
Axis synchronization, 62 
Axis type, 70 

B 
BAUDRATE, 83 
BEG_VAL, 113 
Block library, 35 
Block templates, 35 
Bounce-free switch, 112 
Brake cam track, 17 

C 
Cam activation 

Condition, 14 
Cam activation time, 94 
Cam and track data, 125 

Steps, 125 
Cam controller, 12 

Control signals, 126 
electronic, 9 
Interfaces, 20 

Cam data, 65, 92 
Cam activation time, 94 
Cam end position, 94 
Cam start, 94 
Cam valid, 93 
Definition, 92 
Derivative action time, 95 
Hardware interrupt on activation, 93 
Negative effective direction (minus), 93 
Position-based cam, 93 
Positive effective direction (plus), 93 
Process alarm while switching off, 93 
Time-based cam, 93 
Track number, 93 

Cam data 
Writing, 67 

Cam data 
read, 68 

Cam data error, 188 
Cam data in the parameter DB, 93 
Cam end position, 94 
Cam parameter change, 110 
Cam start, 94 
Cam types, 13 
CAM_END, 108 
CAM_NO, 108 
CAM_START, 108 
CAM_TYPE, 93 
Cams, 13 

Directional reversal, 92 
direction-based, 13 
Switching characteristics, 92 

CAMVALID, 93 
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Cancel set actual value, 100 
AVALREM_EN, 102 

Canceling the setting 
Cancel set actual value, 102 

CBEGIN, 94 
CE label, 8 
CE Label, 159 
CEND, 94 
CH01CAM_EN, 108 
Change cam edges, 108 

Canceling, 109 
Data used in the channel DB, 108 
Definition, 108 
Effects, 109 
Requirements, 108 
Steps, 108 

Channel DB, 46 
Configuration, 46 
Preparing, 63 
Task, 46 

CNT_DIR, 84 
Connecting cables, 29 
Connection Diagrams, 163 
Control signals, 169 

Transfer, 38 
Write, 55 

Control signals for the cam controller, 126 
Data used in the channel DB, 126 
Steps, 126 

Count direction, 84 
Counter cam track, 16, 19 
Counter cam track values 

Data used in the channel DB, 122 
Data used in the parameter DB, 122 
Steps, 122 

Counter cam tracks 
Count values, 122 

CPU 
Startup, 39 

CSA approvals, 158 
Current input, 155 

D 
Data Block 

Template, 46 
Data check, 111 

by the module, 111 
Data error, 182 
Data for "Change cam edges" job, 175 
Data for "Fast cam parameter change" job, 176 
Data for "Read count values" job, 176 

Data for "Read encoder data" job, 176 
Data for the "Length measurement/edge detection" 
job, 175 
Data for the "Read position and track data" job, 176 
DC load power supply, 27 
Delay time 

Total value, 19 
Derivative action time, 95 
Determining a coordinate 

Zero offset, 103 
Diagnostics DB, 47 

Configuration, 47, 180 
Preparing, 63 
Task, 47 

Diagnostics errors, 189 
Diagnostics interrupt, 139 

Evaluation, 51 
Incoming, 140 
Outgoing, 140 
Overview, 139 
Reaction of FM 452, 140 

Digital Input, 27 
Digital output, 28 
DIR_M, 120 
DIR_P, 120 
Direct access to return signals, 54 
Direction of motion, 13 
Directional recognition, 13 
Direction-based cams, 13 
Disabling software limit switches 

Effects, 119 
SSW_OFF, 119 
Steps, 119 

Disabling the cams 
Condition, 14 

DISP_REV, 81 
Distance per encoder revolution, 81 
Done bits for function switches, 172 
Done bits for read jobs, 173 
Done bits for write jobs, 172 
Dynamic adjustment, 19, 97 

E 
Edge detection, 112 

Requirements, 112 
Edge interval 

data update, 112 
disabling, 111 
Result, 112 

EDGE_ON, 113 
EDGEDIST, 114 
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EFFDIR_M, 93 
EFFDIR_P, 93 
Effective direction, 13, 92, 93 
Electrical isolation, 156 
Electronic cam control 

Components, 11 
Electronic cam controller, 9 
EMERGENCY OFF limit switch, 25 
EMERGENCY OFF switch, 25 
ENC_TYPE, 81 
Encoder 

Machine data, 81 
Mechanical adjustment, 80 
Multiturn, 133 
Single-turn, 133 
Total number of steps, 83 

Encoder data, 124 
Data used in the channel DB, 124 
Preconditions, 124 
Steps, 124 

Encoder type, 81 
End of rotary axis, 71 
END_VAL, 113 
Equipotential bonding, 30 
Error bits for function switches, 173 
Error bits for read jobs, 174 
Error bits for write jobs, 174 
Error class 1 

Process error, 182 
Error class 128 

Diagnostics errors, 189 
Error class 15 

Alarms, 189 
Error class 2 

Data error, 182 
Error class 5 

Machine data error, 185 
Error class 7 

Cam data error, 188 
Error classes, 182 
Error displays, 138 
Error evaluation, 137 

Sample Program 3 "OneModule", 149 
Error LED, 138 
Examples 

use, 144 
Execution times, 53 
External enable, 16 
External errors, 138 

F 
Fast cam parameter change, 110 

Canceling, 111 
Data check, 111 
Data used in the channel DB, 110 
Definition, 110 
Effects, 111 
Requirements, 110 
Steps, 110 

FC 0 
FC CAM_INIT, 37 

FC 1 
FC CAM_CTRL, 38 

FC 2 
FC CAM_DIAG, 42 

FC 3 
FC CAM_MSRM, 44 

FC CAM_CTRL, 38 
Call parameters, 40 
Call-up, 38 
Data used, 38 
Malfunction, 41 
Return values, 40 
Tasks, 38 

FC CAM_DIAG, 42 
Call-up, 42 
Data used, 42 
Malfunction, 43 
Parameters, 42 
Return values, 42 
Tasks, 42 

FC CAM_INIT 
FC 0, 37 
Parameters, 37 
Tasks, 37 

FC CAM_MSRM, 44 
Call parameters, 44 
Call-up, 44 
Data used, 44 
Malfunction, 45 
Tasks, 44 

FC CAM_MSRM 
Return values, 44 

Field of application for SIMATIC products, 159 
Flat gain, 131, 135 
FM 352 

Commissioning, 59 
Startup, 39 

FM 452 
Installation, 23 
removing, 23 

FM approval, 158 
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Frame error, 84 
Frame length, 81 
Front connectors, 26 

Terminal assignment, 26 
Wiring, 29 

Function switch, 39, 170 
Functions, 35 

Execution times, 53 
Installing, 33 
Technical data, 52 

FVAL, 101 
FVAL_DONE, 101 
FVAL_EN, 101 

G 
Getting prepared for programming, 62 
Group fault, 138 

H 
Hardware interrupt, 91 

Evaluation, 50 
lost, 50 

Hotline, 160 
HW 

Mounting, 60 
Hysteresis, 18 

Position-based cam, 73 
Time-based cam, 74 

Hysteresis range, 18 
Rules, 18 

I 
INC_REV, 82 
Incorrect length measurement, 114 
Increment, 130 
Incremental encoder, 71 

Missing pulses, 85 
Reaction times, 131 
Signal shapes, 130 

Increments per encoder revolution, 82 
Initial parameter assignment, 66 
Input current, 156 
Input delay, 156 
Input frequency, 156 
Input voltage, 156 
Installation, 33 

Functions, 33 
Programming interface, 33 

Installation guidelines, 159 
Interfaces of the cam controller, 20 
Internal error, 138 
Interrupt enable, 91 

Cam data for, 91 
Definition, 91 
Machine data in the parameter DB, 91 

Interrupt processing, 49 

J 
Job 

execute, 38 
Job management for FC CAM_CTRL, 175 
Job management for FC CAM_MSRM, 175 
Job status, 40 
JOB_ERR alarms, 181 
Jobs, 39 

L 
Lead time, 19 
LEDs 

EXTF, 138 
INTF, 138 

LEN_VAL, 113 
Length measurement, 112 

data update, 112 
incorrect, 114 
Minimum, 114 
Requirements, 112 
Result, 112 

Length of cable, 156 
Limit switches, 60 

safety-relevant, 60 
Linear axis, 9, 71 
Linear scale, 83 
Listen in, 81, 133 

Wiring, 134 
Listen mode, 27 
Load power supply, 27 
Loss of synchronization, 105 

M 
Machine and cam data 

Steps when writing, 65 
Machine data, 65 

Axis type, 70 
Baud rate, 83 
Count direction, 84 
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Distance per encoder revolution, 81 
editing, 66 
enable, 67 
enabling, 65 
Encoder type, 81 
End of rotary axis, 71 
Frame length, 81 
Increments per encoder revolution, 82 
Monitoring functions, 84 
Number of encoder revolutions, 83 
read, 67 
Type of reference point retriggering, 72 
Write, 65 

Machine data error, 185 
Machine data of the encoder, 81 

Data in the parameter DB, 81 
Definition, 81 

Master mode, 27 
MD_EN, 67 
MDRD_EN, 67 
MDWR_EN, 67 
Minimum length measurement, 114 
Missing pulses 

Incremental encoder, 85 
Module cycle, 52 
MON_FRAME, 84 
MON_PULSE, 84 
MON_WIRE, 84 
Monitoring functions, 84 
Motor, 11 
MSR_DONE, 113 
MSR_ON, 113 
MSRRD_EN, 113 
Multiturn encoder, 133 

N 
NO_REV, 83 

O 
OB40_POINT_ADDR 

Table of Contents, 50 
On period, 14 
Output signal 

Asymmetrical, 130 
Symmetrical, 130 

P 
Packaging unit, 10 

Parameter DB, 178 
Areas, 48 
Configuration, 48 
Task, 48 

Parameter for "Set actual value on-the-fly" job, 175 
Parameter for "Set actual value" job, 175 
Parameter for "Set reference point" job, 175 
Parameter for "zero offset" job, 175 
Parameters assignment 

Position-/time-based cams, 13 
Path length, 14 
PI_SW_OFF, 93 
PI_SW_ON, 93 
Position acquisition, 156 
Position and track data, 123 

Data used in the channel DB, 123 
Steps, 123 

Position-based cam, 13 
Definition, 13 
Switching characteristics, 92 
with programmed hysteresis, 73 

Power drive, 11 
Power loss, 155 
Press control, 10 
Process error, 182 
Programming, 61 

Requirements, 33 
Programming interface, 33, 61 

Installing, 33 
Proximity switch, 71, 132 

Signal evaluation, 132 
Pulse, 131 

R 
Read job, 39 

Error, 41 
REFPT, 106, 116 
REFPT_EN, 106 
REFTR_ON, 116 

Retrigger reference point, 116 
Resolution, 86 

Calculation, 86 
Definition, 86 
Example, 87 
Value range, 86 

RETR_TYPE, 116 
Retrigger reference point 

Effects, 117 
REFTR_ON, 116 
Requirements, 116 

Return signals, 170 
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read, 38 
reading, 54 

Return signals for diagnostics, 128 
Data used in the channel DB, 128 
Steps, 128 

Return signals for the cam controller, 127 
Data used in the channel DB, 127 
Steps, 127 

Reverse polarity protection, 155 
Rotary axis, 9, 71 

S 
Safety rule, 25 
Safety rules, 23 
Safety system, 11 
Safety-relevant limit switches, 60 
Sample Program 3 "OneModule" 

Error evaluation, 149 
User program, 149 

Scope of the manual, 7 
Service, 160 
Set actual value, 100, 101 

Data in the channel DB, 101 
Effect, 101 
Steps, 100 

Set actual value on-the-fly, 100 
Data in the channel DB, 101 
Steps, 100 

Set reference point, 106 
Data used in the channel DB, 106 
Definition, 106 
Effects, 106 
Requirements, 106 
Special features of absolute encoders, 107 
Steps, 106 

Setting up a project, 60 
settings 

Change cam edges, 108 
Set reference point, 106 
Zero offset, 103 

Short-circuit protection, 157 
Signal cycle, 130 
Signal shapes 

Incremental encoder, 130 
Signal voltages, 156 
SIM_ON, 120 
SIM_SPD, 120 
SIMATIC Customer Support Hotline, 160 
simulation 

effects when disabling, 121 
Effects when enabling, 120 

Limit values, 121 
SIM_ON, 120 
Steps, 120 

Simulation velocity, 120 
Single-turn encoder, 133 
Slot, 23 
Special track 

Requirements, 16 
Special tracks, 16 
SSW_END, 119 
SSW_OFF, 119 
SSW_STRT, 119 
Standard physical units, 69 
Start software limit switch, 72 
Status displays, 138 
Steps when writing 

Machine and cam data, 65 
Support, 160 
Switching characteristics, 62 

of time-based cams, 99 
Symmetrical output signals, 130 
SYNC, 106 
Synchronization 

loss of, 105 
System of units 

in the parameter DB, 69 
Selecting, 69 

T 
Technical data, 52 
Time-based cam, 13 

Activating, 99 
Definition, 13 
influence of the settings, 99 
Switching characteristics, 92, 99 
with programmed hysteresis, 74 

Tools, 23 
Total number of encoder steps, 83 
Track data, 89 
Track enable 

enabling, 15 
Track result, 15 

Example, 15 
Track signal 

setting, 16 
TRACK_NO, 93 
Tracks, 15 

External enable, 16 
Training Centers, 161 
Traversing range 

Dependency, 87 
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Resolution, 87 
Trigger bits for write jobs, 170 
Type of reference point retriggering, 72 

U 
UL approvals, 158 
UNITS, 69 
User program 

Sample Program 3 "OneModule", 149 

V 
Velocity 

Dependency on the resolution, 87 

W 
Wire end ferrules, 29 
Wire-break, 84 

Wiring, 25 
the front connector, 29 

Wiring information 
for 24 V DC, 29 

Wiring procedure, 31 
Write job, 39 

Error, 41 

Z 
Zero offset 

Canceling, 105 
Data used in the channel DB, 103 
Effects on a linear axis, 104 
on a rotary axis, 105 
Steps, 103 
ZOFF_EN, 103 

ZOFF, 103 
ZOFF_EN, 103 
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